## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC for SIMATIC S7</td>
<td>1</td>
</tr>
<tr>
<td>Basics of SFC</td>
<td>2</td>
</tr>
<tr>
<td>Starting and Operating</td>
<td>3</td>
</tr>
<tr>
<td>Creating the Project Structure</td>
<td>4</td>
</tr>
<tr>
<td>Adapting the Properties of Charts, Types and Instances</td>
<td>5</td>
</tr>
<tr>
<td>Configuring Sequential Control Systems</td>
<td>6</td>
</tr>
<tr>
<td>Compiling SFC Types and SFC Instances</td>
<td>7</td>
</tr>
<tr>
<td>Downloading to the AS</td>
<td>8</td>
</tr>
<tr>
<td>Behavior of the Sequential Control System in the AS</td>
<td>9</td>
</tr>
<tr>
<td>Testing and Commissioning Sequential Control Systems</td>
<td>10</td>
</tr>
<tr>
<td>Documenting Programs</td>
<td>11</td>
</tr>
<tr>
<td>Configuring Parameter Controls</td>
<td>12</td>
</tr>
<tr>
<td>Tips &amp; Tricks</td>
<td>13</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
</tbody>
</table>
Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The notices shown below are graded according to the degree of danger.

 Danger
indicates that death or severe personal injury will result if proper precautions are not taken.

 Warning
indicates that death or severe personal injury may result if proper precautions are not taken.

 Caution
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not taken.

 Caution
without a safety alert symbol indicates that property damage can result if proper precautions are not taken.

 Notice
indicates that an unintended result or situation can occur if the corresponding notice is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notices in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

 Warning
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG.
The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Contents

1 SFC for SIMATIC S7 ................................................................. 1-1
  1.1 Introduction .................................................................................................. 1-1
  1.2 Getting Started ............................................................................................ 1-6
  1.2.1 How to Work with SFC in Overview ...................................................... 1-6
  1.2.2 How to Create an SFC Chart in Overview ............................................ 1-8
  1.2.3 How to Create an SFC Type in Overview .............................................. 1-11
  1.2.4 How to Create an SFC Instance in Overview ....................................... 1-14

2 Basics of SFC ....................................................................................... 2-1
  2.1 SFC in the STEP 7 Environment ............................................................... 2-1
  2.2 SFC and Plant Hierarchy ........................................................................... 2-3
  2.3 SFC and Other Target Systems ................................................................. 2-3
  2.4 Use and Functionality of SFCs .................................................................. 2-4
  2.4.1 What is an SFC Chart? ............................................................................ 2-4
  2.4.2 What is an SFC Type / SFC Instance? .................................................... 2-7
  2.4.3 SFC Chart and SFC Type Compared ................................................... 2-10
  2.4.4 External View of the SFC Chart ............................................................. 2-11
  2.5 SFC Elements .......................................................................................... 2-13
  2.5.1 What is a Sequencer? ............................................................................. 2-13
  2.5.2 What are Sequencer Elements? .............................................................. 2-14
  2.5.3 What is a Step? ..................................................................................... 2-16
  2.5.4 What is a Transition? ............................................................................ 2-17
  2.5.5 What is a Text? .................................................................................... 2-18
  2.5.6 What is a Sequence? ............................................................................. 2-18
  2.5.7 What is a Simultaneous Branch? ............................................................ 2-19
  2.5.8 What is an Alternative Branch? ............................................................ 2-20
  2.5.9 What is a Loop? ................................................................................... 2-21
  2.5.10 What is a Jump? ............................................................................... 2-22

3 Starting and Operating .......................................................................... 3-1
  3.1 Working with the SFC Editor ..................................................................... 3-1
  3.2 How to Start the SFC Editor ...................................................................... 3-1
  3.3 Navigating in the SFC ............................................................................... 3-2
  3.3.1 How to Navigate in the SFC ................................................................. 3-2
  3.4 User Interface and Operator Inputs ......................................................... 3-3
  3.4.1 Elements of the User Interface ............................................................. 3-3
  3.4.2 Dialog Boxes ....................................................................................... 3-8
  3.5 Working with the Mouse .......................................................................... 3-9
  3.6 Working with the Keyboard ..................................................................... 3-10
  3.6.1 Working with the Keyboard ................................................................. 3-10
  3.6.2 Key Combinations for Menu Commands ............................................. 3-10
  3.6.3 Shortcuts for Menu Commands ........................................................... 3-12
  3.6.4 Navigating in the Menu Bar and Menus with the Keyboard ............... 3-14
  3.6.5 Navigating in Dialog Boxes with the Keyboard .................................... 3-15
  3.6.6 Navigating in Texts with the Keyboard .............................................. 3-16
  3.6.7 Selecting Text with the Keyboard ....................................................... 3-16
  3.6.8 Keyboard Shortcuts in the Sequence .................................................. 3-17
  3.6.9 Opening Help with the Keyboard ......................................................... 3-17
## Contents

### 3.6.10 Changing the Window Section ................................................................. 3-17
### 3.7 Default Colors .......................................................................................... 3-18
### 3.8 Data Backup in the SFC Editor ................................................................. 3-19

### 4 Creating the Project Structure .................................................................... 4-1
- 4.1 How to Create a Project Structure .............................................................. 4-1
- 4.2 Creating, Configuring and Managing SFCs ............................................... 4-2
- 4.2.1 Overview of Creating, Configuring and Managing SFCs ..................... 4-2
- 4.2.2 Creating an SFC chart .......................................................................... 4-4
- 4.2.2.1 How to Create an SFC Chart .......................................................... 4-4
- 4.2.3 Creating an SFC Type and Creating an SFC Instance ......................... 4-5
- 4.2.3.1 How to Create an SFC Type ......................................................... 4-5
- 4.2.3.2 How to Create an SFC Instance ................................................. 4-6
- 4.2.4 Configuring an SFC Chart ................................................................... 4-7
- 4.2.4.1 Basics for Configuring an SFC Chart ........................................ 4-7
- 4.2.4.2 Configuration Changes in the SFC Chart ..................................... 4-9
- 4.2.5 Configuring the SFC Type and SFC Instance ...................................... 4-10
- 4.2.5.1 Type/Instance Concept of SFC .................................................... 4-10
- 4.2.5.2 Configuring the SFC Type ......................................................... 4-10
- 4.2.5.3 Configuration Changes in the SFC Type ..................................... 4-13
- 4.2.5.4 Configuring the SFC Instance .................................................... 4-14
- 4.2.5.5 Configuration Changes in the SFC Instance ................................ 4-16
- 4.2.6 Opening ................................................................................................. 4-17
- 4.2.6.1 How to Open SFC Charts or SFC Types ..................................... 4-17
- 4.2.6.2 How to Open SFC Instances ....................................................... 4-18
- 4.2.7 Copying .................................................................................................. 4-19
- 4.2.7.1 Copying and Moving SFC Charts .............................................. 4-19
- 4.2.7.2 Copying and Moving SFC Types ............................................... 4-21
- 4.2.7.3 Copying and Moving SFC Instances ......................................... 4-21
- 4.2.8 Deleting ............................................................................................... 4-22
- 4.2.8.1 How to Delete SFC Charts and SFC Types ................................ 4-22
- 4.2.8.2 How to Delete SFC Instances ...................................................... 4-22

### 5 Adapting the Properties of Charts, Types and Instances ......................... 5-1
- 5.1 How to Adapt Chart Properties .................................................................. 5-1
- 5.2 How to Adapt Type Properties .................................................................. 5-3
- 5.3 How to update SFC Types ........................................................................ 5-4
- 5.4 How to Adapt Instance Properties ............................................................. 5-4
- 5.5 Message Configuration ............................................................................. 5-6
- 5.5.1 How to Configure Messages in the SFC ............................................. 5-6
- 5.6 Configuring Characteristics ...................................................................... 5-8
- 5.6.1 Using the Characteristics Editor and the Interface Editor .................. 5-8
- 5.6.2 Characteristics of the SFC Type .......................................................... 5-9
- 5.6.3 Note on Subsequent Modifications to Control Strategies ................. 5-11
- 5.6.4 How to Configure Note Texts and Position Texts ............................... 5-12
- 5.6.5 Inputs/Outputs for Characteristics ..................................................... 5-13
- 5.6.6 Block Contacts .................................................................................... 5-14
- 5.6.7 Attributes for Characteristics .............................................................. 5-15

### 6 Configuring Sequential Control Systems .................................................. 6-1
- 6.1 How to Configure Sequential Control Systems ........................................ 6-1
- 6.2 Creating the Sequencer Topology ............................................................. 6-3
- 6.2.1 How to Create a Sequencer Topology ............................................... 6-3
- 6.2.2 How to Configure Multiple Sequencers .............................................. 6-5
- 6.2.3 Overview of Inserting/Creating SFC Elements .................................... 6-9
- 6.2.4 How to Create a Sequence .................................................................... 6-10
- 6.2.5 How to Create and Edit a Simultaneous Branch .................................. 6-11
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.2.6</td>
<td>How to Create and Edit an Alternative Branch</td>
<td>6-13</td>
</tr>
<tr>
<td>6.2.7</td>
<td>How to Create and Edit a Loop</td>
<td>6-14</td>
</tr>
<tr>
<td>6.2.8</td>
<td>How to Create and Edit a Jump</td>
<td>6-16</td>
</tr>
<tr>
<td>6.2.9</td>
<td>How to Create and Edit a Text Box</td>
<td>6-18</td>
</tr>
<tr>
<td>6.3</td>
<td>Managing SFC Elements</td>
<td>6-20</td>
</tr>
<tr>
<td>6.3.1</td>
<td>Selecting SFC Elements</td>
<td>6-20</td>
</tr>
<tr>
<td>6.3.1.1</td>
<td>How to Select with a Mouse Click</td>
<td>6-20</td>
</tr>
<tr>
<td>6.3.1.2</td>
<td>How to Select with the Keyboard</td>
<td>6-21</td>
</tr>
<tr>
<td>6.3.1.3</td>
<td>How to Select with the Lasso</td>
<td>6-21</td>
</tr>
<tr>
<td>6.3.1.4</td>
<td>How to Select Steps and Transitions for Editing</td>
<td>6-22</td>
</tr>
<tr>
<td>6.3.2</td>
<td>Copying, Moving and Deleting SFC Elements</td>
<td>6-23</td>
</tr>
<tr>
<td>6.3.2.1</td>
<td>How to Copy SFC Elements</td>
<td>6-23</td>
</tr>
<tr>
<td>6.3.2.2</td>
<td>How to copy object properties of SFC elements</td>
<td>6-25</td>
</tr>
<tr>
<td>6.3.2.3</td>
<td>How to Move SFC Elements</td>
<td>6-26</td>
</tr>
<tr>
<td>6.3.2.4</td>
<td>Deleting SFC Elements</td>
<td>6-28</td>
</tr>
<tr>
<td>6.4</td>
<td>Editing Sequencers</td>
<td>6-29</td>
</tr>
<tr>
<td>6.4.1</td>
<td>How to Edit Sequencer Properties</td>
<td>6-29</td>
</tr>
<tr>
<td>6.4.2</td>
<td>Editing in the Properties Dialog</td>
<td>6-31</td>
</tr>
<tr>
<td>6.4.2.1</td>
<td>How to Edit a Step</td>
<td>6-31</td>
</tr>
<tr>
<td>6.4.2.2</td>
<td>How to Edit Actions in a Step</td>
<td>6-33</td>
</tr>
<tr>
<td>6.4.2.3</td>
<td>How to Edit Addresses in a Step</td>
<td>6-35</td>
</tr>
<tr>
<td>6.4.2.4</td>
<td>Valid Entries for Addresses</td>
<td>6-38</td>
</tr>
<tr>
<td>6.4.2.5</td>
<td>How to Filter Block Inputs/Outputs</td>
<td>6-40</td>
</tr>
<tr>
<td>6.4.2.6</td>
<td>How to Access Structures</td>
<td>6-41</td>
</tr>
<tr>
<td>6.4.3</td>
<td>Editing Transitions</td>
<td>6-43</td>
</tr>
<tr>
<td>6.4.3.1</td>
<td>How to Edit the Transition</td>
<td>6-43</td>
</tr>
<tr>
<td>6.4.3.2</td>
<td>Formulating the Conditions of a Transition</td>
<td>6-46</td>
</tr>
<tr>
<td>6.4.3.3</td>
<td>How to Edit Addresses in a Transition</td>
<td>6-47</td>
</tr>
<tr>
<td>6.4.3.4</td>
<td>How to Edit OS Comments in a Transition</td>
<td>6-49</td>
</tr>
<tr>
<td>6.4.4</td>
<td>Shared Addresses and Valid Data Types</td>
<td>6-51</td>
</tr>
<tr>
<td>6.4.4.1</td>
<td>Shared Addresses</td>
<td>6-51</td>
</tr>
<tr>
<td>6.4.4.2</td>
<td>Absolute Addressing</td>
<td>6-51</td>
</tr>
<tr>
<td>6.4.4.3</td>
<td>How to Perform Symbolic Addressing</td>
<td>6-52</td>
</tr>
<tr>
<td>6.4.4.4</td>
<td>Valid Data Types</td>
<td>6-53</td>
</tr>
<tr>
<td>6.5</td>
<td>Specifying Runtime Properties</td>
<td>6-54</td>
</tr>
<tr>
<td>6.5.1</td>
<td>Runtime Properties of an SFC</td>
<td>6-54</td>
</tr>
<tr>
<td>6.5.2</td>
<td>How to Edit the Run Sequence</td>
<td>6-55</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Runtime Attributes for Runtime Groups and SFCs</td>
<td>6-56</td>
</tr>
<tr>
<td>6.6</td>
<td>Standard Interface and Chart Inputs/Outputs</td>
<td>6-59</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Inputs/Outputs of the SFC Chart Standard Interface</td>
<td>6-59</td>
</tr>
<tr>
<td>6.6.1.1</td>
<td>Standard Interface of the SFC Chart</td>
<td>6-60</td>
</tr>
<tr>
<td>6.6.1.2</td>
<td>Meanings in the Table</td>
<td>6-64</td>
</tr>
<tr>
<td>6.6.1.3</td>
<td>Inputs/Outputs of the SFC Chart Sorted According to Usage</td>
<td>6-65</td>
</tr>
<tr>
<td>6.6.2</td>
<td>Standard Interface of the SFC Type</td>
<td>6-66</td>
</tr>
<tr>
<td>6.6.2.1</td>
<td>Inputs/Outputs of the SFC Type Standard Interface</td>
<td>6-67</td>
</tr>
<tr>
<td>6.6.2.2</td>
<td>Inputs/Outputs of the SFC Type Sorted According to Usage</td>
<td>6-73</td>
</tr>
<tr>
<td>6.6.2.3</td>
<td>&quot;Inputs/Outputs&quot; Interface Expansions</td>
<td>6-73</td>
</tr>
<tr>
<td>6.6.3</td>
<td>&quot;Characteristics&quot; Interface Parameter Assignments</td>
<td>6-74</td>
</tr>
<tr>
<td>6.6.3.1</td>
<td>&quot;Control Strategies&quot; Characteristic</td>
<td>6-74</td>
</tr>
<tr>
<td>6.6.3.2</td>
<td>Characteristic for Note Texts</td>
<td>6-75</td>
</tr>
<tr>
<td>6.6.3.3</td>
<td>Characteristic for Position Texts</td>
<td>6-75</td>
</tr>
<tr>
<td>6.6.4</td>
<td>&quot;Characteristics&quot; Interface Expansions</td>
<td>6-76</td>
</tr>
<tr>
<td>6.6.4.1</td>
<td>&quot;Setpoints&quot; Characteristic</td>
<td>6-77</td>
</tr>
<tr>
<td>6.6.4.2</td>
<td>Meaning and Usage of Setpoints</td>
<td>6-85</td>
</tr>
<tr>
<td>6.6.4.3</td>
<td>&quot;Process Values&quot; Characteristic</td>
<td>6-89</td>
</tr>
<tr>
<td>6.6.4.4</td>
<td>&quot;Control Values&quot; Characteristic</td>
<td>6-89</td>
</tr>
<tr>
<td>6.6.4.5</td>
<td>&quot;Parameters&quot; Characteristic</td>
<td>6-90</td>
</tr>
</tbody>
</table>
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.6.4.6 &quot;Bit Memory&quot; Characteristic</td>
<td>6-90</td>
</tr>
<tr>
<td>6.6.4.7 &quot;Timers&quot; Characteristic</td>
<td>6-91</td>
</tr>
<tr>
<td>6.6.4.8 &quot;Block Contacts&quot; Characteristic</td>
<td>6-91</td>
</tr>
<tr>
<td>6.6.5 Inputs/Outputs of the Sorted by Usage</td>
<td>6-92</td>
</tr>
<tr>
<td>6.6.5.1 Operating Modes (SFC Inputs/Outputs)</td>
<td>6-92</td>
</tr>
<tr>
<td>6.6.5.2 Commands and Operating States (SFC Inputs/Outputs)</td>
<td>6-94</td>
</tr>
<tr>
<td>6.6.5.3 Execution Options (SFC Inputs/Outputs)</td>
<td>6-102</td>
</tr>
<tr>
<td>6.6.5.4 Group Displays and Group Acknowledgements (SFC Inputs/Outputs)</td>
<td>6-103</td>
</tr>
<tr>
<td>6.6.5.5 Data from Sequencers and Steps to be Processed (SFC Inputs/Outputs)</td>
<td>6-104</td>
</tr>
<tr>
<td>6.6.5.6 BATCH Parameters (SFC Inputs/Outputs)</td>
<td>6-105</td>
</tr>
<tr>
<td>6.6.5.7 Continuous Mode (SFC Inputs/Outputs)</td>
<td>6-106</td>
</tr>
<tr>
<td>6.6.5.8 Error Handling (SFC Inputs/Outputs)</td>
<td>6-107</td>
</tr>
<tr>
<td>6.6.5.9 Messages (SFC Inputs/Outputs)</td>
<td>6-110</td>
</tr>
<tr>
<td>6.6.5.10 Control Words (SFC Inputs/Outputs)</td>
<td>6-111</td>
</tr>
<tr>
<td>6.6.5.11 Status Words (SFC Inputs/Outputs)</td>
<td>6-112</td>
</tr>
<tr>
<td>6.6.5.12 System Parameters (SFC Inputs/Outputs)</td>
<td>6-117</td>
</tr>
<tr>
<td>6.6.5.13 Reserves (SFC Inputs/Outputs)</td>
<td>6-117</td>
</tr>
</tbody>
</table>

#### 7 Compiling SFC Types and SFC Instances

- 7.1 Overview of Compiling Charts, Types, and Instances                   | 7-1  |
- 7.2 Settings for Compiling/Downloading                                  | 7-3  |
- 7.2.1 How to Compile                                                   | 7-4  |
- 7.3 Overview of the Blocks Generated during Compilation                | 7-6  |
- 7.4 Consistency Check                                                  | 7-8  |

#### 8 Downloading to the AS

- 8.1 How to Download Programs                                            | 8-1  |

#### 9 Behavior of the Sequential Control System in the AS

- 9.1 Sequential Control Systems in the AS                                | 9-1  |
- 9.2 Specifying the Runtime Behavior                                    | 9-3  |
- 9.2.1 Runtime Behavior of the Sequential Control System                | 9-3  |
- 9.2.2 Operating Modes                                                  | 9-4  |
- 9.2.3 Step Control Modes                                               | 9-5  |
- 9.2.4 Execution Options                                                | 9-7  |
- 9.2.5 Operating States                                                 | 9-9  |
- 9.2.5.1 Operating State Logic for SFC (SFC OSL)                        | 9-10 |
- 9.2.5.2 Continuous Mode                                                | 9-17 |
- 9.2.5.3 Diagram of the State Changes for SFC OSL                       | 9-18 |
- 9.2.5.4 Operating State Logic for Sequencers (Sequencer OSL)           | 9-20 |
- 9.2.5.5 Diagram of the State Changes for Sequencer OSL                 | 9-22 |
- 9.3 Executing the SFC in the AS                                        | 9-23 |
- 9.3.1 Executing an SFC                                                 | 9-23 |
- 9.3.2 Executing an SFC after CPU Stop and Restart                      | 9-26 |
- 9.3.3 Commands                                                         | 9-28 |
- 9.3.4 Priority of the Commands                                        | 9-30 |
- 9.3.5 Start Requirements of an SFC (Chart/Instance)                    | 9-31 |
- 9.3.6 Executing the SFC Elements                                       | 9-33 |
- 9.3.6.1 Runtime Phases of a Step                                       | 9-33 |
- 9.3.6.2 Executing a Step and Transition                               | 9-34 |
- 9.3.6.3 Executing a Simultaneous Branch                                | 9-35 |
- 9.3.6.4 Executing an Alternative Branch                                | 9-36 |
- 9.3.6.5 Executing a Loop                                               | 9-36 |
- 9.3.6.6 Executing a Jump                                               | 9-37 |
- 9.4 Changing Control Strategies and Setpoints                         | 9-38 |
- 9.4.1 Changing the Control Strategy and Setpoints for an SFC Instance  | 9-38 |
- 9.4.2 Tracking the Control Strategy and Setpoints in AUTO Mode         | 9-40 |
1 SFC for SIMATIC S7

1.1 Introduction

What is SFC?

SFC (Sequential Function Chart) enables you to graphically configure and commission sequential control systems. The sequential control systems are transferred to an automation system and executed there. A sequential control system allows state-driven or event-driven execution of production processes based on sequencers.

You can use sequential control systems to describe the manufacturing specifications of products as event-driven processes (recipes), for example.

The sequential control system controls the basic automation functions created with CFC via operating and state changes and processes them selectively.

SFC provides two independent variants of sequential control systems for different application scenarios:

- SFC Chart
- SFC type with SFC instances
SFC Chart

A SFC chart contains the following:

- A standardized interface for controlling the SFC through the user program or by the operator
- Up to 8 sequencers for formulating the sequential control system ("gray sequencer")

The sequential control system accesses the basic automation blocks and signals directly and is therefore not reusable.
SFC Type / SFC Instance

An SFC type contains the following:

- A standardized interface for controlling the SFC through the user program or by the operator
- Up to 32 sequencers for formulating the sequential control system ("gray sequencer")

You can also expand the interface ("gray interface"). The SFC type accesses only its own interface and can therefore be used as often as required as an SFC instance.

An SFC instance is derived from an SFC type and initially has properties identical to those of the SFC type. You can adapt the SFC type to the SFC instance to a limited extent on an instance-specific basis through changes in the CFC or SFC.
Criteria for Selecting SFC Chart or SFC Type

You use an **SFC chart** when you need a sequential control system that is to be used once and the sequential control system will control multiple sub areas of the production plant.

You use an **SFC type** when you need a sequential control system that is used more than once and the sequential control system has SFC instances that will control its own sub area of the production plant. Central changes to an SFC type are automatically forwarded to all SFC instances.

You can use the following criteria in the order given to decide if an SFC chart or an SFC type is required:

- Sphere of action
- Reuse
- Changeability

Example of decision making:

If the sphere of action is large but the sequential control system is to be used more than once, you still may need to realize the sequential control system as an SFC chart in certain circumstances. Reuse is then only possible in the form of copies. In this case, you cannot make changes from a central location.

If the sphere of action is small, you can use either an SFC chart or an SFC type. Here, the decision depends on the ability to reuse and to change.

What is a Sequential Control System?

A sequential control system allows the structuring of production processes by breaking them down into consecutive steps. The steps define the actions to be executed and therefore the operations required in the production plant, for example:

- Switch on motor
- Open valve

The passage from one step to the next triggers a transition with a defined step enabling condition, for example:

- Temperature achieved
- Reactor empty
What are Sequencers?

You can use sequencers as a higher-level structuring tool that defines state or event-triggered sub-sequences, for example:

- Sequence for production
- Sequence for holding
- Sequence for error handling

You specify the state or event that is to trigger execution of the sequencer in the start condition of the sequencer. The sequencer itself is formulated as a series of steps and transitions.

A sequential control system contains at least one sequencer. In the initial state, its start condition is set so that the sequencer is processed when the sequential control system is in the "active" state (condition: RUN = TRUE).

Where are Sequential Control Systems Used?

Typical applications of sequential control systems involve batch processing plants. But you can also use sequential control systems for continuously operating plants, for example, for:

- Startup and shutdown operations
- Operating point changes
- State changes when faults occur

You can use sequential control systems in the following plant levels:

- Device control level (for example, opening a valve or starting a motor)
- Group control level (for example, dosing, stirring, heating, or filling)
- Unit level (for example, tanks, mixers, scales, reactors)
- Plant level (synchronization of units and common resources, for example, routing)

You can use SFC charts at all levels, while SFC types are generally used on the group control and unit levels since requirements for reusability at the higher levels are unlikely.

Notes

The SFC editor is a tool for creating and testing sequential control systems. In this documentation, the term "SFC" refers to the chart, type, instance or editor depending on the context.
1.2 Getting Started

1.2.1 How to Work with SFC in Overview

Operating Principle

1. You create your sequential control system using graphic tools in the SFC editor. You place the elements of the SFC in the sequencer according to fixed rules. You do not need to be aware of details such as algorithms or the assignment of machine resources but can concentrate solely on the technological aspects of your configuration.

2. After creating the sequencers as a series of steps and transitions, you proceed to configure the object properties of SFC, sequencers, steps and transitions, and formulate the respective properties there. You configure the following:
   - Operating parameters of the SFC
   - Start conditions of the sequencers
   - Actions of the steps
   - Step enabling conditions of the transitions

3. When this configuration is complete, you compile the executable machine code with SFC, download it to the AS, and test it with the SFC test functions.

SFC Chart

If you have never before worked with the SFC editor, it is best to begin with an SFC chart. In this way, you will require an understanding of the following topics:

- Creating, configuring, compiling and downloading a sequential control system
- How the sequential control system works in the AS
- How to use commands (such as Start and Abort) in a sequential control system in test mode
SFC Type and SFC Instance

Once you know how to implement a sequential control system with an SFC chart, you can begin to work with the SFC type and SFC instance. You can then decide which of the two sequential control systems is better suited for the specific task.

The SFC type and SFC instance introduce new aspects of working with sequential control systems. With the SFC chart, you can start working directly because an SFC chart can be generated and then compiled, downloaded and tested immediately.

With an SFC type, you create the sequential control system independent of a specific application in the form of a template so that it can be used more than once.

Then you create an SFC instance, adapt it to the individual application and interconnect to the basic automation blocks.

A standard interface must be available for the SFC type in order to interconnect an SFC instance with the basic automation. You can expand this interface to include new inputs/outputs or create the required inputs/outputs technologically as characteristics of the SFC type.

You then compile the program, download it to the AS, and test the SFC instance. This also tests the SFC type indirectly.

Additional Information

You will find more information on this subject in the following sections:

- Creating an SFC Chart
- Creating an SFC Type
- Creating an SFC Instance
1.2.2 How to Create an SFC Chart in Overview

Introduction

The steps for configuring SFC charts are presented in order below:

Procedure

1. Creating the Project Structure

Create a project structure in SIMATIC Manager in which you configure CFC/SFC charts.

For additional information, see:
How to Create a Project Structure

2. Adapt the chart properties

You can change the general properties (name, author, comment), adapt the operating parameters and change the version.

By setting the operating parameters, you specify the behavior of the sequential control system, such as operating mode (MANUAL, AUTO), step control mode (T, C, T and C etc.) and other execution options (cyclic execution, time monitoring or autostart).

In the chart properties, you can change the option that the chart is to be transferred to the OS.

For additional information, see:
How to Adapt Chart Properties

3. Runtime Properties

The runtime properties of an SFC chart specify how this SFC chart fits in the time sequence of the processing within the overall structure of the target system. You can change the runtime properties in the window of the sequence editor of CFC.

For additional information, see:
Runtime Properties of an SFC

4. Create the sequencers

The newly created SFC already contains one sequencer (RUN). You create additional sequencers in the tab of the currently selected sequencer using the context menu or you copy sequencers from the templates of the SFC Library.

For additional information, see:
How to Configure Multiple Sequencers

5. Configure the sequencer properties

For each sequencer, you configure the start condition and, as an option, the action for preprocessing and postprocessing and the OS comment, if needed.

For additional information, see:
Editing Sequencer Properties
6. Create the topology of the sequencers
   You configure sequential control systems in the SFC editor by inserting the steps and transitions for one or more sequencers and adding additional elements as necessary.
   
   For additional information, see:
   How to Create a Sequencer Topology

7. Configure the steps (in the object properties dialog box)
   You formulate actions in steps. The actions contain statements that change the values of block inputs and of shared addresses or that enable and disable runtime groups or other SFC charts.
   
   For additional information, see:
   How to Edit a Step

8. Configure the transitions (in the object properties dialog box)
   You formulate conditions in the transitions to read the following:
   - The values of the block inputs/outputs and shared addresses
   - The state (such as on/off) of runtime groups or other SFC charts
   When the conditions of a specified logic operation are met, the next step becomes active in the execution of the SFC and its actions are executed.
   
   For additional information, see:
   How to Edit a Transition

9. Compile and downloading the program
   When you compile the current chart folder, an executable user program is generated (compile entire program) that you can then download to the target system (CPU).
   
   You will find more information on this subject in the following sections:
   "Overview of Compiling Charts, Types, and Instances"
   "How to Download Programs"
10. Test the program

After compiling and downloading, you test the program in process mode or in laboratory mode. Using the SFC test functions, you can run the sequential control system in various operating modes and step control modes and monitor and modify the values of addresses in the CPU. You can also influence the most important operating modes (e.g., STOP, Clear/Reset, RUN, for example) of the CPU.

For additional information, see:
Operator Control and Monitoring during Testing

---

**Note**

Prior to compiling (Item 9), you must interconnect the external view of the SFC chart or the SFC instance (of the SFC type) for AUTO mode in the CFC chart.

For additional information, see:
External View of an SFC Chart

---

**Tips**

The following tips may help you:

- In the "SFC Library", you can access the "ChartStates" SFC chart with the menu command **SFC Library > Blocks+Templates > Templates**. This already contains several sequencers for state-oriented processing of the sequential control system. You can copy this chart and use it as an example.

- If you want to focus initially on learning the steps from creation to testing of a sequential control system, you should compile, download and test the "ChartStates" SFC chart (or a newly created SFC chart) without any modifications. The SFC chart is processed in MANUAL mode. In this way, you can monitor and influence the processing of the SFC chart in test mode with the available test functions.

- To stop the SFC chart from being processed "too quickly" in the automation system, you can move the SFC chart in the run sequence, for example, to the "OB32" task. Select the menu command **Test > Test Settings** and select a suitable monitoring cycle for the test settings in the SFC.
1.2.3 How to Create an SFC Type in Overview

Introduction

The steps for configuring SFC charts are presented in order below:

Procedure

1. Creating the Project Structure

Create a project structure in SIMATIC Manager in which you can configure CFC/SFC charts.

For additional information, see:
How to Create a Project Structure

Note:
You can also create an SFC type in a library.

2. Create the SFC type

In the Component view of SIMATIC Manager, insert an SFC type as a new object in the chart folder. The SFC type is entered in the block catalog of CFC.

Tip: In the "SFC Library", you can access the "TypeStates" SFC type with the menu command SFC Library > Blocks+Templates > Templates. The SFC type already contains several sequencers for state-oriented processing of the sequential control system. You will also find the "TypeCtrlStrategy" SFC type. It contains a control strategy-oriented processing of the sequential control system. You can copy these templates and change them to suit your purposes.

You will find more information on this subject in the tips in the section:
Configuring the SFC Type

3. Adapt the SFC properties

You can change the general properties (name, author, family, FB number, comment), adapt the operating parameters and change the version.

By setting the operating parameters, you specify the behavior of the sequential control system, such as operating mode (MANUAL, AUTO), step control mode (T, C, T and C, for example) and other execution options (cyclic execution, time monitoring or autostart, for example).

For additional information, see:
How to Adapt the Type Properties
4. Create the interface

The SFC type already has a standard interface that usually must be extended for the interconnections of SFC instances with the basic automation.

For more information, refer to the SFC online help in the following sections:
- Standard Interface of an SFC Type
- "Inputs/Outputs" Interface Expansions
- "Characteristics" Interface Expansions

5. Optional: Configure the characteristics

You use the characteristics editor for the technological configuration of the interface. In the characteristics editor, you define characteristics and insert control strategies, setpoints, process values or block contacts, for example.

For additional information, see:
- Characteristics of the SFC Type

6. Create the sequencers

Open the SFC type. The newly created SFC already contains one sequencer (RUN). You create additional sequencers in the tab of the currently selected sequencer with the context menu or you copy sequencers from the templates in the SFC Library (SIMATIC Manager). You can copy these templates and adapt them to suit your purposes.

For additional information, see:
- How to Configure Multiple Sequencers

7. Configure the sequencer properties

For each sequencer, you configure the start condition and, as an option, the action for preprocessing and postprocessing and the OS comment, if needed.

For additional information, see:
- Editing Sequencer Properties

8. Create the topology of the sequencers

You configure sequential control systems in the SFC editor by inserting the steps and transitions for one or more sequencers and adding additional elements as necessary.

For additional information, see:
- How to Create a Sequencer Topology

9. Configure the steps (in the "Object Properties" dialog box)

You formulate actions in steps. The actions contain statements that change the values of inputs of the interface of the SFC type.

For additional information, see:
- How to Edit a Step
10. Configure the transitions (in the "Object Properties" dialog box)

You formulate conditions in the transitions to read the values of inputs/outputs from the interface of the SFC type. When the conditions of a specified logic operation are met, the next step becomes active in the execution of the SFC and its actions are executed.

For additional information, see:
How to Edit a Transition

11. Create the SFC instances

For more information, refer to the section:
How to Create an SFC Instance
1.2.4 How to Create an SFC Instance in Overview

Introduction

The steps for configuring SFC instances are presented in order below:

Procedure

1. Open the CFC chart

   Open the CFC chart in which you want to interconnect an SFC instance to the basic automation blocks.

   Place the SFC type in the chart from the CFC block catalog or from a library and thereby generate an SFC instance.

   For additional information, see:
   - How to Create an SFC Instance

2. Specify the SFC instance properties

   Change the general properties (name, comment) in the object properties of the SFC instance in the CFC, as required.

   For additional information, see:
   - How to Adapt Instance Properties

3. Adapt the operating parameters and options of the instance

   In the CFC, open the SFC instance and adapt the operating parameters in the "Properties" dialog box. These parameters determine the runtime behavior in the AS.

   As an option, select which of the control strategies specified by the SFC type are to be used for the SFC instance.

   For additional information, see:
   - How to Adapt Instance Properties

4. Assign parameters and interconnect the interface of the SFC instance

   You assign parameters for the SFC instance in CFC using the object properties or in SFC using the "I/Os" interface editor.

   In CFC, you interconnect the inputs/outputs of the SFC instance to the inputs/outputs of the CFC blocks or to shared addresses.

5. Compile and download the program

   When you compile the current chart folder, an executable user program is generated (compile entire program) that you can then download to the target system (CPU).

   You will find more information on this subject in the following sections:
   - "Overview of Compiling Charts, Types, and Instances"
   - "How to Download Programs"
6. Test the program

After compiling and downloading, you can test the program in process mode or in laboratory mode. Using the test functions, you run the sequential control system online in various operating modes and step control modes and monitor and modify the values of addresses. You can also influence the most important operating modes (STOP or RUN, for example) of the CPU.

For additional information, see:
Operator Control and Monitoring during Testing
2 Basics of SFC

2.1 SFC in the STEP 7 Environment

Configuration Environment

SIMATIC manager is used as the graphic user interface for all target systems and it is used to coordinate the tools and objects. It manages tools and data and is used, among other things, to created and modify a project structure (CPU, CFC/SFC charts) and to start the SFC editor.

The figure shows how SFC fits into the STEP 7 and PCS 7 environment:
**Key:**

<table>
<thead>
<tr>
<th>Object</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>PH (Plant Hierarchy)</td>
<td>Software packages of the process control system (PCS 7)</td>
</tr>
<tr>
<td>IEA (Import/Export Assistant)</td>
<td></td>
</tr>
<tr>
<td>PO (process object view)</td>
<td>Operator control and monitoring system in PCS 7 (here with the optional package for SFC Visualization).</td>
</tr>
</tbody>
</table>

**WinCC**

Operator control and monitoring system in PCS 7 (here with the optional package for SFC Visualization).
2.2 SFC and Plant Hierarchy

Use of an SFC in the Plant Hierarchy

The plant hierarchy (PH) allows charts to be arranged and managed not only from the point of view of running them on a CPU, but also according to technological or plant criteria (for example, an SFC chart for device control, group control, or unit control).

If the SFC chart was assigned to a plant hierarchy folder, the path of the plant hierarchy is added to the chart name. You thus use the naming scheme of your plant as the criteria for arranging charts in the project.

---

Note

You cannot assign SFC types to a hierarchy folder in the plant view since they themselves are not relevant to execution (from the perspective of the process to be automated).

---

Additional Information

You can find additional information on the plant hierarchy in the online help for PH.

2.3 SFC and Other Target Systems

SFC and Other Target Systems

This SFC for S7 documentation contains a considerable amount of information that is only relevant for the S7 target system. To avoid needing to point this out in each individual case, the most important topics and functions that are irrelevant or are handled different for other target systems are listed below.

- Symbolic addressing
- Shared addresses
- Program-controlled enabling/disabling of charts
2.4 Use and Functionality of SFCs

2.4.1 What is an SFC Chart?

Use and Functionality

An SFC chart is a sequential control system that normally controls a larger section of a plant and is only used once since the same control task does not occur again in the plant.

To this end, the SFC chart has a set of properties and a standardized interface for controlling the SFC through the user program or by the operator. The sequential control system accesses the basic automation blocks and signals directly and is therefore not reusable.

To configure the sequential control system, you must know the mechanisms for processing an SFC and its sequencers in the AS. You will find more information on this subject in the following sections:

- Sequential Control Systems in the AS
- Runtime Behavior of the Sequential Control System
- Operating States
- Operating State Logic for SFC
- Executing an SFC
Properties

The properties of the SFC chart include the following elements:

- Name, author and comment as descriptive data
- The operating parameters for the AS that determine the execution in the AS (for example, operating mode, step control mode, execution options).

You will find more information on this subject in the following sections:

- Operating Modes
- Step Control Modes
- Execution Options
- Runtime Behavior of the Sequential Control System

You can also specify whether operator control and monitoring of the SFC chart on the OS is to be possible ("Transfer chart to OS for visualization" check box). You require the "SFC Visualization" optional package on the OS for this.

You can configure the message properties and the footer data of the SFC chart as additional properties.

Control

The standard interface of the SFC chart contains the required inputs/outputs for the following tasks:

- Controlling the SFC chart in AUTO mode via the user program
- Operator control and monitoring of the SFC chart in MANUAL mode by the operator

The control of the SFC chart in AUTO mode is configured in the external view of the SFC chart.

For additional information, see:
- External View of an SFC Chart

You will find more information on the SFC chart in the following sections of the online help:

- Standard Interface of the SFC Chart
- Inputs/Outputs of the SFC Chart Standard Interface
- Inputs/Outputs of the SFC Chart Sorted by Usage
Sequencers

The actual sequential control system is formulated with the sequencers.

The SFC chart allows configuration of up to 8 sequencers for formulating the control function ("gray sequencer").

You will find more information on sequencers in the following sections:

- What is a Sequencer?
- What is an SFC Type/an SFC Instance?
- SFC Chart and SFC Type Compared
2.4.2 What is an SFC Type / SFC Instance?

SFC Type

An SFC type is a sequential control system that normally controls a smaller sub area of a plant (unit or section of a plant, whereby the control task occurs repeatedly in similar form in the plant. For this reason, with the SFC type the sequential control system is created as a type-defined template apart from a specific application. Once it is created, you can use the SFC type repeatedly by generating SFC instances from it.

The SFC type contains a standardized interface to allow control of the SFC from the user program or by the user and allows configuration of up to 32 sequencers for formulating the control function ("gray sequencer"). The interface can also be expanded by the user ("gray interface"). The SFC type accesses only its own interface and can therefore be used as often as required as an SFC instance.

SFC Instance

An SFC instance is derived from an SFC type and initially has properties identical to those of the SFC type. You can adapt the SFC instance to a limited extent on an instance-specific basis in CFC or SFC. Only after interconnecting the SFC instance with blocks and signals of basic automation do you have an executable sequential control system.
Properties of an SFC Type and an SFC Instance

The properties of the SFC type and SFC instance include the name and comment as descriptive data. The SFC type has the additional properties author, version and family and FB number as information for the compilation. Both for the SFC type and the SFC instance, you can specify the operating parameters for the AS that determine the execution in the AS (for example, operating mode, step control mode or execution options).

You will find more information on this subject in the following sections:

- Operating Modes
- Step Control Modes
- Execution Options
- Runtime Behavior of the Sequential Control System

You can also set additional options and specify whether the SFC type and SFC instance are relevant for SIMATIC BATCH and which of the defined control strategies will be enabled for use with the SFC type or SFC instance. As additional properties, you can configure the message properties and the footer data of the SFC type and SFC instance.

SFC instances can be made available on the OS (default: Yes), so that operator control and monitoring of the SFC instances can be performed on the OS with the "SFC Visualization" optional package. If you do not want SFC instances to be available on the OS, you need to clear the "OCM possible" check box in the object properties for the instance.

The standard interface of the SFC type includes the inputs/outputs needed to control an SFC instance from the user program in AUTO mode or for operator control and monitoring of the SFC instance by the user in MANUAL mode.

You will find detailed information on the standard interface in the section: Standard Interface of the SFC Type

To interconnect an SFC instance with the basic automation, you usually need to expand the interface for the SFC type. You can do this by adding new inputs/outputs directly for the interface of the SFC type or by creating the necessary inputs/outputs technologically as characteristics of the SFC type. We recommend this procedure.

You will find more information on the interface in the following sections:

- "Characteristics" Interface Parameter Assignments
- "Characteristics" Interface Expansions
- "Inputs/Outputs" Interface Expansions
The actual sequential control system is formulated with the sequencers. You will find more information on sequencers in the section: What is a Sequencer?

To configure the sequential control system, you must know the mechanisms for processing an SFC and its sequencers in the AS.

You can find additional information about this in the following sections:

- Sequential Control Systems in the AS
- Runtime Behavior of the Sequential Control System
- Operating States
- Operating State Logic for SFC
- Executing an SFC
2.4.3 SFC Chart and SFC Type Compared

Common Features
An SFC chart and an SFC type have the following common features:
- Standard interface for external control of the SFC (MANUAL/AUTO)
- Sequencers for formulating the control function of the SFC

Differences
An SFC chart and an SFC type differ as follows:

<table>
<thead>
<tr>
<th>SFC Chart</th>
<th>SFC Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct access to basic automation</td>
<td>Access to basic automation by means of interface</td>
</tr>
<tr>
<td>Can be used once</td>
<td>Can be used more than once</td>
</tr>
<tr>
<td>Can be modified locally</td>
<td>Can be modified centrally</td>
</tr>
<tr>
<td>Interface cannot be expanded</td>
<td>Interface can be expanded</td>
</tr>
<tr>
<td>Maximum of 8 sequencers can be configured</td>
<td>Maximum of 32 sequencers can be configured</td>
</tr>
</tbody>
</table>
2.4.4 External View of the SFC Chart

Display

The external view of the SFC chart represents the SFC chart in a CFC chart as a block with its interface. To distinguish it from CFC blocks and nested charts, the external view has the "SFC chart" icon in the header.

![External View of the SFC Chart](image)

Purpose

In the external view, you can assign parameters for and interconnect the interface of the SFC chart for AUTO mode so that the status of the SFC chart can be determined and the control signals can be derived from it for the SFC chart. This allows you to influence the processing of the SFC chart via the user program. If the SFC chart is used in MANUAL mode, only the inputs/outputs that are also processed in MANUAL mode are relevant in the external view.
Interconnection
You can provide the inputs/outputs with textual interconnection and/or interconnect them with compatible inputs/outputs of other objects or with shared addresses. You make all interconnections in the sheet bar. You cannot place any object, such as blocks, in this window.

Properties
You can open the object properties for the entire interface or for each individual I/O in the header of the external view. The Run Sequence window opens in the runtime properties box.

You will find more information on the interface in the following sections:
- Standard Interface of the SFC Chart
- Inputs/Outputs of the SFC Chart Sorted by Usage
2.5 SFC Elements

2.5.1 What is a Sequencer?

Sequencer

Sequencers enable status-dependent and event-driven execution in the SFC.

When it is created, each sequencer is given a consecutive number. This number is required for the "programmed target steps" and to interpret the outputs of the SFC in the CFC view.

An SFC chart can include a maximum of 8 sequencers and an SFC type a maximum of 32 sequencers, which can be controlled by defining different start conditions.

One sequencer at a time is displayed in the working window of the SFC. You switch to another sequencer via the tab at the lower edge of the window.

When you create a new SFC chart/type, a sequencer with the name "RUN" and the start condition RUN=TRUE is created automatically (Note: This corresponds to a chart of V5). The start conditions are formulated like transition conditions. For more information, refer to the section What is a Transition? An empty start condition – in contrast to the transition – is evaluated as FALSE, in other words, the sequencer is never executed.

In addition to this start condition, each sequencer also contains the "Priority" attribute (1 – 255) that is used to specify the start order if the conditions of several sequencers are satisfied simultaneously (in the "Start Condition" tab of the "Sequencer Properties" dialog box). If the conditions of multiple sequencers with the same priority are met simultaneously, the position of the sequencer in the tab determines the order of processing in the CPU (similar to the alternative branch; you will find information on this in the section Executing an Alternative Branch).

You can also configure an additional action for each sequencer. Each action consists of the following:

- **Preprocessing**, actions to be executed in every cycle after the sequencer has started and before the steps and transitions are processed
- **Postprocessing**, actions to be executed in every cycle after the steps and transitions are processed

This, for example, allows you to make pre-settings or to pass on the results of the sequencer processing.

You will find more information on configuring sequencers in the section: Configuring Multiple Sequencers
2.5.2 What are Sequencer Elements?

Sequencer Elements

An SFC chart consists of 1 to 8 sequencers and an SFC type of 1 to 32 sequencers, each with a series of sequencer elements (basic elements). This includes the following elements:

- Step
- Transition

There is another element outside a sequence (can be freely positioned):

- Text

The remaining elements are structures that are made up of different basic elements:

- Sequence
- Simultaneous Branch
- Alternative branch
- Loop
- Jump

Identification of "Step" and "Transition"

The identification characteristic of the basic elements, step and transition, is a name that is unique within the sequencer. When the element is created, the editor enters a consecutive number that you can change to a name with a maximum of 16 characters. This name must not consist exclusively of numbers. The original number is retained for the element and is displayed in the object properties in the "Number" box. This is required for the "programmed target steps" and to interpret the outputs of the SFC in the CFC view.

You can use the optional comment, for example, to provide a text description of the respective functionality. A comment can take up several lines and contain up to 80 characters, however, only 16 characters are displayed to the right of the chart element.

If you position the cursor on the step or the comment, you can see a tooltip displaying the name with a maximum of 16 characters and a comment with up to 50 characters.
Resources
When programming and assigning parameters for steps, transitions, start condition and preprocessing and postprocessing in SFCs, you can access the interface of the SFC, the CFC block inputs/outputs, the runtime groups, other SFCs, and all shared addresses of the user program. With the textual interconnections, you can also access objects that do not yet exist. When you configure steps and transitions in SFC types, it is only possible to use the SFC type’s own interface inputs/outputs in addition to the textual interconnections.

Screen Display
The elements of an SFC are shown on the screen as follows:

- All the elements of a sequencer, including the links are displayed in white with black print in the unselected and unedited state.
- Selected elements, including the links are displayed in blue.
- Edited steps or transitions (whose object properties have been changed) are displayed in gray with black print.

Note
The colors indicated here are the default settings, some of which can be modified. For additional information, see: Default Colors.
2.5.3 What is a Step?

Step

The step is a control entity for executing the assigned actions in the AS. You can configure up to three actions (Initialization, Processing, Termination) for each step.

Action

An action is a series of statements formulated as follows:

- Assignments for assigning parameters of CFC blocks or shared resources, for example:
  - Settemp := 100
  - XYZ.pump.on := TRUE
- Enabling or disabling of an SFC or a runtime group, for example:
  - SFC_1.INTONOFF := TRUE
  - ABL_1.EN := FALSE

Step Types

You can use one start step, a maximum of 253 normal steps, and one final step in each sequencer. When a sequencer is created, one start step, one final step and one transition are created automatically. These three basic elements form the initial state of a sequencer that you can then adapt by adding further chart elements.

The **start step** is activated at the start of the sequencer and the associated actions are executed according to the status of the successor transition. The final step does not have a successor transition; all actions are processed exactly once.

You cannot copy, cut or delete the start step or final step. This ensures sure a sequencer always contains one (and only one) start step and final step.

All steps besides the start step and final step are **normal steps**.
2.5.4 What is a Transition?

Transition

A transition contains the conditions with which a sequential control system passes control from one step to the next. Several conditions can be logically combined using Boolean operators. The result of the logic operation determines whether the next step is enabled.

Transition Condition

The result of a transition condition in an SFC chart is derived from a Boolean expression that is formed by logic operations on the values of the following elements:

- Shared addresses
- Textual interconnections
- CFC block inputs/outputs
- Runtime group status
- SFC chart status

In SFC types, only the inputs/outputs of the SFC type’s own interface can be used in addition to the textual interconnections.

During compilation, an empty transition is pre-assigned the default value TRUE. This pre-assignment is necessary because while the formulation of a condition is optional, the AS requires a defined value as a step enabling condition.

If several transitions are valid simultaneously, for example, in the alternative branch, for a loop or jumps), the system automatically assigns priority from left to right in descending order.
2.5.5  What is a Text?

Text

You can use the “Text” chart element to insert any static text (free text) you require in a chart.

The text box can contain one-line or multiple-line character strings. For example, this allows you to insert descriptive texts into the SFC during the analysis phase that can later be replaced by automation functions.

Free texts are not embedded in the topological sequencer structure. If you change the topology, the text boxes are not repositioned; they maintain their position.

2.5.6  What is a Sequence?

Sequence

A sequence is a series of steps and transitions that can be created with a selectable length and inserted in the sequential control system.

Sequencer

A closed sequence forms one sequencer in a sequential control system, for example between the divergence and convergence of a simultaneous or alternative branch. The entire sequencer is also designated as a sequencer in SFC. It runs from the start step to the final step.
2.5.7  What is a Simultaneous Branch?

Simultaneous Branch

If the execution is to be split into two or more sequencers that are to be executed at the same time, the simultaneous branch is used.

A simultaneous branch consists of at least two sequencers that are executed at the same time.

A simultaneous branch is always preceded by a transition or an alternative branch. The simultaneous branches end in a simultaneous convergence that is always followed by a transition or alternative branch.

The successor transition executes only when all actions of the steps at the end of every associated sequencer have been executed (apart from the "termination" action) and the step enabling condition is fulfilled (synchronization).

Key:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Sequencer</td>
</tr>
<tr>
<td>(2)</td>
<td>Successor transition</td>
</tr>
</tbody>
</table>
2.5.8 What is an Alternative Branch?

Alternative branch

If the execution is to be split up into two or more sequencers but only one of these sequencers is to be executed, an alternative branch is used.

An alternative branch consists of at least two sequencers, of which only one will be executed depending on the state of the first transitions in the individual sequencers. The sequencer whose transition is fulfilled first is selected. If more than one transition is fulfilled simultaneously, the sequencer furthest left with a fulfilled transition is executed.

The alternative branch can only be preceded and followed by a step or a simultaneous branch.

Key:

| (1) | Sequencer |
| (2) | Next step |
2.5.9 What is a Loop?

Loop

If a section of the sequencer is to be executed again contingent on a transition, a loop is used.

A loop consists of a sequence and a return path with a transition that encloses a sequence. The start of the loop must be immediately following a step and the return path must converge again immediately before a step.

Key:

1. Sequence
2. Return path
3. Successor transition

The transition of the return path is processed chronologically after the successor transition.

If the successor transition and the return path transition are fulfilled at the same time, the step or simultaneous branch located after the successor transition is executed.

Note
Return paths out of or into simultaneous or alternative branches are not possible.
2.5.10 What is a Jump?

Jump

A jump can be used, contingent on a transition condition, to continue the execution of the sequencer at any step within the same sequencer.

A jump always leads immediately out of the sequence following a step (origin of the jump). Several jumps are also possible.

A jump consists of an initiating transition and an arrow with the jump destination information. The jump destination specification is the name of the step at which the execution is continued when the transition is fulfilled. If the jump destination is still unknown, the name is "???".

The transition of the jump is processed chronologically after the successor transition.

If the successor transition and one or more jump transitions are fulfilled at the same time, the step (or simultaneous branch) located after the successor transition is executed.

The origin and destination of a jump must always be a step.

Key:
(1) Jump origin
(2) Jump
(3) Jump destination
(4) Successor transition

Note
Be aware of the possible consequences during execution in the AS when working with jumps to or from a sequencer of a simultaneous branch.

For more information, refer to the section: How to Create and Edit a Jump.
3 Starting and Operating

3.1 Working with the SFC Editor

SFC Editor
You create your sequential control system using graphic tools in the SFC editor by specifying actions and step enabling conditions. The elements of the SFC are positioned in the sequencer according to fixed rules. You do not need to be aware of details such as algorithms or the assignment of machine resources; you can concentrate solely on the technological aspects of your configuration.

After creating the sequencers as a series of steps and transitions, you proceed to configure the object properties of SFC, sequencers, steps and transitions. You configure the operating parameters of the SFC, the start conditions of the sequencers as well as the actions of the steps and the step enabling conditions of the transitions.

After configuration, you compile the executable machine code with SFC, download it to the CPU, and test it with the SFC test functions.

3.2 How to Start the SFC Editor

Introduction
You can call the CFC editor directly or via SIMATIC Manager.

Starting via SIMATIC Manager:
Double-click the icon of the desired SFC chart.
The SFC editor starts and opens the chart.

Starting via the Windows Desktop:
Double-click on the icon of the desired SFC chart on your desktop.
or
Select the program listing in the Start menu with the menu command Start > SIMATIC > STEP 7 > SFC.
3.3 Navigating in the SFC

3.3.1 How to Navigate in the SFC

Introduction
There are several ways in which you can navigate in an SFC.

Changing the Display Size
- Select one of the menu commands, View > Zoom > Zoom In / Zoom Out / Normal Size / Zoom Factor.
  This allows you to change the size of the displayed SFC elements - and therefore also the visible section of the window.
  or
- Use the icon in the toolbar to zoom in and the icon to zoom out.

Changing the Displayed Section
You can change the displayed section as follows:
- Using the scroll bars
- With the View > Center menu command or by clicking the icon
- by dragging the SFC elements over the window border (automatic scrolling of the window section)
- With the keyboard

Switching between Sequencers
If the SFC consists of several sequencers, you can switch from one sequencer to another as follows:
- Using the tabs in the bottom horizontal scroll bar
- Using the menu commands Edit > Go To > Next Sequencer or > Previous Sequencer
3.4 User Interface and Operator Inputs

3.4.1 Elements of the User Interface

SFC Editor

The SFC editor is a Windows application consisting of the following elements:

- Frame window with title bar
- Menu bar
- Toolbar
- Status Bar
- At least one working window

You execute functions and operator inputs using menu commands (menu bar, context menu) and in dialog boxes as needed.

It is generally advisable and more efficient to manipulate functions and objects using the mouse. Most operations can be also performed using the keyboard.
Windows
Within the SFC editor, you can open as many windows as you wish (within the limits of Windows). Each window contains the view of an SFC (chart or type). You can also open several windows for the same SFC. The window in the foreground is always the active application window. This means that the menus and buttons in the toolbar always apply to this window.

At the lower edge, there is a scroll bar with which you can move the content in the visible part of the window.
This bar also contains the tabs with which you can navigate from one sequencer of the chart to another.

Title Bar
The title bar of the SFC window contains the name "SFC" and the buttons typical for Windows applications. If you display the SFC maximized to the full screen display, the name also appears in the title bar of the SFC window, since the title bar of the workspace is no longer displayed. The title bar of the online window can be distinguished from the title bar of the offline window by the different colored background and/or the text (can be specified in SIMATIC Manager using Options > Customize > "View" tab).

Menu Bar in the SFC Window
The menu bar of the SFC window is always visible below the title bar. There are two different combinations of menus depending on whether or not an SFC is open.
- If no SFC is open, the window is displayed with an empty editing area and the menu bar is limited to four menus (SFC, View, Options, Help).
- If at least one SFC is open, the complete menu bar is displayed with all menu titles.
- If several charts are open, the commands of the menu bar relate to the active window.

Menu
A menu is a group of functions that can be selected and activated in the menu bar. Menu commands that are not applicable in a particular situation are displayed in gray and cannot be selected.

Opening a Menu
You open menus by clicking the menu title or, using the keyboard, by typing the underlined character in the menu title while holding down the ALT key.
If you hold down the left mouse button, you can move through the menu bar and open and close the menus one after the other (browsing).
Context Menu

By right-clicking in the current context, you can display a context menu containing frequently needed commands from the menu bar. You obtain a different context menu with the following objects:

- Free area
- SFC element
- "Properties" dialog box in the editing window
- "Properties" dialog box in a selected line outside the editing window

Icons in the Toolbar

The icons in the toolbar can be used to start some of the most important functions from the menus.

Depending on the current state of the editor, only the command icons that can be applied in a specific situation are activated.

If you hold the hover the mouse pointer over an icon in the toolbar for a short time, the tooltip for the button is displayed. The status bar displays a more detailed description of the function of the button.

When you click the question mark icon, the cursor changes its appearance. You can now click a button, a menu command or an object in a chart. Help on the selected element will appear.

Icons in the Element Bar

The icons in the element bar represent the functions of the "Insert" menu.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

Key:

| (1) | Activate selection |
| (2) | Insert step + transition |
| (3) | Insert simultaneous branch |
| (4) | Insert alternative branch |
| (5) | Insert loop |
| (6) | Insert jump |
| (7) | Insert text |
**Positioning the Toolbar and Element Bar**

You can freely position the toolbar and element bar any place on the desktop, as is usual in Windows. Press the left mouse button at any free space on the bar and drag it to the desired location. The arrangement of the icons is either horizontal or vertical depending on the position of the bar.

If you position the toolbar or element bar in the workspace away from the edge, it is displayed as a dialog box with a "Close" button.

If you close the toolbar or element bar, you can display it again with the menu command **View > Toolbar** or **View > Element Bar**.

**Status Bar**

The status bar is located at the bottom edge of the SFC window and displays important information.

The left part of the status bar displays contextual information, for example explanations of menu commands, operator prompts or error messages.

The right part of the status bar displays current information such as the current location of an element. In test mode (online), the operating state of the CPU is displayed and also visualized by a color (red = STOP, green = RUN).

**Optional Layout**

While the menu bar is always visible, you can toggle the display of the toolbar, element bar and status bar on or off, for example to make more room on your screen. You can specify what is displayed by selecting the appropriate command in the "View" menu.
3.4.2 Dialog Boxes

Operator Control

When you activate some functions, a dialog box opens. Here, you can make settings and selections for the function you have activated. In the dialog boxes of modal dialogs, you cannot make selections or entries outside the box. You must first close the dialog box by clicking "OK" or "Cancel". The dialog boxes for "Properties" and "Browse", on the other hand, remain on the user interface while you continue to edit the sequencer topology or select other menu functions (except for activating test mode: here, the dialog boxes are closed).

Layout

Some dialog boxes contain tabs. This means that several pages (tabs) are cascaded on the screen. You can navigate from tab to tab as necessary.

To make configuration more convenient, some dialog boxes not only offer standard buttons (such as OK, Cancel, Help), they also have buttons with useful functions.

In the "Object Properties" dialog box, you can use the buttons ![left arrow] ![up arrow] ![down arrow] ![right arrow] within the sequencer to access the next element of the selected element type (step or transition) without having to open and close the box again each time. The jumps to the base elements are in the logical order and not the geometrical order.

With ![left arrow], in a simultaneous or alternative branch you jump from left to right to the first element of the next sequencer.

With ![left arrow], you jump from right to left to the last element of the sequencer further left.

With ![down arrow] you move from top to bottom in a sequencer. When a simultaneous or alternative branch is reached, only the left sequencer is executed.

With ![up arrow] you move from top to bottom in a sequencer. When a simultaneous or alternative branch is reached, only the right sequencer is executed.
3.5 Working with the Mouse

Mouse and Pointer
The main tool for working with the SFC editor is the mouse. You can perform most operations with the mouse, in particular those for selecting, moving, and inserting chart elements. In some situations, the mouse pointer changes its appearance and may take the shape of an arrow, hand or hourglass.

In addition to the standard pointer in insert mode, the SFC editor also uses the icons of the chart elements to be inserted, as they are displayed in the toolbar or element bar. The icons also have a small cross to enable exact positioning (top left). This additional cross is referred to as a positioning cross in the following.

For move or copy functions, the positioning cross also appears along with a hand icon when a position is reached where the element is permitted.

Autoscrolling
When moving elements in a chart, you can scroll the displayed window if the insertion position of the element is not currently visible. Holding down the left mouse button, drag the object to the edge of the window so that the positioning cross is on the inner (horizontal or vertical) line of the window frame. The window is then scrolled until the limit of the chart is reached or until you pull the positioning cross away from the edge of the window.

Shortcuts using the Mouse
- Object properties: Double-click on a step or transition:
- Move: Select SFC elements + drag:
- Copy and paste: Select SFC elements + <Ctrl> + drag
- Select all elements in the lasso: "Lasso" (press mouse button and drag)

Tooltips for Steps and Transitions
Instead of opening the object properties to get specific information, you can also do the following:
- Step: If you position the mouse pointer on a step, the name, number and – when available – the run times, comments and acknowledgement information are displayed.
- Transition: If you position the mouse pointer on a transition, the name, number and – when available – the comments are displayed.
3.6 Working with the Keyboard

3.6.1 Working with the Keyboard

Working with the Keyboard

You can also perform most functions with the keyboard. You can find additional information about this in the following sections:

- Key Combinations for Menu Commands
- Shortcuts for Menu Commands
- Navigating in the Menu Bar and Menus with the Keyboard
- Opening Help with the Keyboard
- Navigating in Dialog Boxes with the Keyboard
- Changing the Window Section
- Navigating in Texts with the Keyboard
- Selecting Text with the Keyboard
- Keyboard Shortcuts in the Sequence

3.6.2 Key Combinations for Menu Commands

Key Combinations for Menu Commands

You can call every menu command via an appropriate key combination with the <Alt> key.

Press the following keys in the order shown

- <Alt>
- The letter underlined in the menu name you require (for example, <Alt+S> for the "SFC" menu - if the "SFC" menu is included in the menu bar). The menu opens.
- The letter underlined in the menu command you require (for example, N for the menu command "New"). If the menu command has a submenu, the submenu is also opened. Repeat the actions above until you have selected a complete menu command by typing in the relevant letters.

The menu command is executed after you have entered the last letter of the key combination.
Examples

<table>
<thead>
<tr>
<th>Menu Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC &gt; New</td>
<td>&lt;Alt+S+N&gt;</td>
</tr>
<tr>
<td>Options &gt; Customize &gt; Colors</td>
<td>&lt;Alt+O+C+C&gt;</td>
</tr>
</tbody>
</table>
3.6.3 Shortcuts for Menu Commands

### Shortcuts for Menu Commands

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Menu</th>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>SFC</td>
<td>Create a new chart</td>
<td>&lt;Ctrl+N&gt;</td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td>Open chart</td>
<td>&lt;Ctrl+O&gt;</td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td>Close chart</td>
<td>&lt;Ctrl+F4&gt;</td>
</tr>
<tr>
<td>Check Consistency</td>
<td></td>
<td>Check the consistency of the charts in the chart folder</td>
<td>&lt;Ctrl+Alt+K&gt;</td>
</tr>
<tr>
<td>Compile</td>
<td></td>
<td>Compile charts in the chart folder</td>
<td>&lt;Ctrl+B&gt;</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>Print chart</td>
<td>&lt;Ctrl+P&gt;</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Exit the SFC editor</td>
<td>&lt;Alt+F4&gt;</td>
</tr>
<tr>
<td>Cut</td>
<td>Edit</td>
<td>Cut selected objects</td>
<td>&lt;Ctrl+X&gt;</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td>Copy selected objects</td>
<td>&lt;Ctrl+C&gt;</td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td>Paste copied/ cut objects</td>
<td>&lt;Ctrl+V&gt;</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td>Delete selected objects</td>
<td>&lt;Del&gt;</td>
</tr>
<tr>
<td>Copy Object Properties</td>
<td></td>
<td>Copy object properties for step/transition</td>
<td>&lt;Ctrl+Shift+C&gt;</td>
</tr>
<tr>
<td>Paste Object Properties</td>
<td></td>
<td>Paste copied object properties in step/transition</td>
<td>&lt;Ctrl+Shift+V&gt;</td>
</tr>
<tr>
<td>Select All</td>
<td></td>
<td>Select all objects in the chart</td>
<td>&lt;Ctrl+A&gt;</td>
</tr>
<tr>
<td>Find</td>
<td></td>
<td>Search for SFC elements</td>
<td>&lt;Ctrl+F&gt;</td>
</tr>
<tr>
<td>Object Properties</td>
<td></td>
<td>Call Dialog box &quot;Properties – Step/ Transition&quot; call</td>
<td>&lt;Alt+Return&gt;</td>
</tr>
<tr>
<td>Go To, Next Sequence</td>
<td></td>
<td>Go to the sequence that is after the current sequence</td>
<td>&lt;Ctrl+PgDn&gt;</td>
</tr>
<tr>
<td>Go To, Previous Sequence</td>
<td></td>
<td>Go to the sequence that precedes the current sequence</td>
<td>&lt;Ctrl+PgUp&gt;</td>
</tr>
<tr>
<td>Run Sequence</td>
<td></td>
<td>Call &quot;Run Sequence&quot;</td>
<td>&lt;Ctrl+F11&gt;</td>
</tr>
</tbody>
</table>
### Menu Command | Menu | Function | Keys
--- | --- | --- | ---
Select | Paste | Switch on selection mode (cursor as arrow) | <Esc>
Step + Transition |  | Switch on paste mode for step + transition | <Ctrl+1>
Simultaneous Branch |  | Activate insert mode for simultaneous branch | <Ctrl+2>
Alternative Branch |  | Activate insert mode for alternative branch | <Ctrl+3>
Loop |  | Activate insert mode for loop | <Ctrl+4>
Jump |  | Activate insert mode for jumps | <Ctrl+5>
Text Box |  | Switch on paste mode for text boxes | <Ctrl+6>
Download | CPU | Download current program to the CPU | <Ctrl+L>
Module Information |  | Display status of the current CPU | <Ctrl+D>
Operating Mode |  | Display/change the operating mode of the CPU | <Ctrl+I>
Test Mode | Debug | Activate/deactivate Test mode | <Ctrl+T>
Overview | View | Select overview display | <Ctrl+U>
Details |  | Select display at the last set zoom level | <Ctrl+Shift+U>
Zoom, Zoom In |  | Enlarge size of display | <Ctrl+Num + *)>
Zoom, Zoom Out |  | Reduce size of display | <Ctrl+Num - *)>
Zoom, Normal Size |  | Display in normal size (100%) | <Ctrl+Shift+N>
Update |  |  | <F5>
Customize, Layout | Options | Open the "Customize Layout" dialog box | <Ctrl+Alt+E>
Chart Reference Data |  | Display "Chart Reference Data" | <Ctrl+Alt+R>
Symbol Table |  | Display the symbol table | <Ctrl+Alt+T>
Arrange, Cascade | Windows | Cascade windows | <Shift+F5>
Arrange, Horizontally |  | Tile windows from top to bottom | <Shift+F2>
Arrange, Vertically |  | Tile windows from left to right | <Shift+F3>
Context-sensitive Help | Help | If there is a current context, for example, a selected menu command, the relevant help topic is opened. Otherwise the contents page is displayed. | <F1>

*) "Num +" / "Num –“ indicates the plus/minus keys of the numeric key pad
3.6.4 Navigating in the Menu Bar and Menus with the Keyboard

Navigating in the Menu Bar and Menus with the Keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the menu bar</td>
<td>&lt;F10&gt;</td>
</tr>
<tr>
<td>Move to the pop-up menu</td>
<td>&lt;Shift+F10&gt;</td>
</tr>
<tr>
<td>Select the menu containing the underlined character X</td>
<td>&lt;Alt+X&gt;</td>
</tr>
<tr>
<td>Select a menu command</td>
<td>Underlined character in the menu command</td>
</tr>
<tr>
<td>Move one menu command to the left</td>
<td>&lt;Left&gt;</td>
</tr>
<tr>
<td>Move one menu command to the right</td>
<td>&lt;Right&gt;</td>
</tr>
<tr>
<td>Move one menu command up</td>
<td>&lt;Up&gt;</td>
</tr>
<tr>
<td>Move one menu command down</td>
<td>&lt;Down&gt;</td>
</tr>
<tr>
<td>Activate the selected menu command</td>
<td>&lt;ENTER&gt;</td>
</tr>
<tr>
<td>Deselect menu or return to text</td>
<td>&lt;Esc&gt;</td>
</tr>
</tbody>
</table>
### 3.6.5 Navigating in Dialog Boxes with the Keyboard

#### Navigating in Dialog Boxes with the Keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move from one input box to the next (left to right and top to bottom)</td>
<td><code>&lt;Tab&gt;</code></td>
</tr>
<tr>
<td>Move one input box back</td>
<td><code>&lt;SHIFT+Tab&gt;</code></td>
</tr>
<tr>
<td>Move to the next line</td>
<td><code>&lt;Ctrl+Down&gt;</code></td>
</tr>
<tr>
<td>Move to the previous line</td>
<td><code>&lt;Ctrl+Up&gt;</code></td>
</tr>
<tr>
<td>Previous address</td>
<td><code>&lt;Ctrl+Left&gt;</code></td>
</tr>
<tr>
<td>Next address or in steps in the last address of the last line:</td>
<td><code>&lt;Ctrl+Right&gt;</code></td>
</tr>
<tr>
<td>next line on the next page</td>
<td></td>
</tr>
<tr>
<td>Focus on line with this digit (single)</td>
<td><code>&lt;Ctrl+Number&gt;</code></td>
</tr>
<tr>
<td>Next page (with transitions and start condition of the sequencers)</td>
<td><code>&lt;PAGE DOWN&gt;</code></td>
</tr>
<tr>
<td>Previous page (with transitions and start condition of the sequencers)</td>
<td><code>&lt;PAGE UP&gt;</code></td>
</tr>
<tr>
<td>Move to the next tab</td>
<td><code>&lt;Ctrl+PAGE DOWN&gt;</code></td>
</tr>
<tr>
<td>Move to the previous tab</td>
<td><code>&lt;Ctrl+PAGE Up&gt;</code></td>
</tr>
<tr>
<td>To first address</td>
<td><code>&lt;Ctrl+Home&gt;</code></td>
</tr>
<tr>
<td>To last address</td>
<td><code>&lt;Ctrl+End&gt;</code></td>
</tr>
<tr>
<td>Activate/deactivate OS comment in line with this digit (single)</td>
<td><code>&lt;Ctrl+Alt+Number&gt;</code></td>
</tr>
<tr>
<td>Move to input box with the underlined character X</td>
<td><code>&lt;Alt+X&gt;</code></td>
</tr>
<tr>
<td>Select in a list of options</td>
<td>Arrow key</td>
</tr>
<tr>
<td>Open a selection list</td>
<td><code>&lt;Alt+Down&gt;</code></td>
</tr>
<tr>
<td>Select or deselect an object in a list</td>
<td><code>&lt;Space&gt;</code></td>
</tr>
<tr>
<td>Confirm the entries and close the dialog box (&quot;OK&quot; button)</td>
<td><code>&lt;ENTER&gt;</code></td>
</tr>
<tr>
<td>Close the dialog box without saving changes (&quot;Cancel&quot; button)</td>
<td><code>&lt;Esc&gt;</code></td>
</tr>
</tbody>
</table>
3.6.6 Navigating in Texts with the Keyboard

Navigating in Texts with the Keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>One line up or one character to the left in a text</td>
<td>&lt;Up&gt;</td>
</tr>
<tr>
<td>consisting of only one line</td>
<td></td>
</tr>
<tr>
<td>One line down or one character to the right in a</td>
<td>&lt;Down&gt;</td>
</tr>
<tr>
<td>text consisting of only one line</td>
<td></td>
</tr>
<tr>
<td>One character to the right</td>
<td>&lt;Right&gt;</td>
</tr>
<tr>
<td>One character to the left</td>
<td>&lt;Left&gt;</td>
</tr>
<tr>
<td>One word to the right</td>
<td>&lt;Ctrl+Right&gt;</td>
</tr>
<tr>
<td>One word to the left</td>
<td>&lt;Ctrl+Left&gt;</td>
</tr>
<tr>
<td>To the beginning of the line</td>
<td>&lt;Home&gt;</td>
</tr>
<tr>
<td>To the end of the line</td>
<td>&lt;End&gt;</td>
</tr>
<tr>
<td>To the screen above</td>
<td>&lt;PgUp&gt;</td>
</tr>
<tr>
<td>To screen below</td>
<td>&lt;PgDn&gt;</td>
</tr>
<tr>
<td>To the beginning of the text</td>
<td>&lt;Ctrl+Home&gt;</td>
</tr>
<tr>
<td>To the end of the text</td>
<td>&lt;Ctrl+End&gt;</td>
</tr>
</tbody>
</table>

3.6.7 Selecting Text with the Keyboard

Selecting Text with the Keyboard

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character to the right</td>
<td>&lt;Shift+Right&gt;</td>
</tr>
<tr>
<td>One character to the left</td>
<td>&lt;Shift+Left arrow&gt;</td>
</tr>
<tr>
<td>One word to the right</td>
<td>&lt;Ctrl+Shift+Right&gt;</td>
</tr>
<tr>
<td>One word to the left</td>
<td>&lt;Ctrl+Shift+Left arrow&gt;</td>
</tr>
<tr>
<td>The text to the beginning of a line</td>
<td>&lt;Shift+Home&gt;</td>
</tr>
<tr>
<td>The text to the end of a line</td>
<td>&lt;Shift+End&gt;</td>
</tr>
<tr>
<td>One line of text up</td>
<td>&lt;Shift+Up&gt;</td>
</tr>
<tr>
<td>One line of text down</td>
<td>&lt;Shift+Down&gt;</td>
</tr>
<tr>
<td>To the screen above</td>
<td>&lt;Shift+PgUp&gt;</td>
</tr>
<tr>
<td>To screen below</td>
<td>&lt;Shift+PgDn&gt;</td>
</tr>
<tr>
<td>To beginning of file</td>
<td>&lt;Ctrl+Shift+Home&gt;</td>
</tr>
<tr>
<td>To end of file</td>
<td>&lt;Ctrl+Shift+End&gt;</td>
</tr>
</tbody>
</table>

SFC for SIMATIC S7
A5E00807946-01
3-16
3.6.8 Keyboard Shortcuts in the Sequence

Keyboard Shortcuts in the Sequence
- <Up> selects the previous SFC element in the sequence
- <Down> selects the next SFC element in the sequence
- <Left> selects the SFC element further left in the sequence
- <Right> selects the SFC element further right in the sequence

3.6.9 Opening Help with the Keyboard

Opening Help

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open help</td>
<td>If there is a current context, for example, a selected menu command, the relevant help topic is opened. Otherwise the table of contents will be displayed.</td>
</tr>
<tr>
<td>Close the Help window and return to SFC editor</td>
<td>&lt;Alt+F4&gt;</td>
</tr>
</tbody>
</table>

3.6.10 Changing the Window Section

Changing the Window Section

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll window section up</td>
<td>&lt;PgUp&gt;</td>
</tr>
<tr>
<td>Scroll window section down</td>
<td>&lt;PgDn&gt;</td>
</tr>
<tr>
<td>Scroll window section right</td>
<td>&lt;Ctrl+PgUp&gt;</td>
</tr>
<tr>
<td>Scroll window section left</td>
<td>&lt;Ctrl+PgDn&gt;</td>
</tr>
<tr>
<td>To top of window</td>
<td>&lt;Ctrl+Home&gt;</td>
</tr>
<tr>
<td>To bottom of window</td>
<td>&lt;Ctrl+End&gt;</td>
</tr>
<tr>
<td>To left edge of window</td>
<td>&lt;Home&gt;</td>
</tr>
<tr>
<td>To right edge of window</td>
<td>&lt;End&gt;</td>
</tr>
</tbody>
</table>
### 3.7 Default Colors

Defaults
(Change these defaults with the menu command **Options > Customize > Colors**...).

<table>
<thead>
<tr>
<th>Selection</th>
<th>Blue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step/transition parameters assigned [name]</td>
<td>Black</td>
</tr>
<tr>
<td>Step/transition no parameters [object]</td>
<td>White</td>
</tr>
<tr>
<td>Step/transition no parameters [name]</td>
<td>Black</td>
</tr>
<tr>
<td>Step/transition [comment]</td>
<td>Black</td>
</tr>
<tr>
<td>Step/transition selected [name]</td>
<td>White</td>
</tr>
<tr>
<td>Step ACTIVE [object]</td>
<td>Green</td>
</tr>
<tr>
<td>Step ACTIVE [name]</td>
<td>Black</td>
</tr>
<tr>
<td>Step EXECUTED [object]</td>
<td>Dark green</td>
</tr>
<tr>
<td>Step EXECUTED [name]</td>
<td>White</td>
</tr>
<tr>
<td>Step HELD [object]</td>
<td>Yellow</td>
</tr>
<tr>
<td>Step HELD [name]</td>
<td>Black</td>
</tr>
<tr>
<td>Step ERROR [Object]</td>
<td>Red</td>
</tr>
<tr>
<td>Step ERROR [name]</td>
<td>Yellow</td>
</tr>
<tr>
<td>Transition FALSE [object]</td>
<td>Red-brown</td>
</tr>
<tr>
<td>Transition FALSE [name]</td>
<td>White</td>
</tr>
<tr>
<td>Transition TRUE [object]</td>
<td>Dark green</td>
</tr>
<tr>
<td>Transition TRUE [name]</td>
<td>White</td>
</tr>
<tr>
<td>Operator Prompt</td>
<td>Gray</td>
</tr>
<tr>
<td>Error confirmation</td>
<td>Red</td>
</tr>
</tbody>
</table>

Defaults that cannot be changed:

<table>
<thead>
<tr>
<th>Textual interconnection [object]</th>
<th>Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Textual interconnection [name]</td>
<td>Black</td>
</tr>
<tr>
<td>Step INACTIVE [object]</td>
<td>*)</td>
</tr>
<tr>
<td>Step INACTIVE [name]</td>
<td>*)</td>
</tr>
<tr>
<td>Transition INACTIVE [object]</td>
<td>**)</td>
</tr>
<tr>
<td>Transition INACTIVE [name]</td>
<td>**)</td>
</tr>
</tbody>
</table>

Default Setting in Windows:
(Modify with the right mouse button on Desktop: **Properties > Display > Extended > Element: Selected elements**)

| Background of the tab ID for tabs with content | Blue |

*) Color is identical to the color for the unselected step and cannot be changed

**) Color is identical to the color for the unselected transition and cannot be changed
3.8 Data Backup in the SFC Editor

Data Backup in the SFC Editor

All changes made in the SFC editor are saved immediately - there is therefore no other save option in SFC. This means that you can no longer undo or cancel changes in the SFC editor by closing the editor without saving. This does not apply for the configuration of sequences, steps, and transitions in the properties dialog box. There you can "discard" changes.

To back up your data, copy the entire program folder to a backup project. You can then revert to old versions at any time. This also allows you to archive your complete configuration.
4 Creating the Project Structure

4.1 How to Create a Project Structure

Optional Procedures

Use SIMATIC Manager to create a project. The following options are available in SIMATIC Manager for creating a project:

- **PCS 7 Wizard**
  With the PCS 7 Wizard, you create a single project or multiproject in the Plant view and in the Component view. In addition to the actual project, a multiproject also includes a master data library.

- **STEP 7 Wizard**
  With this wizard you create a STEP 7 project with the following elements:
  - The SIMATIC station
  - The CPU
  - The S7 program
  - The block folder

- **Menu commands**
  With the menu commands you create a new project and insert all the required components.

We recommend the procedure using the **PCS 7 Wizard** (point 1) because it is both faster and is less liable to errors.

You can select the PCS 7 Wizard or the STEP 7 Wizard in SIMATIC Manager in the "Wizards" tab with the menu command **Options > Settings**.

Creating a Project with the PCS 7 Wizard

1. Start the PCS 7 Wizard (if it does not start automatically) with the menu command **File > 'New Project' Wizard**.

2. Work through the steps of the wizard.
   In the dialog "Which objects will be used in the project?", the "SFC chart" option in the "PLC Objects" box is set by default.

   The hardware configuration is made largely automatically and only the CPUs permitted for PCS 7 are available to you.
4.2 Creating, Configuring and Managing SFCs

4.2.1 Overview of Creating, Configuring and Managing SFCs

Overview

You can create new charts and types, open them for editing, and modify their properties in both SIMATIC Manager and SFC editor. You can copy and delete charts and types only in SIMATIC Manager. You copy and delete instances in the relevant CFC chart.

The SFC chart can be displayed in CFC in its external view, allowing the SFC to be controlled by CFC interconnections. The external view displays the SFC like a block; in other words, with the standard interface.

Requirement for Creating SFC Charts and SFC Types

The required project structure must have been created in SIMATIC Manager.

Each newly created chart or type is assigned a default name, which you can later change. If you change the name, the system checks to ensure that it is unique in the CPU. Note the following when assigning names:

- The names of SFC charts can contain a maximum of 22 characters.
- The names of SFC types can contain a maximum of 16 characters. Although you can enter 24 characters in the properties, when the instances are created, only 16 characters are permitted.
- The following characters are illegal: " % . / \.

You will find more information on creating charts and types in the sections:

- How to Create an SFC Chart
- How to Create an SFC Type
Requirements for Creating SFC Instances

You create an SFC instance from an SFC type. The following requirements must be met:

- The SFC type that you want to use as an instance is located in the chart folder of the current S7 program.
- The CFC chart in which you want to insert and interconnect the instance is open.
- The same naming convention as that for the SFC type applies, but you can only use 16 characters for the instance name.

You will find more information on creating instances in the section: How to Create an SFC Instance

You will find more information on managing charts in the sections:

- How to Adapt Chart Properties
- How to Adapt Type Properties
- How to Adapt Instance Properties
- Copying and Moving SFC Charts
- "Copying and Moving SFC Types"
- Copying and Moving SFC Instances
- How to Delete SFC Charts and SFC Types
- How to Delete SFC Instances
4.2.2 Creating an SFC chart

4.2.2.1 How to Create an SFC Chart

Introduction

You create a new SFC chart in the following ways:

- In the Component view, Plant view or Process Object view in SIMATIC Manager
- In the SFC editor

Creating a Chart in SIMATIC Manager

1. In the Component view of SIMATIC Manager, select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder.
   
   If the chart is to be assigned to a plant hierarchy folder, select the project and the hierarchy folder from the Plant view or Process Object view.

2. Open a chart folder in the Component view or select a hierarchy folder in the Plant view or Process Object view.

3. Insert a chart into the chart folder or the hierarchy folder with the menu command **Insert > S7 Software > SFC**.
   
   The chart is given a default name by the system, for example SFC(1), which you can change.

Creating a Chart in the SFC Editor

1. Select the menu command **SFC > New..** in SFC.
   
   The "New" dialog box opens.

2. Select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder in the dialog box.

3. If the chart is to be assigned to a plant hierarchy folder, select the project and the hierarchy folder in the "Plant view" or "Process Object view"

4. Select "SFC" from the drop-down list box in the "Object type" box.

5. Enter a chart name in the "Object name" box.

6. Click "OK".

A new window opens with the chart (1 sequencer, initial state).
4.2.3 Creating an SFC Type and Creating an SFC Instance

4.2.3.1 How to Create an SFC Type

Introduction
You create a new SFC type in the following ways:

- In the Component view of SIMATIC Manager
- In the SFC editor

Creating a Type in SIMATIC Manager
1. Open the chart folder in the Component view of SIMATIC Manager.
2. Select the menu command Insert > S7 Software > SFC Type.
   The SFC type is inserted into the chart folder.

Creating a Type in the SFC Editor
1. Select the menu command SFC > New in the SFC editor.
   The "New" dialog box opens.
2. Select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder in the dialog box.
3. Select "SFC type" from the drop-down list box in the "Object type" box.
4. Enter a chart name in the "Object name" box.
5. Click "OK".
   A new window opens with the SFC type (a sequencer in the initial state).

Result
The type is given a default name by the system, for example SFC_Type(1), which you can change. The next free FB number is automatically reserved for the SFC type and the type template (FB 247) is copied to the block folder with this number. This allows you to configure messages and instances for the type once it is created without having to compile the type. The FB number can be modified later in the object properties dialog box.

When you first create an SFC type, the blocks required for compilation and for execution in the AS are copied to the current program and then managed in the ES. The blocks are included in the supplied block library.

Note
SFC types cannot be assigned to a hierarchy folder in the plant view since they themselves are not relevant to execution (from the perspective of the process to be automated).
4.2.3.2 How to Create an SFC Instance

Introduction

The SFC types available in the chart folder are displayed in the CFC block catalog. They are either in the "All blocks" directory and in the directory of the family, if they are assigned to a family, otherwise, they are in the "Other blocks" directory.

You can also insert SFC types in the CFC chart from the libraries (for example, SFC library or master data library).

Procedure

In CFC, drag the SFC type into the CFC chart from the block catalog or from a library.

Result

The SFC instance is represented like a CFC instance block. If there is not enough space to position the SFC instance, it is displayed as an "overlapping block" (light gray and without visible inputs/outputs). After moving them to a free position in the chart, the overlapping blocks are displayed as normal blocks again.

You can rename, assign parameters for, and interconnect the SFC instance in the CFC chart.
4.2.4 Configuring an SFC Chart

4.2.4.1 Basics for Configuring an SFC Chart

Introduction

In SFC, there is initially the "SFC chart" object type along with the "SFC type" object type. The SFC chart allows the definition of sequential control systems using a predefined interface and process signals to the plant being automated. The SFC chart must first be compiled and it is then downloaded to the automation system where it is executed.

Basics of Configuration

The SFC chart has an interface that is created when the SFC chart is generated and includes the standard interface derived from the SFC chart template (block @SFC_RTS). This is required to provide SFC system functionality (operating modes, operating states, step control modes, etc.) at the interface of the SFC chart.

You cannot move or delete the elements of the standard interface. Neither can you add new elements to the standard interface. You can edit the initial value, comments, and attributes.

During configuration, you can use the interface inputs/outputs and any required process signals to formulate step assignments or the transition and start conditions. Here, textual interconnections are also possible.

The SFC chart is therefore not self-contained and can only be used once. If you wish to reuse the SFC chart, copy the SFC chart and adapt it fully to the "new environment" because the process signals used must usually be replaced by others.

For more detailed information on creating an SFC chart, refer to the section Creating an SFC Chart.

You can set or change the following in the "Properties" dialog box:

- The "General" properties (name, author, comment, OS comment).
- The "CPU operating parameters" (default settings: Step control mode, Operating mode, Instruction output, Cyclic execution, Time monitoring and the start options: Autostart, Use default operating parameters when SFC starts)
- The option whether or not the SFC chart is available on the OS for operator control and monitoring
Creating the Project Structure

Runtime Properties

An SFC chart is inserted in the run sequence in order to determine when the SFC chart is to be processed in the automation system.

For more information on this subject, refer to the section Runtime Properties.

Messages

You have the option of configuring seven messages requiring acknowledgment for an SFC chart in the SFC editor (menu command SFC > Message...). The SFC chart itself requires the remaining available messages (one message requiring acknowledgment and one that does not).

For more information on this subject, refer to the section Configuring Messages in SFC.

Footer

You can configure an optional footer for an SFC chart.

- For more information on this subject, refer to the section Defining Footers.

Copying, Moving, Deleting

You can copy, move, or delete SFC charts in SIMATIC Manager.

You can find additional information about this in the following sections:

- Copying and Moving SFC Charts
- How to Delete SFC Charts and SFC Types

The attributes required for the SFC chart (for example, S7_m_c) are preset.

Compiling and Downloading

The SFC chart is compiled in the “Compile Program” context and downloaded in the “Download to PLC” context.

You can find additional information about this in the following sections:

- Overview of Compiling Charts, Types, and Instances
- How to Download Programs

Testing

In the SFC test mode, the execution of the SFC is made dynamic and can be influenced with the test functions.

- For more information on this subject, refer to the section Operator Control and Monitoring during Testing.
4.2.4.2 Configuration Changes in the SFC Chart

Description

You can change the topology (step/transition sequences, jump destinations) or the configured steps/transitions in the SFC chart. The changes do not take effect until the chart has been compiled and downloaded.

Following a topology change, you can download inactive sequencers at any time. You need to disable the SFC chart to download active sequencers.

You can download changes in the step and transition configuration at any time even if the SFC chart is currently being processed in the automation system.

The basic rule is that changes in the SFC chart that prevent or restrict a download of changes in RUN mode can be made only after the user has confirmed a prompt.

Further Procedure

After completing the changes, you must compile and download the OS to ensure that the current data are available on the OS.
4.2.5 Configuring the SFC Type and SFC Instance

4.2.5.1 Type/Instance Concept of SFC

Overview of SFC Type and SFC Instance

The type/instance concept was introduced in SFC V6.0. This makes it possible to create sequential control system types that generate SFC instances when placed in a CFC chart.

The SFC type is not executable on its own. Like a function block type, an SFC type must be placed in a CFC chart to obtain a sequence-relevant object, in this case, an SFC instance. To execute an SFC instance, both the SFC type and the SFC instance are downloaded to the automation system.

For more information on this subject, refer to the section Configuring the SFC Type.

4.2.5.2 Configuring the SFC Type

Introduction

In SFC, there is not only the object type "SFC chart" but also the object type "SFC type". The SFC type allows the definition of sequential control systems including an interface. The sequence logic of the SFC type is based solely on the interface inputs/outputs of the SFC type. This is why the SFC type cannot access all process signals, in contrast to the SFC chart.

Overview of Configuring the SFC Type

The SFC type has an interface corresponding to the SFC chart. It is created when an SFC type is generated and already contains the SFC type standard interface, derived from the SFC type template "@SFC_TYPETEMPLATE" (FB247). The standard interface is required to provide SFC system functionality (for example, operating modes, operating states, step control modes, etc.) at the interface of the SFC type.

You can add additional inputs/outputs to the standard interface in the interface editor and additional characteristics in the characteristics editor.

For more information on this subject, refer to the section Using the Characteristics Editor and the Interface Editor.

You cannot move or delete the elements of the standard interface or the characteristics. You can change the initial value, comments, and attributes.

Explicitly created elements can be manipulated as required.

During configuration, you can only use the interface inputs/outputs to formulate step assignments or the transition and start conditions. Addresses in assignments or conditions are therefore always references to inputs/outputs of the interface. Here, textual interconnections are also possible.
Creating the Project Structure

This means that the SFC type is self-contained since there can be no external accesses from the SFC type that bypass the interface.

There are two ways of creating and changing an SFC type:

- **Creating and changing in a library**
  This has the advantage that the master for the SFC type is always in the library and that the test project can still run until a new version of the SFC type is adopted.

- **Creating and changing in a project**
  This has the advantage that every change to the SFC type can be checked immediately since you are working directly with the master.

For more information on this subject, refer to the section **How to Create an SFC Type**.

Configuring Runtime Properties

An SFC type does not have any runtime properties, since it is not relevant to execution of the program. An SFC type **cannot** be inserted in the run sequence.

Configuring Messages

You can configure seven messages that must be acknowledged and five that do not require acknowledgment for an SFC type. The SFC type itself requires the remaining available messages (one message for each message type and 10 status messages for SIMATIC BATCH).

For more information on this subject, refer to the section **Configuring Messages in SFC**.

Configuring Footers

You can configure one footer for an SFC type.

For more information on this subject, refer to the section **Defining Footers**.

Compiling / Downloading

The SFC type is compiled in the "Compile program" context and downloaded to the CPU in the "Download to PLC" context.

You will find more information on this subject in the following sections:

- **Overview of Compiling Charts, Types, and Instances**
- **How to Download Programs**
Tips

The following tips may help you:

- In the "SFC Library", you can find the "TypeStates" SFC type with the menu command SFC Library > Blocks+Templates > Templates. This already contains several sequencers for state-oriented processing of the sequential control system. You will also find the "TypeCtrlStrategy" SFC type containing control strategy-oriented processing of the sequential control system. You can copy these templates and change them to suit your purposes.

- When creating an SFC type for SIMATIC BATCH, remember the following points:
  - In Properties > Operating Parameters CPU of the SFC type, you need to select the "AUTO" mode, otherwise the control commands from SIMATIC BATCH will have no effect (this also applies to the SFC instances).
  - In Properties > Options, you have to set one of the categories, "EOP" or "EPH", otherwise the SFC type remains "invisible" to SIMATIC BATCH.
  - If you wish to use the "Continuous mode" of the SFC, you have to set inputs/outputs ENASTART=1 and SELFCOMP=0. To configure the start condition of sequencers, you need to take input/output READY_TC into consideration (this also applies to SFC instances).

For more information on this subject, refer to the section Start Requirements of an SFC (Chart or Instance)
4.2.5.3 Configuration Changes in the SFC Type

Effects of the modified SFC type

Modifications to the interface of the SFC type are transferred to the SFC instances immediately. You can only download the SFC type and its instances during RUN mode of the automation system if all the SFC instances of this SFC type are disabled or if you temporarily disable the SFC instances during downloading. The instances are disabled during the download following operator confirmation and restarted after the download, again following operator confirmation. The execution of the instance then depends on the process state and on the configuration of the instances (especially the start conditions).

Note

If you perform the download with the SIMATIC Manager function "Compile and Download Objects" and the SFCs need to be disabled for this, the SFCs will not be disabled. In this case, the download will not be performed and an error message is entered in the log.

While changes are being downloaded, the SFC instances cannot be processed in the automation system and the SFC instances cannot be accessed via the interconnections in the CFC.

Changes in the topology (step/transition sequence, jump destination) and the step or transition configurations are made in the SFC type and do not become effective in the SFC instances until they are compiled and downloaded. You can download inactive sequencers following changes to the topology at any time. If you want to download active sequencers following changes to the topology, you must first disable the SFC instances before downloading. You can download changes to the step and transition configuration at any time even if SFC instances of the SFC type are currently being processed in the automation system.

After changing the configuration, you need to compile the OS to ensure that the current data are available on the OS.

Effects on SFC Instances in the CFC

If you change an SFC type and the instances belonging to it are open in the CFC, you will have to update (View > Update or F5) the CFC and therefore the SFC instances after compiling and downloading the changes. If the CFC is in test mode, you must leave this mode before performing the update.

Effects on SFC Instances in the SFC

If you want to change an SFC type and the instances belonging to it are opened in the SFC and are in test mode, you must leave this mode before changing the type. After making the change and compiling and downloading the change, you will have to update the SFC instances (View > Update or F5). You can then re-enable test mode.
4.2.5.4 Configuring the SFC Instance

Introduction

An SFC instance is derived from an SFC type. The SFC type is first inserted into a CFC chart similar to a function block type in the CFC. The SFC instances are therefore always assigned to one CFC chart and are addressed using the chart. SFC instances are displayed as blocks, same as CFC instances; in other words, their interface is visible in the CFC chart.

SFC instances are not displayed in SIMATIC Manager since they can only be addressed via the CFC chart. With the assignment of the CFC chart to the plant hierarchy, the SFC instances contained are also indirectly assigned to the plant hierarchy.

Creating and Handling

SFC instances are created by placing an SFC type in the CFC chart. The SFC types in the chart folder are displayed in the CFC "Blocks" catalog (in "All blocks" and in the folder of the family if they are assigned to a family, otherwise in the "Other blocks" folder). You can also insert SFC types from the libraries (for example, SFC library, master data library) in the CFC chart.

You can configure and interconnect an SFC instance similar to a CFC instance.

SFC instances are handled in the same way as CFC instances in the CFC chart in which they are placed.

Runtime Properties

The runtime properties of an SFC instance are identical to the runtime properties of CFC block instances.

Messages

You can configure the messages of an SFC instance in SFC (menu command SFC > Message...) and in CFC using the "Object Properties" dialog box.

Opening and Testing

You can open SFC instances in the CFC chart. The SFC opens and the first sequencer is displayed. You cannot change the sequencer. In SFC test mode, the execution of the instance is made dynamic and can be influenced in the same way as in SFC charts.
Creating the Project Structure

Copying, Moving, Deleting

You can copy/move SFC instances in the CFC chart or between CFC charts.

You delete SFC instances in the CFC chart or indirectly by deleting the CFC chart in SIMATIC Manager.

You will find more information on this subject in the following sections:

- Copying and Moving SFC Instances
- How to Delete SFC Instances

Configuration

The configuration options for SFC instances in the SFC are limited compared to SFC types. The interface and the sequencers cannot be changed in the SFC instance since they are specified identically for all instances based on the SFC type. However, you can change the parameters (initial value and comments) of the interface inputs/outputs for each specific instance.

You can make the following settings in the "Properties" dialog box:

- "General" properties (name, comment).
- "CPU operating parameters" (these are the default settings: Step control mode, Operating mode, Instruction output, Cyclic execution, Time monitoring and the start options: Autostart, Use default operating parameters when SFC starts).
- The "options" for SIMATIC BATCH (category, allow operator instructions) cannot be modified here; the configured control strategies can be enabled or disabled here for the instance.

You can open the "Properties" dialog box as follows:

1. Select the SFC instance in the CFC.
2. Open the context menu and select the menu command **Open**.
   The SFC instance opens in the SFC.
3. Select the menu command **SFC > Properties...**
   The "Properties SFC Instance" dialog box opens.
Compiling / Downloading

SFC instances are compiled in the "Compile program" context and downloaded to the CPU in the "Download to PLC" context.

You will find more information on this subject in the following sections:

- Overview of the Blocks Generated during Compilation
- Overview of Compiling Charts, Types, and Instances
- How to Download Programs

Tips:

- You can use the "SFC Visualization" optional package on the OS for operator control and monitoring of the SFC instances (and SFC charts). You also use "SFC Visualization" to perform the necessary configuration steps for SFC operator control and monitoring.

You can find additional information on SFC Visualization in the SFC Visualization for S7 manual or the "Options" folder of the WinCC online help.

4.2.5.5 Configuration Changes in the SFC Instance

Description

Due to the limited configuration options for SFC instances, any changes you make directly in the SFC instances can be downloaded at any time, even if the SFC instances are currently being processed in the automation system.

Further Procedure

After completing the changes, you must compile and download the OS to ensure that the current data are available on the OS.
4.2.6 Opening

4.2.6.1 How to Open SFC Charts or SFC Types

Introduction

You can open an SFC chart or an SFC type both in SIMATIC Manager and in the SFC editor.

Opening an SFC Chart or SFC Type in the SFC Editor

1. Select the menu command **SFC > Open** in the SFC editor.
2. Select the project (the SIMATIC station, the CPU, the S7 program) and the chart folder containing the SFC chart or SFC type you want to open.
3. Select the "SFC" object type for the chart or the "SFC type" for the type.
4. Click the chart or type you want to open in the right window of the dialog box.
5. Click "OK".

The window with the SFC chart or SFC type opens.

**Note**

The "SFC" menu displays the last four objects edited (SFC charts and/or SFC types) as menu commands. If you select one of these menu commands, the corresponding object opens.

Opening an SFC Chart or SFC Type in SIMATIC Manager

1. Select the menu command **View > Component View** in SIMATIC Manager and then select the project and the chart folder in the S7 program.
2. Open the chart folder.
3. Double-click on the SFC chart or the SFC type in the right-hand window. The SFC editor starts (if not already started) and the chart or type is displayed in an SFC editor window.

**Note**

If the project is assigned a plant hierarchy, you can also open SFC charts in the Plant view or Process Object view in SIMATIC Manager. In this case, you open the hierarchy folder that contains the chart instead of the chart folder.

SFC types are not included in the plant hierarchy since they are not relevant to execution from a technological perspective.
4.2.6.2 How to Open SFC Instances

Introduction
You can only open SFC instances in the CFC chart.

Procedure
1. Select the SFC instance in the respective CFC chart.
2. Select the menu command Edit > Open. The SFC editor starts (if it is not already started) and the SFC instance is displayed in a window of the SFC editor. The displayed topology is determined by the associated SFC type.
4.2.7 Copying

4.2.7.1 Copying and Moving SFC Charts

Overview of Copying and Moving

You can copy charts with SIMATIC Manager. You can transfer tested partial or complete structures from one CPU to another CPU or even within a single CPU. Existing references are not lost if the relevant charts are copied together at one time.

You can not only copy individual charts but also an entire chart folder with all the charts it contains.

You can also move charts across CPUs. The information contained in the section "Copying/Moving across CPUs" applies to moving.

Copying within the CPU (in the chart folder)

Note the following when copying within the CPU:

- Interconnections and cross-accesses between CFC charts and between SFC and CFC charts are also copied if the charts involved are copied at the same time.
- Chart names must be unique in a chart folder; it may be necessary to rename files.
- Special considerations when copying SFC charts:
  - All SFC statements and SFC transition conditions that access uncopied blocks in CFC charts will continue to access the original blocks.
  - All SFC statements and SFC transition conditions that access global resources (via symbolic addresses of the symbol list) will continue to access these resources.
Copying/Moving across CPUs

When copying/moving charts across CPUs, remember the following points:

- Interconnections
  Interconnections to shared addresses and to runtime groups are not copied unless you copy a complete program folder including user program, chart folder and symbol table.

- Block Types
  Unless all the block types are identical in the destination CPU (name, block inputs/outputs), the copy/move function is rejected. You must then first copy the relevant block types to the block folder of the destination CPU and import them into a CFC of the destination chart folder.

- Task
  A task with the same name is used to insert the copied/moved blocks. The system does not check whether the tasks with the same name on both CPUs actually have the same properties. If a task with the same name does not exist on the destination CPU, copying/moving is rejected. You must then configure a task with the same name. If the destination system is an S7 CPU, the task is an OB number; any name in the symbol table will be considered as a comment and has no relevance.

- Chart names, block names
  Since CFC block names are unique within a chart, it is not necessary to rename them. It may be necessary to rename charts, however.

- Special consideration when copying/moving SFC charts
  All SFC statements and SFC transition conditions that access global resources (via symbolic addresses of the symbol list) access the same resources on the target CPU. If these resources do not exist on the destination CPU, they are automatically converted to textual interconnections (see above).

You will find information on textual interconnections in the CFC documentation in the section:
Working with Textual Interconnections
4.2.7.2 Copying and Moving SFC Types

Copying SFC Types

The runtime objects associated with the SFC type are also copied. If the SFC type is not up-to-date because the time stamp of the FB is older than the time stamp of the SFC type, you receive a message. If there is an SFC type with an identical name in the destination folder, it is overwritten following an acknowledgment prompt and any deviating properties for the existing type are passed to the SFC instances.

Moving SFC Types

You can only move an SFC type when there are no SFC instances for the SFC type in the source. The runtime objects associated with the SFC type are also moved. If there is an SFC type with an identical name in the destination folder, it is overwritten following an acknowledgment prompt and any deviating properties for the existing type are passed to the SFC instances.

4.2.7.3 Copying and Moving SFC Instances

Introduction

You can copy or move SFC instances within a CFC chart, between CFC charts or indirectly by copying/moving the CFC chart in SIMATIC Manager. The runtime objects associated with the SFC instance are also copied or moved.

Copying SFC Instances

You can copy an SFC instance within a CFC chart or between CFC charts in the same chart folder. If you copy a CFC chart within a chart folder, the SFC instance is also copied. The runtime objects associated with the SFC instance are also copied.

If you copy an SFC instance between CFC charts from different chart folders or copy a CFC chart to a different chart folder, the SFC type is also copied.

Moving SFC Instances

If you move an SFC instance between CFC charts in the same chart folder, the SFC instance is moved and the associated runtime objects are retained.

If you move an SFC instance between CFC charts from different chart folders or move a CFC chart to a different chart folder, the SFC type is also copied or moved.
4.2.8 Deleting

4.2.8.1 How to Delete SFC Charts and SFC Types

Deleting an SFC Chart or SFC Type

You delete SFC charts and SFC types in SIMATIC Manager.

SFC types can only be deleted when no SFC instances for the SFC type exist. If instances of an SFC type exist, you receive a message to this effect.

The runtime objects associated with the SFC type are thereby also deleted.

Procedure

1. Select the SFC chart or SFC type in the Component view of SIMATIC Manager.
2. Press the <Del> key.

4.2.8.2 How to Delete SFC Instances

Deleting an SFC Instance

You delete SFC instances in the associated CFC chart or indirectly by deleting the CFC chart in SIMATIC Manager.

The runtime objects associated with the SFC instance are thereby also deleted.

Procedure

1. Select the SFC instance in the CFC chart.
2. Press the <Del> key.
5 Adapting the Properties of Charts, Types and Instances

5.1 How to Adapt Chart Properties

Introduction

You can view and change the properties of the active SFC chart (SFC editor) or any SFC chart in the chart folder (SIMATIC Manager). The chart properties are displayed in a dialog box with several tabs.

Opening the Dialog Box of the Chart Properties

In the SFC editor

1. Open the SFC chart.
2. Select the menu command SFC > Properties….

In SIMATIC Manager

1. Select the SFC chart in SIMATIC Manager.
2. Select menu command Edit > Object Properties….
   The properties dialog box opens.
Tabs

You can modify the chart properties in the following tabs.

- **General**
  This tab is used to enter or modify the chart name, the author and the comment.

- **Operating Parameters CPU**
  You can set the following options in this tab:
  
  - Defaults for the initial state of the chart: "Step control mode", "Operating mode", "Instruction output", "Cyclic execution" and "Time monitoring".
  
  - SFC startup following an AS restart
    The options are "Initialize SFC" or "Retain SFC state". This allows you to determine if the SFC should start with the data it had before the CPU stop or if it should be initialized again following a restart of the CPU.
  
  - Start options of the chart: "Autostart" and "Use default operating parameters when SFC starts".

- **OS**
  If the "Transfer chart to OS for visualization" check box is selected, the SFC chart is transferred to the OS automatically with the next OS compilation.

- **Version**
  In the "Version:" box, the current version of the chart is displayed. When you create a chart, Version 0.1 is entered here. To identify working versions, you can change this version number (0.0 to 15.15 are permitted).

  With "Data version", you obtain information on the software version used to create the chart.
5.2 How to Adapt Type Properties

Opening the Dialog Box

1. Select the menu command SFC > Properties.. in SFC editor. The dialog box of the properties opens.
2. You can display and modify the properties for the active SFC type in the tabs of the dialog box.

Tabs

You can modify the type properties in the following tabs.

- **General**
  This tab includes the entry or modification of the type name, the author, the family, the FB number and the comment.

- **Operating Parameters CPU**
  You can perform the following actions in this tab:
  - Set the defaults for the initial state of the SFC instances that are generated from this type. "Step control mode", "Operating mode", "Instruction output", "Cyclic execution" and "Time monitoring".
  - Activate or deactivate the start options for the SFC instances: "Autostart" and "Use default operating parameters when SFC starts".

- **Options**
  In this tab, you can set the classification of the SFC type for SIMATIC BATCH:
  - **Category**
    "None": There is no classification (type is ignored by SIMATIC BATCH) "EOP": The SFC type is classified as "Operation type".
    "EPH": The SFC type is classified as "Phase type".
  - **Allow operator instructions on the OS to enable input of values in the operator dialog.**
  - **Control Strategy Selection**
    This box contains all control strategies configured for the SFC type (maximum of 32).
    Select the respective check box to enable control strategies of the SFC type as default for the SFC instances. This applies to all SFC instances that are already in the project - as long as the default value has not been changed in the instance - and for all the SFC instances yet to be generated. The control strategy selection can be modified for the individual instances.
• **Version**
  In the "Version:" box, you can see the current version of the SFC type. When you create an SFC type, Version 0.1 is entered here. To identify working versions, you can change this version number (0.0 to 15.15 are permitted).

  With "Data version", you obtain information on the software version used to create the SFC type.

### 5.3 How to update SFC Types

**Update in multi-project**

SFC types can be updated in a multi-project. The procedure is the same as when updating block types of CFC.

You will find more information on this subject in the CFC documentation: How to update block types/SFC types

### 5.4 How to Adapt Instance Properties

**Opening the Dialog Box**

1. Select the SFC instance in CFC and then select the menu command **Edit > Open**.
   The SFC instance opens in the SFC editor.
2. Select the menu command **SFC > Properties...** for the active SFC instance in the SFC editor.
   The dialog box of the properties opens.

   You can display and modify the properties for the active SFC type in the tabs of the dialog box.

**Tabs**

You can modify the SFC instance properties in the following tabs.

- **General**
  This tab is used to enter or modify the instance name and the comment. All other properties (see SFC type) can be read but not modified.

- **Operating Parameters CPU**
  In this tab, you can change the operating parameters for the SFC instance (see SFC Type).
Options
In this tab, you can view the options set for the SFC type for SIMATIC BATCH and change some of them:

- Category (cannot be modified)
  "None": There is no classification
  "EOP:" The SFC type is classified as "operation type"
  "EPH:" The SFC type is classified as "phase type".

- Allow operator instructions on the OS (cannot be modified)
  Values can be input in the operator dialog box when this option is set.

- Control Strategy Selection
  This box contains all control strategies configured for the SFC type (maximum of 32).
  The control strategies adopted from the SFC type are selected. You can change the selection for each SFC instance. You can select a new control strategy or deselect an existing assignment.

Note
If you change the control strategy selection for an SFC instance, all subsequent changes to the control strategy selection for the SFC type are no longer applied automatically for this SFC instance.

Version
In the "Version:" box, you always see the version of the associated SFC type. The version cannot be changed in the SFC instance.

With "Data version", you obtain information on the software version used to create the SFC instance.
5.5 Message Configuration

5.5.1 How to Configure Messages in the SFC

Configuring Messages in the SFC

Select the menu command SFC > Message... in the SFC editor to configure the messages.

You can configure specific message texts for each SFC chart/SFC type/SFC instance. You can change the message texts in a dialog box (for example, to distinguish messages in different charts/types).

Configuration Limits

You can configure the following number of messages for one SFC chart:
- Seven messages requiring acknowledgment

You can configure the following number of messages for one SFC chart or one SFC instance:
- Seven messages requiring acknowledgment
- Five message that do not require acknowledgment

The SFC type itself requires the remaining available messages (one message for each message type and 10 status messages for SIMATIC BATCH).

The reserved message events have default texts:
- "Step execution time exceeded"
- "Operator prompt"
- 10 status messages for SIMATIC BATCH (only with SFC type_Instance)
  - "Running"
  - "Completed"
  - "Held"
  - "Aborted"
  - "Ready to complete"
  - "Stopped"
  - "Error"
  - "MANUAL"
  - "Not released for SIMATIC BATCH"
  - "Execution time exceeded"
Step Execution Time Exceeded

The "step error" event is a process control message that must be acknowledged and is signaled along with 3 associated values using the message block ALARM_8P. The remaining seven available messages (SFC type/instance only) and associated values can be assigned as required.

For this purpose, the standard interface contains inputs/outputs that can be used to trigger messages (SIG_2 ... SIG_8) including the associated values AUX_PR04 to AUX_PR10 (with an SFC type/instance). These inputs/outputs can be used by having interconnections in the actions of the steps or by having direct block interconnections.

Operator Prompt

The operator prompt is a message that does not require acknowledgment and that is signaled in an SFC chart with the NOTIFY message block and in an SFC type with NOTIFY_8P message block.

You can find a table of the inputs/outputs utilized in the interface for message under "Messages".

Note

When configuring messages, remember that the messages of ALARM_8P can only be assigned message classes requiring acknowledgment.
5.6 Configuring Characteristics

5.6.1 Using the Characteristics Editor and the Interface Editor

Characteristics Editor / Interface Editor

You use the characteristics editor for the technological configuration of the interface for an SFC type. You can only work with the editor if an SFC type is open in SFC.

You define the interface inputs/outputs of the SFC type as follows:

- Directly in the interface editor:
  Access this editor with the menu command View > Inputs/Outputs or the icon
- In the characteristics editor
  Access with the menu command View > Characteristics or the icon

The interface editor and the characteristics editor box are displayed alternatively. This means that it is not possible to define technological characteristics and interface inputs/outputs at the same time. You can define characteristics and inputs/outputs in any order.

Note

You define individual inputs/outputs in the interface editor. These are available in addition to the inputs/outputs defined in the characteristics editor. These inputs/outputs are unknown to the characteristics editor and cannot be handled there.

Setpoints, for example, are created and assigned values during the definition of characteristics. From this definition, the characteristics editor generates the required inputs/outputs, which are displayed in the interface editor after it is opened and can be used to configure the sequence logic. You cannot change the inputs/outputs generated by the characteristics editor in the interface editor (except for system attributes, initial value, comments), in other words, the characteristics editor is the master for these inputs/outputs.

You can group inputs/outputs only in the characteristics editor. These groups are taken into account during compilation in the applicable plausibility checks and status and message processing. Visualization/operator control on an OS station (for example, of setpoints) using the SFC type faceplate requires the characteristics editor.

For more information on the Characteristics Editor, refer to the section Characteristics of the SFC Type
5.6.2 Characteristics of the SFC Type

Characteristics

A characteristic is the technology-oriented functionality of an SFC type that is described by a set of attributes (for example, I/O name, data type, initial value or high limit).

The following characteristics are available for creating the type:

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control strategies</td>
<td>Control strategies are used for structuring of an SFC type as required for process control. You define control strategies in the characteristics editor in order to use them in configuring sequencers (for heating or cooling, for example). The control strategy can be set by the operator or by a higher-level controller (SIMATIC BATCH, for example). Control strategies are optional. For more information on this subject, refer to the section <a href="#">Note on Subsequent Modifications to Control Strategies</a>.</td>
</tr>
<tr>
<td>Setpoints</td>
<td>Setpoints control the SFC type or are used by it to control underlying automation functions. Setpoints can be set by the operator or by a higher-level controller (SIMATIC BATCH, for example). A setpoint is assigned to the control strategies that exist when it is created. You can change the assignment individually for each control strategy.</td>
</tr>
<tr>
<td>Process values</td>
<td>Process values control the SFC type based on process signals (for example, the value for the fill level).</td>
</tr>
<tr>
<td>Control values</td>
<td>Control values are used by the SFC type to control external logic.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Parameters modify the behavior of the SFC type. For example, you can use parameters to select alternative branches or to configure start conditions.</td>
</tr>
<tr>
<td>Bit memory</td>
<td>Bit memory is the local data memory of the SFC instances belonging to the SFC type. You can temporarily store data here and reuse it later. The data are retained until they are overwritten or deleted.</td>
</tr>
<tr>
<td>Timers</td>
<td>Timer objects are used to configure time-driven sequences in an SFC type. Timer objects can be used locally for a step or applied overall to multiple steps and sequencers. Timed routines are started in steps, stopped, and the elapsed time queried in transitions or start conditions. You can vary timed sequences with a variety of modes (for example, pulse, extended pulse, on delay, retentive on delay, off delay).</td>
</tr>
<tr>
<td>Note texts</td>
<td>Note texts are used to display information relating to execution that may require action on the part of the operator. A note text is displayed on the OS in the SFC faceplate and can be acknowledged there. For more information on this subject, refer to the section <a href="#">Using Note and Position Texts</a>.</td>
</tr>
</tbody>
</table>
### Characteristic

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Block Contacts</strong></td>
<td>Block contacts represent blocks of the basic automation. When a block contact is created, inputs/outputs of the block to be represented are created in the interface of the SFC type. When configuring the SFC type, you can use these inputs/outputs to represent the block that will later be interconnected with an SFC instance. For more information on this subject, refer to the sections Inputs/Outputs for Characteristics, Block Contacts.</td>
</tr>
<tr>
<td><strong>Position texts</strong></td>
<td>Position texts are used to display the current progress in execution or the status of execution of the SFC. A position text is displayed on the OS in the SFC faceplate. For more information on this subject, refer to the section Using Note and Position Texts</td>
</tr>
</tbody>
</table>

### Additional Information

For more information, refer to the following sections:

- Inputs/Outputs for Characteristics
- Attributes for Characteristics
5.6.3 Note on Subsequent Modifications to Control Strategies

Notes

Control strategies that have already been used, for instance in:

- Start Conditions
- Transitions
- Assignment to setpoints
- Control strategy release

Should not be deleted or moved in the characteristics editor, otherwise the control strategies will be renumbered. This also applies for control strategies that you copy from one SFC type into a different SFC type.

The numbers of the control strategies in the existing utilization are not adapted. For this reason, accesses and other mechanisms that reference these numbers no longer function as originally intended.

Example

You no longer want to use the control strategy with number "2" and delete it.

The control strategies are renumbered. The previous control strategy "3" is given the number "2", control strategy "4" is given the number "3", etc.

If you no longer want to use a control strategy, do not delete the control strategy; rather, rename it as "not used", for example. The numbering and functionality of the other control strategies is then retained.
5.6.4 How to Configure Note Texts and Position Texts

Procedure from Configuring up to Use of Note Texts

1. Configure note texts and position texts in the characteristics editor. Each text contains a unique number for identification. The characteristics editor assigns the next available number for this. You can change the numbers as you wish – but they must remain unique among all texts (value range: 1 to 32767). The numbering can also include gaps.

Before a note text can be displayed in the SFC faceplate, the OPTIPNO I/O containing the relevant note text number must be included in a step suitable for the note text.

2. After compiling and downloading the AS and compiling and downloading the OS, you activate the OS.

3. Once the faceplate for the SFC instance is open, you can prepare and start the SFC instance ("Prepared values" view of the faceplate).

When the step used in item 2 is executed, the faceplate displays the note text.

4. Acknowledge the note text by clicking "OK".

The dialog box for operator acknowledgement appears.

5. Click "Yes". This confirms the operation. An operating message is generated on the OS and the OPTIPNO output is reset to "0" in the block.

The value change of OPTIPNO from "x" to "0" can be interpreted as an acknowledgment if the SFC type does not trigger this change itself by assigning a value to OPTIPNO in a step.

**Note:** The displayed text is either the comment for the note text or, if the comment was not configured, the name.
Procedure from Configuring up to Use of Position Texts:

The procedure for position texts corresponds to the procedure for note texts with the following differences:

- The associated block I/O is called "POSINO".
- Steps 5 and 6 are omitted.

Notes

Note the following:

- An SFC type has two note texts that are triggered during the setpoint check if the value limits are violated: "Low Limit for a Setpoint Underranged" and "High Limit for a Setpoint Exceeded". These default note texts are used if a separate note text has not be configured. (OPTIPNO = 0).
- The display of note and position texts does not cause a message to be generated and is not documented in the message system. The acknowledgment of a note text, on the other hand, is documented as an operating message.
- When copying instruction texts and position texts from an SFC type and inserting in a different SFC type the numbers are reassigned. If usages already exist in steps, transitions and sequences and chains then you must check these numbers and correct them if necessary.

5.6.5 Inputs/Outputs for Characteristics

Inputs/Outputs for Characteristics

There are predefined descriptions of the required inputs/outputs for use in defining the interface inputs/outputs or I/O elements of a characteristic.

The required interface inputs/outputs or I/O elements for the "Control strategies", "Note texts" and "Position texts" characteristics are already contained in the standard interface of an SFC type.

For the other characteristics, the names of the individual I/O elements are made up of the I/O names configured in the characteristic and a fixed part.

Additional Information

For more information, refer to the following sections:

- "Characteristics" Interface Parameter Assignments
- "Characteristics" Interface Expansions
- Standard Interface of an SFC Type
- Block Contacts
- Attributes for Characteristics
### 5.6.6 Block Contacts

**Block Contacts**

If you want to use block contacts to connect the basic automation blocks, specify the inputs/outputs relevant for the connection to an SFC type in the block types.

To do this, you have to assign system attribute "S7_contact=true" for the block I/O in the creation language of the block type. The technological blocks from the PCS 7 Library are prepared accordingly. You can adapt the inputs/outputs in the supplied block types to your project conditions.

**Note**

If you subsequently add or change system attribute "S7_contact" for the I/O of a block type that is used as a block contact in the SFC type, this has no effect on the block inputs/outputs of the SFC type.

If you want these changes to be adopted for the SFC type, note the following:

- Import the changed block type in the CFC with the menu command **Options > Block Types**. All block instances of the type are updated during the import.
- Update the block contacts in the SFC with the menu command **Options > Block Contacts**. This menu command applies the changes to the interface of the SFC type and to all SFC instances.

By defining an instance of the "block contact" characteristic in the characteristics editor, the selected block inputs/outputs are created accordingly in the SFC type. The IN I/Os of the block type are created as OUT I/Os in the SFC type. The OUT I/Os of the block type are created as IN I/Os in the SFC type. The IN_OUT I/Os of the block type are created as OUT I/Os in the SFC type.

This allows you to interconnect a specific CFC instance of the block type to the corresponding inputs/outputs of an SFC instance. An instance of the "block contact" characteristic is therefore always assigned to exactly one block type. You must enter the relevant block type in the "Block" column in the right window pane. The block type must be present in the ES data management.

This procedure enables you to configure, commission, and visualize basic automation blocks independently. As a result, you can configure SFC types based on block contacts and interconnect them later to the basic automation blocks.
5.6.7 Attributes for Characteristics

Attributes for Characteristics

In the following table you can see the attributes available for configuring the characteristics along with their meaning.

Assignment of the Attributes to the Characteristics

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Control strategy</th>
<th>Setpoints</th>
<th>Process values</th>
<th>Control values</th>
<th>Parameters</th>
<th>Bit memory</th>
<th>Timers</th>
<th>Note texts</th>
<th>Block contacts</th>
<th>Position texts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Display name</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>×</td>
<td></td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Standard</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data type</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>I/O name</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td>×</td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>&lt;Setpoint&gt;</td>
<td></td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial value</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Text length</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Precision</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low limit</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High limit</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text0</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text1</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enumeration</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Archive</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setpoint ID</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proc val ID</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tracking ID</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Faceplate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Transfer ID</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer counter</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Meaning of the Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name is a designator for the characteristic that must be unique among all characteristics of a type. It can contain a maximum of 24 characters and cannot contain spaces or special characters (exception: &quot;.&quot;). The name is irrelevant for the interface inputs/outputs.</td>
</tr>
<tr>
<td>Display name</td>
<td>The display name can be in other languages and is also transferred to WinCC when compiling the OS. The display names can only be modified on the type.</td>
</tr>
<tr>
<td>Number</td>
<td>The number uniquely identifies the corresponding characteristic. With control strategies, the number is managed by the system and assigned consecutively from 1 to 32 according to the position in the characteristics editor. The control strategy &lt;no&gt; is assigned bit &lt;no-1&gt; in the SELCS I/O of the SFC type. This bit is set if the corresponding control strategy has been configured. With an SFC type and SFC instance, the bit is deleted when the corresponding control strategy is not to be used (selection with the menu command SFC &gt; Properties &gt; Options: Control strategy selection). The next available number is used for note and position texts. However, you can replace the number with any other number of your choice as long as it is unique and in the range of 1 to 32767.</td>
</tr>
<tr>
<td>Standard</td>
<td>&quot;Standard&quot; indicates the control strategy that will be used when starting the SFC instance with prepared values.</td>
</tr>
<tr>
<td>Data type</td>
<td>Permitted data types for characteristics are BOOL, INT, DINT, REAL, and STRING. For setpoints, the data types PI and PO are also available and basically represent a REAL setpoint with the addition of the &quot;Material&quot; and &quot;Tracking ID&quot; attributes. Lists can be assigned to the data types DEST, SOURCE, VIA and TKEY. Depending on the characteristic and its data type, other boxes can either be edited or are locked.</td>
</tr>
<tr>
<td>I/O name</td>
<td>The I/O name is required to generate the interface inputs/outputs belonging to the characteristic. The I/O name is derived from the characters of the name. You can change the I/O name. The following limits apply: Setpoints and counters: max. 16 characters Block contacts: max. 10 characters All other characteristics max. 24 characters When the interface inputs/outputs are created, several inputs/outputs are generated depending on the characteristic. A suffix is appended to the I/O name so that the inputs/outputs are named uniquely. The maximum lengths of the I/O names result from the different ways of generating interface inputs/outputs. With setpoints and timers, the system limits the suffix to a maximum of 8 characters. With block contacts, the length of the suffix depends on the block being used. No suffix is appended to the other characteristics so that the I/O name can contain a maximum of 24 characters.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can use comments to describe the characteristic in greater detail. The comment can contain a maximum of 80 characters and include any special characters.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Meaning</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;Setpoint&gt;</td>
<td>Setpoint selection for the &quot;Control strategy&quot; characteristic. Name of each created setpoint is displayed as a column. This allows you to assign the required setpoint to the control strategy by selecting the corresponding column. The assignment of setpoint to control strategy is stored in the &quot;&lt;setpoint-I/O name&gt;_CS&quot; I/O for each setpoint. The coding is the same as for the SELCS I/O; in other words, control strategy &lt;no&gt; is assigned bit &lt;no-1&gt;. This bit is set if the setpoint is assigned to the control strategy; in other words, it is required to run the control strategy.</td>
</tr>
<tr>
<td>Initial value</td>
<td>The initial value corresponds to the value of the characteristic when no current value is available. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Text length</td>
<td>With the STRING data type, the text length defines the maximum length of the string (number of characters: 1 to 254).</td>
</tr>
<tr>
<td>Precision</td>
<td>With the REAL, PI, and PO data types, the precision defines the number of decimal places to be displayed (0 to 7).</td>
</tr>
<tr>
<td>Unit</td>
<td>With the INT, DINT, REAL, PI, and PO data types, a unit can be defined. This is stored as system attribute &quot;S7_unit&quot; for the interface inputs/outputs. The attribute can be changed in the SFC instance. The units are included as a basic set in the ES data management and can be added to or modified in SIMATIC Manager as &quot;Shared declarations&quot;.</td>
</tr>
<tr>
<td>Low limit</td>
<td>With the INT, DINT, REAL, PI, PO, DEST, SOURCE, VIA, and TKEY data types, a low limit can be defined for the range of values. This is stored in the &quot;&lt;I/O name&gt;_LL&quot; I/O. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>High limit</td>
<td>With the INT, DINT, REAL, PI, PO, DEST, SOURCE, VIA, and TKEY data types, a high limit can be defined for the range of values. This is stored in the &quot;&lt;I/O name&gt;_HL&quot; I/O. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Text0</td>
<td>With the BOOL data type, this is used to specify the value identifier for the value FALSE. This is stored as system attribute &quot;S7_string0&quot; for the interface inputs/outputs. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Text1</td>
<td>With the BOOL data type, this is used to specify the value identifier for the value TRUE. This is stored as system attribute &quot;S7_string1&quot; for the interface inputs/outputs. The attribute can be changed in the SFC instance.</td>
</tr>
<tr>
<td>Enumeration</td>
<td>With the BOOL, INT and DINT data types, you can assign an enumeration. This is stored as system attribute &quot;S7_enum&quot; for the interface inputs/outputs. The enumeration is defined in SIMATIC Manager in the &quot;Shared declarations&quot;. You can select the name of the enumeration for the attribute from a drop-down list box. The attribute can be changed in the SFC instance. The enumeration is then available for operator control and monitoring of SFC instances in SIMATIC BATCH and in the SFC faceplates. Note: If &quot;S7_enum&quot; is used, the &quot;S7_string_0&quot; and &quot;S7_string_1&quot; system attributes are ignored.</td>
</tr>
<tr>
<td>Archive</td>
<td>From the drop-down list box, you can select whether the current value of the &quot;&lt;I/O name&gt;_AO&quot; output is to be archived, is not to be archived, or is to be transferred to the long-term archive. The attribute can be changed in the SFC instance. An archive tag is created when the OS is compiled so that the value is transferred to the archive.</td>
</tr>
<tr>
<td>Test</td>
<td>This selects the characteristic that is to be provided for manual testing (manufacturing instruction) in the batch report of SIMATIC BATCH.</td>
</tr>
</tbody>
</table>
### Attribute Meanings

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setpoint ID</td>
<td>You use the ID number to specify if the characteristic value is to be saved for logging. If the ID is greater than 0, the setpoint or process value is also made available for an external program. You can make processing in an external application easier if you assign unique ID numbers to the characteristic values. You can assign ID numbers from 0 to 32767.</td>
</tr>
<tr>
<td>Proc val ID</td>
<td>тельныйство используется для указания, если значение характеризует значение процесса или установки. Если ID больше 0, значение установки или процесса также становится доступным для внешнего программного обеспечения. Можно сделать обработку в внешней приложении проще, если вы присвоите уникальные ID-номера характеристикам значений. ID-номера можно присвоить значениям от 0 до 32767.</td>
</tr>
<tr>
<td>Material</td>
<td>With the PI and PO data types, you can enter a material identifier.</td>
</tr>
<tr>
<td>Tracking ID</td>
<td>With the data types PI, PO, you can enter a numeric ID to identify the material.</td>
</tr>
<tr>
<td>Block</td>
<td>This attribute contains the name of the block type represented by the block contact. When the interface inputs/outputs are generated, the interface inputs/outputs for which system attribute &quot;S7_contact=true&quot; is set are adopted in the SFC type from the block type. The names of the interface inputs/outputs of the block type are appended as suffixes to the I/O names of the block contact. Inputs and in/outs of the block type become outputs of the SFC type. Outputs of the block type become inputs of the SFC type.</td>
</tr>
<tr>
<td>Faceplate</td>
<td>Here you can select the parameters that will be displayed in the parameter view of the SFC faceplate.</td>
</tr>
<tr>
<td>Transfer ID</td>
<td>This ID is the unique ID of an individual transfer in BATCH. It is part of the transfer key (data type, TKEY) and assigned by an MES application.</td>
</tr>
<tr>
<td>Transfer Counter</td>
<td>This attribute shows the loop repetition number of the transfer phases in BATCH. It is part of the transfer key (data type TKEY) and is assigned by an MES application.</td>
</tr>
</tbody>
</table>

### Additional Information

You can find additional information about the inputs/outputs and characteristics in the following sections:

- "Characteristics" Interface Parameter Assignments
- "Characteristics" Interface Expansions

You can find additional information about the system attributes in the STEP 7 online help under:

- "System Attributes for Block I/Os"
6 Configuring Sequential Control Systems

6.1 How to Configure Sequential Control Systems

Requirements

Before you can configure sequential control systems, you must first create the required basic automation functions with CFC and/or STEP 7 tools. At the same time, the AS blocks to be used in the SFC charts or SFC types are also inserted. Automation functions that do not yet exist can be added as needed and then used in the SFC.

Procedure

When configuring a sequential control system (SFC chart or SFC type), proceed as follows:

- Create the sequencer topology with the required number of sequencers and the required layout of SFC elements.
- Configure the start condition, the preprocessing and the postprocessing in the "Properties" dialog box for the sequencers.
- Configure the actions and conditions in the "Properties" dialog box for the steps and transitions.

Color ID

The objects of the sequential control system are displayed in different colors depending on their current state. The elements of an unselected sequential control system, for example, are displayed in "white" (parameters not assigned) or "gray" (parameters assigned) and in "blue" when they are selected.

You can select your own color scheme for specific elements using the menu command Options > Customize > Colors....

When you open the object properties then the tab IDs of the tab that do not have any entries have the standard background color of the dialog box. For a tab with content the background of the tab ID is marked in the color that is set in the Windows properties for the display (right mouse button on desktop: Properties > Display > Extended > Element: Selected Element).
Textual Interconnections

If you delete CFC blocks that access the SFC, these accesses will be configured as textual interconnections (text of the address is marked in yellow).

You can complete a textual interconnection as soon as the connection partner is available again in the chart folder. The textual interconnection will then become a real interconnection.

To complete a textual interconnection, select either the menu command **Options > Make Textual Interconnection** or select the "Make textual interconnection" check box in the "Compile" dialog box.
6.2 Creating the Sequencer Topology

6.2.1 How to Create a Sequencer Topology

Display of the Sequence
In its initial state, the new SFC consists of one sequencer; however, this can be extended up to a maximum of 8 (SFC chart) or 32 (SFC type) sequencers. You create each sequencer in its own working window. A tab is created for every working window at the bottom of the screen. The tab shows the name of the sequencer (for example, RUN or SEQ1). You can switch to the individual sequencers using these tabs.

A newly created sequencer (menu command Insert > Sequencer > ...) is inserted at a selected position in the SFC in its initial state consisting of an initial step, transition and final step.

For more information, refer to the section: How to Configure Multiple Sequencers

If you insert or delete SFC elements in the sequencer, its layout is changed automatically according to predefined rules. These rules determine the spacing between elements, the extension of steps and transitions, or the alignment of alternative branches. You can change these layout rules at any time using the menu command Options > Settings > Layout....

You can center the entire sequencer topology in the window. You can zoom into and zoom out of the display as required using the zoom functions. The changes are made in percentage increments that are determined by the zoom factor.

Adding Elements
If you want to add additional elements to the SFC, select the icon of the required element to be created in the element bar.

The cursor changes its appearance from an arrow to the selected icon with a positioning cross. Position the cross at the desired located to insert the sequencer element. The position of insertion is marked by a green line. Left click on the insertion position. The inserted elements are highlighted in color.
Syntax Rules

The sequencer topology is formed by the sequences of steps and transitions. The fundamental rule of the sequencer topology is that a step (S) must be followed by a transition (T) and a transition must always be followed by a step (sequence: S-T-S or T-S-T). The editor automatically adheres to the rules.

Example:

If you insert a simultaneous branch after a transition and before a step in a sequencer, a transition is automatically created between the simultaneous branch and the step.
6.2.2 How to Configure Multiple Sequencers

Introduction

An SFC can contain several sequencers that can be used for different applications. By specifying different start conditions, you can arrange for a specific sequencer to start when a particular event occurs. You can, for example, configure a separate sequencer for every operating state (idle, active, or error, for example) or for every control strategy (heating, cooling, or tempering, for example).

Note
Predefined sequencers are already available for various standard scenarios. These sequencer templates are available in the "SFC Library".
You can copy these templates and adapt them to suit your purposes.

Grouping of Sequences into a Sequencer

If the processing sequences for the "Active" state and the "Holding", "Held" and "Resuming" states are to be grouped into one sequencer as alternative branches, you must set the RUNHOLD input of the SFC to TRUE.
If RUNHOLD is set to FALSE, the sequencer change mechanism does not work (a sequencer cannot be held and then (re)started and then resumed). If the runtime system detects that a sequencer to be resumed was previously aborted, this is displayed as an execution error (EXEC_ERR). The configuration must then be corrected to conform to the rule above.

Start Conditions of the Sequencers

The first sequencer of an SFC has the condition "<SFCName>.RUN=Run" in an SFC chart or "RUN=Run" in an SFC type. The start condition of every other sequencer added is empty and therefore unfulfilled; in other words, it is never processed. In contrast to newly created transitions that are always fulfilled, a new sequencer must always be given a defined start condition with the menu command Sequencer Properties > "Start Condition" tab.
Since it is possible that several start conditions can be satisfied at the same time, you can assign different priorities to the individual sequencers with the menu command Sequencer Properties > "General" tab, Priority: 1 to 255).
Formulate the start condition of a sequencer so that the status of the operating state logic is checked and the appropriate sequencer is executed when the SFC is in the corresponding state. You can also formulate any other conditions to suit your purposes.

When configuring start conditions, follow the same procedure as for configuring transitions. You will find detailed information on this subject in the sections:

- Formulating Conditions of a Transition
- How to Edit Addresses in a Transition
- How to Edit OS Comments in a Transition

**Examples**

**Example 1:**
You configure a sequencer with a start condition that queries one of the control strategies of the SFC. The formulation is, for example, "QCS=Heat". If the SFC is set to this control strategy, the sequencer is executed and is not dependent on the operating state of the SFC.

**Example 2:**
You configure a sequencer with the start condition "<SFCName>.IDLE=Idle". This sequencer is executed if the operating state is "Idle".

**Example 3:**
Any process status can also be queried for the start condition. To do this, interconnect the process status to the external signal "LOCKERROR" (input of the SFC). The SFC changes to "Error" state if the problem occurs. Also configure a sequencer for handling the problem whose start condition is "<SFCName>.ERROR=Error AND <process status>=1", for example.

**Example 4:**
As an alternative to example 3, error handling is also possible without a state change. To achieve this, you configure a sequencer with the start condition "<process status>=1" and assign it a high priority. This sequencer is always executed when the problem occurs and the sequencer that is currently being processed has a lower priority than the sequencer for handling the problem. In this case, do not interconnect the process status to the "LOCKERROR" input as this would mean a change to "Error" state.

**Note**
With a chart, the address "<SFCName>.I/O" is specified and with a type only "I/O" is specified.
How do I create a sequence?

You can insert a new sequencer consisting of a start step, a transition, and a final step with the menu commands:

Insert > Sequencer > Before Current Sequencer

or

Insert > Sequencer > At End

How do I move/copy a sequencer?

You can move or copy a sequencer within an SFC window and reinsert it at another position.

Procedure for moving within the current SFC window

1. Select the menu command Edit > Move Sequencer....
   The "Move Sequencer" dialog box opens.
2. Check if the "Create copy" check box is cleared in the dialog box (default: check box cleared).
3. From the list, select the sequencer before which you want to insert the moved sequencer or select the line "(put at end)".
4. Click "OK".

Procedure for copying within the current SFC window

1. Select the menu command Edit > Move Sequencer....
   The "Move Sequencer" dialog box opens.
2. Select the "Create Copy" check box (check mark).
3. From the list, select the sequencer before which you want to insert the copied sequencer or select the line "(put at end)".
4. Click "OK".

The copied sequencer is renamed automatically so that the names of the sequencers in the SFC window are always unique. If the last position of the name is a number, it is incremented, otherwise a free number is appended to the name.
Procedure for copying/moving and inserting outside the current SFC window

1. Select the menu command Edit > Copy Sequencer or Edit > Cut Sequencer.
2. Switch to the other SFC window.
3. Select the menu command Edit > Insert Sequencer.
   The copied/cut sequencer is then inserted before the current sequencer in the other SFC.

Note
Pasting also works within the same SFC window. The copied/cut sequencer is then renamed and inserted before the current sequencer.

How do I delete a sequencer?

You delete the current sequencer as follows:

1. Select the menu command Edit > Delete Sequencer.
2. Click "Yes" to acknowledge the prompt for confirmation.

Notes on Configuration

Note the following:

- The names of the steps and transitions must be unique within a sequencer; you can use the same names in different sequencers.
- You can also configure an additional action for each sequencer. Each action consists of the following:
  - **Preprocessing**, actions to be executed in every cycle after the sequencer has started before processing the steps and transitions
  - **Postprocessing**, actions to be executed in every cycle after processing the steps and transitions

You configure both parts in the "Sequencer Properties" dialog box. The dialog box provides the "Preprocessing" and "Postprocessing" tabs for this purpose, whose structure corresponds to the processing phases of steps.
6.2.3 Overview of Inserting/Creating SFC Elements

Inserting/Creating SFC Elements

You select the SFC element you want to insert with the menu commands Insert > Step/Transition, > Simultaneous Branch, > Alternative Branch, > Loop, > Jump or > Text. The cursor changes its appearance and you change to insert mode. As an alternative to the menu commands, you can also click the corresponding icon in the element bar.

When you now move the mouse over the sequencer, the shape of the cursor indicates whether you can insert the selected element (icon of the SFC element and <+> key) or whether you cannot (icon depicting a prohibited sign).

If you move the mouse pointer to a "permitted" insertion point in the sequencer, you will see a horizontal green line.

Within the simultaneous branch (in the vicinity of the upper simultaneous branch or lower simultaneous branch), the vertical green line indicates that you are inserting an additional sequence. If, for example, you insert an alternative branch beside a sequence, an additional step is created before and after the sequence to maintain the correct syntax. If, for example, you insert a simultaneous branch beside a sequence, an additional transition is created before and after the sequence.

After insertion, the inserted SFC elements are highlighted in blue.
6.2.4 How to Create a Sequence

Introduction
When generating a sequence, a transition-step-sequence (TS) or an step-transition-sequence (ST) (see figure) is generated depending on the position.

![Diagram showing TS and ST sequences]

Key:
1. TS sequence
2. ST sequence

Procedure
1. Click the step/transition icon in the element bar.
2. Click the vertical line of the sequencer between a step and transition (or between a transition and step).
3. If you move the cursor to a "permitted" insertion point in the sequence, you will see a horizontal green line.
4. If you also want to specify the length of the sequence, keep the left mouse button pressed and drag a lasso in the vertical direction. The current length that will be inserted (number of ST/TS pairs) is displayed as a number at the starting point of the lasso.

Result
The sequencer is inserted at the desired position.
6.2.5 How to Create and Edit a Simultaneous Branch

Introduction
When you create a simultaneous branch, two sequences are generated, each consisting of one step. Depending on the point of insertion, a further transition is added automatically before or after the simultaneous branch to ensure that the syntax is maintained.

Procedure
1. Click the simultaneous branch icon in the element bar.
2. Then click the position at which the simultaneous branch should be inserted.

If you keep the left mouse key pressed while entering and drag open a lasso around elements of a sequence (here S5 to S6), the marked elements become part of the left sequence of the generated simultaneous branch.

If you drag a lasso so that instead of a pure step sequence (here: S5 to S6) a step-transition sequence is captured (here: S5 to T5), due to syntactic reasons an additional step (here: S10) is created in the left sequence and a transition (here: T9) is created after the simultaneous branch. S10) in the left sequence and a transition (here: T9) after the simultaneous branch.
3. If you want to expand a simultaneous branch, switch to the desired insertion mode (for example, alternative branch) and click using the positioning cursor at the desired position in the vicinity of the upper or lower branch line.

**Editing a Simultaneous Branch**

You can add additional sequences, simultaneous branches or alternative branches to a simultaneous branch, delete them or insert them in a different sequence. You can move sequences within a simultaneous branch or to any other position in the sequencer (except in the return branch of a loop). If you delete the next to last sequence, the remaining sequence is simply integrated in the surrounding structure and the simultaneous branch is eliminated.
6.2.6  How to Create and Edit an Alternative Branch

Introduction
When you create an alternative branch, two sequences are generated, each consisting of a transition. Depending on the point of insertion, a further step is added automatically before or after the alternative branch to ensure that the syntax is maintained.

Procedure
1. Click the alternative branch icon in the element bar.
2. Click the position at which the alternative branch should be inserted.
   If you hold down the left mouse button and open a lasso around elements of a sequence, these elements become part of the left sequence of the resulting alternative branch.
3. If you want to expand an alternative branch, switch to the desired insertion mode (for example, simultaneous branch) and click the positioning cursor at the desired position in the vicinity of the upper or lower branch line.

Editing an Alternative Branch
You can add additional sequences to an alternative branch or delete them and also insert them in a different sequence. You can move sequences within the alternative branch or to any other position in the chart. If you delete the next to last sequence, the remaining sequence is simply integrated in the surrounding structure and the alternative branch is eliminated.
6.2.7 How to Create and Edit a Loop

Introduction

When you create a loop, a sequence, which can consist of a single step, and a return path with a transition are generated.

Procedure

1. Click the loop icon in the element bar.
2. Click the vertical line at the position where the loop should begin.
3. Keep the mouse button pressed and release it on the vertical line at the desired end position.

Result

The loop is created around the elements contained between the start position and end position. The syntax is maintained by adding elements as necessary.

Moving a Loop

If you want to move a loop, first select the loop with the elements it contains. Keep the mouse button pressed and place the loop at the desired position on the vertical line of the sequence.
Changing the Return Jump Destination

To change the return jump destination later, select the horizontal line of the arrow tip and holding down the left mouse button, move it to any syntactically correct position in the sequencer above the starting point.

If you drag the arrow point below the starting point of the loop, the starting point will be moved instead of the return jump destination.

Notes

- Loops leading into or out of alternative or simultaneous branches are not permitted. Due to the block-oriented sequencer topography, only entire chart elements, including alternative and simultaneous branches, can exist within a loop.

- The return path of a loop can and must contain only one transition.
6.2.8 How to Create and Edit a Jump

Introduction

When you insert a jump, a transition with an arrow and jump destination information is generated.

Procedure

1. Click the jump icon in the element bar.
2. Create the jump directly after a step on the vertical line of the sequence:
   - If you want to create a jump with an undefined jump destination, click the vertical line after the step.
     The jump is created. The jump destination is displayed as question marks (???). You can now change the jump destination.
   - If you want to create a jump with a defined jump destination, drag from the jump origin to the desired step.
     The jump is created. The name of the step is entered in the jump destination.
   - If you want to create a jump with several jump destinations, repeat the previous action

Note

• When a step used as a jump destination is deleted, all jumps referring to it become undefined.
• If the name of a step used as a jump destination is subsequently changed, all the jumps referencing it are automatically adapted.

3. Double-click the jump destination information.
   The "Select Jump Destination" dialog box opens. All the available steps of the chart - except the start step - are shown in a sortable list.
4. Select a step as the new jump destination and click "OK".
Jump to Destination

1. Select the jump.
2. Select the context menu command "Go to Jump Destination".

Result: The jump destination is displayed as selected.

You can use the function in the edit and test modes.

Deleting a Jump

Select the jump-transition and press the "Del" key.

---

Note
Be aware of the possible consequences during execution in the AS when working with jumps to or from a sequence of a simultaneous branch.

Jumps to or from a simultaneous branch should be used with special care: the respective jump always refers to the sequence in the simultaneous branch in which the source or destination is located. All other sequences will continue to be processed regardless of what happens.

If you jump from one of the sequences, you should make sure that

- There is a return jump to the same sequence
- or
- All other sequences are also exited with a jump.

The user is responsible for using jumps carefully and being aware of the consequences to prevent unexpected runtime behavior in the AS.

**Recommendation**: Avoid using jumps into or out of simultaneous branches.
6.2.9 How to Create and Edit a Text Box

Introduction
You can insert, delete, copy and move a text box to any free position in the chart. You cannot move text objects across charts using drag-and-drop.

Procedure

1. Click on the text symbol in the toolbar.
2. Click using the positioning cursor on the desired location in the window where you wish to place the text box.
   A text box is inserted and opened in the window. The text cursor is active.
3. Enter text in the text box.
   The text automatically wraps at the end of the line.
4. Finally, click outside the text box to exit edit mode and to close the text box.

Note
When positioning, make sure that the text box does not cover elements of the sequencer topology. If this happens, the unselected text box will be displayed as a frame with a transparent surface (without content). The chart elements below it remain visible.

Changing the Size of a Text Box

If you enter more text than can be displayed in the box, the size of the box is not increased automatically; instead the text moves out of the visible area. You can make the entire text visible by increasing the size of the box manually. If you change the width of the box, the text lines are automatically wrapped.

Procedure:

1. Click the text box to open it.
2. Grab the hatched frame with the cursor and drag the box until the required size is reached.
Moving a Text Box

If you want to move a text box to another location within the window, proceed as follows:

1. **Left** click the text box.
   The text box opens.

2. Grab the text box with the cursor at the non-highlighted point of the frame and drag it to another location within the window.

   If you want to move the text box to another window, follow the procedure described under "Copying or Cutting and Inserting a Text Box".

Copying or Cutting and Inserting a Text Box

1. Open the context menu of the text box.

2. Select the menu command **Cut Text Box** if you want to move the text box or the command **Copy Text Box** if you want to copy it.

3. Switch to the desired window.
   This can be the same window or another window of a sequencer.

4. Open the context menu and select the menu command **Insert**.
   The cursor changes to a hand (with an empty object following cutting, with "+" object after copying).

5. **Left** click the desired position.
   The text box is inserted at the cursor position

Deleting a Text Box

1. **Right** click the text box.
   The context menu opens.

2. Select the menu command **Delete Text Box**.
   The dialog box with the prompt for confirmation opens.

3. Click "Yes".
   The text box is deleted.
6.3 Managing SFC Elements

6.3.1 Selecting SFC Elements

6.3.1.1 How to Select with a Mouse Click

Simple Selection

You can select in the following ways:

- You can select steps and transitions by simply left-clicking them.
- You select sequences by clicking the vertical line between a step and transition. Provided that the sequence is not in a simultaneous branch, alternative branch, or a loop, the entire sequencer is selected.
- You can select branch sequences by clicking on the upper or lower horizontal line.
- You can select loops by clicking the upper or lower horizontal line of the return path (the entire loop is selected) or on the vertical link (only the return path with the transition is selected).
- You can select jumps by clicking the horizontal line of the jump or the vertical line below the step of the origin of the jump (the origin and the jump are both selected). If you click the jump destination information, the associated transition is also selected.
- You can select the entire sequencer by clicking the vertical link of a sequence containing the start or final step.
- If you click an element, any other elements selected at the time are deselected.
- If you right click, the context menu appears with the currently available menu commands.

Multiple Selection

If you want to select more than one SFC element, hold down the <Ctrl> key when clicking with the mouse. The clicked SFC element is selected without deselecting elements you have already selected. If you have inadvertently selected an element, you can deselect it by clicking again while holding down the <Ctrl> key.

If you have selected an entire sequence and click a single element while holding down the <Ctrl> key, the single element is deselected and the entire selection effectively becomes a selection of single elements.
6.3.1.2 How to Select with the Keyboard

Selecting with the Keyboard
You can select SFC elements with the <Up>, <Down>, <Left> and <Right> keys of the keyboard (single selection). The selection made depends on the currently selected element. If no SFC element is currently selected, when you first press a key, the last selected element is selected again.

- <Up> selects the previous SFC element in the sequence
- <Down> selects the next SFC element in the sequence
- <Left> selects the SFC element to the left in the sequence
- <Right> selects the SFC element to the right in the sequence

If you also hold down the <Ctrl> key, you select the SFC elements without deselecting those already selected (multiple selection).

6.3.1.3 How to Select with the Lasso

Selecting with the Lasso
If you drag the mouse while holding down the left mouse button, you open a lasso or frame. All the SFC elements located completely within the lasso are selected when you release the button. SFC elements that were already selected are deselected if they were outside the lasso.

If you also hold down the <Ctrl> key, you select the SFC elements without deselecting those already selected outside the lasso.

If you drag a lasso around a group of selected and unselected elements while holding down the <Ctrl> key, the selected elements are deselected and the unselected elements are selected.
6.3.1.4 How to Select Steps and Transitions for Editing

Selecting for Editing Steps and Transitions

You can edit the properties of steps and transition as follows:

1. Double-click a step or transition.
2. Select the menu command **Edit > Object Properties**....
   A dialog box with tabs opens. Once this dialog box is open, you can edit additional steps or transitions as follows:
3. Click the following buttons in the dialog box:
   - ![prev](previous step or transition)
   - ![next](next step or transition)
   - ![left](step or transition to the left)
   - ![right](step or transition to the right)
4. Click the desired step or transition in the SFC.
6.3.2 Copying, Moving and Deleting SFC Elements

6.3.2.1 How to Copy SFC Elements

Overview of Copying

You can insert copied elements of a sequencer to a syntactically correct position within the same sequencer or in another sequencer of the same SFC or a different SFC on the same CPU or a different CPU. If necessary, new names may be assigned to the copied elements automatically. The copies contain the same actions or conditions as the originals.

If you paste a copied step or a copied transition in an SFC on a different CPU, textual interconnections may be created if there are accesses to objects that have not been copied (for example, blocks in the CFC).

When you copy, the syntax is automatically corrected, for example, by adding an empty step or an empty transition.

Copying with the Mouse

In addition to the menu commands Copy and Paste, you can also copy SFC elements with the mouse (exception: text boxes).

Procedure:
1. Select the desired elements and hold down the left mouse button.
2. Press the <Ctrl> key at the same time.
3. Drag the positioning cursor to the desired location in the sequencer in the same window or another window and then release the mouse button (drag-and-drop).

The cursor adopts the shape of a prohibited sign if copying is not permitted at the current position.

Note on Copying Jumps

Note the following:

- If you copy a sequence that contains a jump and the step of the jump destination, the jump destination is adapted accordingly in the copy.
- If you copy a sequence that contains a jump but the destination of the jump is not within the copied object, the jump destination becomes undefined (???).
Copying Text Boxes

Follow the steps outlined below to copy text boxes:

1. Open the context menu of the text box.
2. Select the menu command **Copy Text Box**.
3. Switch to the desired window.
   This can be the same window or another window of a sequencer.
4. Open the context menu and select the menu command **Insert**.
   The cursor changes to a hand (with an empty object following cutting, with "+" object after copying).
5. Left click at the desired position.
   The text box is inserted at the cursor position

**Note**
Multiple selected text boxes cannot be copied at the same time.

Copy object properties

Instead of SFC elements, you can also copy and insert the object properties of steps and transitions. For additional information, see:

- **How to Copy Object Properties of SFC Elements**
6.3.2.2 How to copy object properties of SFC elements

Object properties of steps and transitions

You can copy the complete object properties of steps and transitions and insert them in other steps and transitions. This also applies to the start and end step.

Procedure

1. Select the SFC element whose object properties you want to copy.
2. In the shortcut menu, select the menu command Copy object properties.
3. Select the SFC element that is to adopt the copied object properties.
4. In the shortcut menu, select the menu command Insert object properties.
   A message will appear that prompts you to confirm this action.
5. Acknowledge with "Yes".
   The selected SFC element will adopt the copied object properties.

Note

The message appears prior to each inserting action. If you tick the box "Do not show this message in the future", the message will not be shown anymore.

In the SIMATIC Manager, if you open the "Customize" dialog with the menu command Tools > Customize..., in the "General" tab you can reactivate the system messages.
6.3.2.3 How to Move SFC Elements

Overview of Moving

You can paste cut elements of a sequencer to a syntactically correct position within the same sequencer or in another sequencer of the same SFC or a different SFC on the same CPU or a different CPU. If necessary, new names may be assigned to the copied elements automatically. The moved elements retain their actions or conditions.

When you insert, the syntax is automatically corrected by adding an empty step or an empty transition as needed.

Moving with the Mouse

In addition to the menu commands Cut and Paste, you can also move SFC elements with the mouse. If you move SFC elements, the elements are implicitly cut and pasted again.

Procedure

1. Select the desired elements and hold down the left mouse button.
2. Keeping the mouse button pressed, drag the positioning cursor to the desired location in the sequencer in the same window or another window and then release the mouse button (drag-and-drop).

The cursor adopts the shape of a prohibited sign if copying is not permitted at the current position.
Moving Text Boxes

If you want to move a text box to another location within the window, proceed as follows:

1. **Left** click the text box.
   The text box opens.
2. Grab the text box with the cursor at the non-highlighted point of the frame and drag it to another location within the window.

If you want to move the text box to another window, proceed as follows:

1. Open the context menu of the text box.
2. Select the menu command **Cut Text Box**.
3. Switch to the desired window.
   This can be the same window or another window of a sequencer.
4. Open the context menu and select the menu command **Insert**.
   The cursor changes to a hand (with an empty object following cutting, with "+" object after copying).
5. Left click at the desired position.
   The text box is inserted at the cursor position

---

**Note**
Multiple selected text boxes cannot be moved at the same time.
6.3.2.4 Deleting SFC Elements

Deleting SFC Elements

You can delete selected SFC elements after a prompt for confirmation. The following exceptions and special consideration apply:

- You cannot completely delete the start step or final step. If you delete the start or final step, the parameter assignments for these steps are deleted but not the SFC element itself.

- If you delete only one element from a syntactical unit, the syntax is immediately restored by entering a new element to suit the syntax (this has no parameters assigned). This means that you have only deleted the parameter settings for the object.

- You cannot delete the last step of a sequence in a simultaneous branch. To delete the sequence that now consists of only a single step, you must select the sequence. You select the sequence by clicking the vertical line. The same applies to an alternative branch.

- You can delete a text box by right-clicking and selecting the context menu command Delete Text Box. You can delete several text boxes by selecting them (with a lasso, for example) and then right clicking on one of the objects to select the context menu command Delete.
6.4 Editing Sequencers

6.4.1 How to Edit Sequencer Properties

Opening the Dialog Box
1. Select the menu command Edit > Sequencer Properties...
or
   position the cursor on a sequencer name in the tab at the bottom of the window
   and select the context menu command Sequencer Properties.....
   The dialog box of the sequencer properties opens.
2. Specify the properties by formulating the actions and conditions.
   The "Properties" dialog is divided into five tabs for editing the sequencer:
   - "General"
   - "Start Conditions"
   - "OS Comment"
   - "Preprocessing"
   - "Postprocessing"

"General" Tab
You change the name and comment of the sequencer in the "General" tab. The "Number" box contains the sequencer number generated by SFC. This cannot be changed. In The "Priority" box, you can assign the sequencer a priority of 1 to 255. Here, 1 represents the lowest priority and 255 the highest priority. The priority decides which sequencer of an SFC is started when the start conditions of several sequencers are met simultaneously.

"Start Condition" Tab
In this tab, you define the conditions for the SFC chart/type that will cause the sequencer to start (for example, "<SFCName>.RUN = Active" starts the sequencer when the SFC chart is in "Active" operating state).

The other editing steps in this tab are identical to those for transition conditions. You will find information on this subject in the section "How to Formulate Conditions of a Transition".
"OS Comment" Tab

Editing steps in this tab are the same as for the OS comments for the transitions. You will find information on this subject in the section How to Edit OS Comments in a Transition.

"Preprocessing" and "Postprocessing" Tabs

In these tabs, you can configure the following actions for the SFC chart/type:

- Action that is to be executed in every cycle after the sequencer has started but before the steps and transitions are processed (preprocessing).
- Action that is to be executed in every cycle after the steps and transitions are processed (postprocessing).

The editing steps in this tab are identical to those for formulating actions of the steps. You will find more information on this subject in the section How to Edit a Step.
6.4.2 Editing in the Properties Dialog

6.4.2.1 How to Edit a Step

Opening the "Properties" Dialog of the Step

You open the dialog box by double-clicking the step to be edited or by selecting the menu command Edit > Object Properties... for a selected step.

A dialog box opens where you can edit the properties and formulate the actions.

The dialog box is divided into four tabs:

• "General"
• "Initialization"
• "Processing"
• "Termination"

"General" Tab

In the "General" tab, you can enter or change the step name, the run time and the comments for the step and the OS.

The number was assigned by SFC when the step was generated and is unique in this sequencer. It is read-only and cannot be modified. The number sequence is consecutive without gaps; in other words, if the step is deleted and a new one is inserted later, the new step is given the number of the previously deleted step.

You can assign a flag to the step by clicking the "Confirmation" check box. This flag determines the behavior of the step during execution in the AS in the "T/T and C" mode. Successor transitions following steps with this flag only become active (enable the next step) when they are satisfied and confirmed by the operator (as in "T and C" mode). Without these flags, the successor transitions enable the next steps once their conditions are satisfied (as in the "T" mode).

With "Minimum:" You can set the minimum time that a step should remain active regardless of whether the successor transition is already satisfied.

With "Maximum:" You can specify a time for the time monitoring limiting the maximum time that the step can be active.

In the "Comment" and "OS Comment" boxes, you can enter texts, for example, a brief description of the step. The comment for the step can contain up to 80 characters and the OS comment up to 512 characters. The OS comment is used in process control for visualizing the step.
"Initialization", "Processing", "Termination" tabs

The tabs for the processing phases (actions) "Initialization", "Processing" and "Termination" all have the same layout. This is where you configure the statements that control the actions that take place during initial processing, normal processing and termination processing of the step.

The statements are adopted as OS comments if the check box is activated (check mark) in the relevant line.

With the menu command Options > Edit OS Comment..., you can later specify in a dialog box how the OS comments should be used for the respective processing phases:

- Leave unchanged
- Use all statements
- Use no statements

You can also specify how any edits to the OS comments are to apply in this dialog box:

- The entire chart folder
- The current chart
- The selected steps

Documenting the Configuration

You can document the configured actions of the step. By clicking "Print" in the Object Properties dialog, you obtain a log of the step with information about the properties and statements for initialization, processing and termination.

Changes to the Configuration

If you change the configuration of a step (name, comment, OS comment, attributes, assignments), you can compile changes only (SFC > Compile..., range: Changes menu command) and download while the CPU is in RUN mode (CPU > Download..., download mode: Changes menu command) without first deactivating the active SFC.

You will find detailed information on editing a step in the sections:

- How to Edit Actions in a Step
- How to Edit Addresses in a Step
- How to Copy Object Properties of SFC Elements
6.4.2.2 How to Edit Actions in a Step

Introduction

You enter the statements for actions in a formatted dialog box.

Editing Actions

---

Note

Note that an SFC type can only access its own interface and not external objects.

---

For each step, you can formulate up to 50 statements per action. Ten of these are visible in the dialog box. You can change the visible section with the scroll bar.

Each statement line consists of the following elements:

- The button with the line number for selecting the line
- The check box that you can use to select the statement as an OS comment
- An edit box for the left (first) address, the operator, and the right (second) address.

You can use the number buttons at the start of each line to select a statement in order to copy it, delete it or insert a previously copied statement before it. Once you have selected a button, you can right-click to access the available menu commands.

In unselected lines, you can use the Copy/Paste Action context menu command to copy the statements of a complete action and paste them into another action. In this way, you can easily copy the statements from the "Initialization" action to the "Termination" action, for example.

If you have placed the text cursor in an address box, the context menu only displays the functions required for editing the contents.

Texts with a yellow background reference objects that no longer exist or do not yet actually exist (block inputs/outputs, charts, runtime groups).

This reference is a textual interconnection that you can complete during compiling or explicitly using the menu command Options > Make Textual Interconnection if the interconnection partner actually exists. The textual interconnection is displayed on a yellow background in the line of the address. The same highlighting is used if a previously real interconnection becomes a textual interconnection due to deletion of the interconnection partner.
Textual interconnections that cannot be made are ignored during compilation. A corresponding warning is entered in the log indicating which inputs/outputs still have a textual interconnection. An unmade textual interconnection is also tolerated in the download.

**Note**

Interconnections cannot be set up if the target of the interconnection is not unique; in other words, its name occurs more than once. The interconnection is also displayed as a textual interconnection in this case and it cannot be made.

Example: The object name of an SFC is the same as the symbolic name of a DB.

You will find more information on editing a step in the sections:

- [How to Edit Addresses in a Step](#)
- [Valid Data Types](#)
6.4.2.3 How to Edit Addresses in a Step

Selecting Addresses

Note
Note that an SFC type can only access its own interface and not external objects.

Edit or process the addresses for the statements as follows:

1. Drag the inputs/outputs or characteristics from the interface editor or characteristics editor to the address box.
   
   Note: Several inputs/outputs can exist for a characteristic, for example, for setpoints, timers, and block contacts. In this case, a list of available inputs/outputs is displayed before you insert an address and you can select the required I/O.

2. Drag the block inputs/outputs from CFC charts directly to the address box.

3. Click "Browse".
   
   The dialog box opens.

   The "Browse" dialog box has four different tabs:
   
   - "Plant View"
   - "Component View"
   - "Runtime Groups"
   - "Icons"

   When you browse (through CFC charts in the Plant or Component view, for example), all the available objects of the chart folder are found and displayed.

   You limit the list of inputs/outputs by clicking "Filter...". Then, only the inputs/outputs relating to the current configuration are shown. You will find more information on filtering in the section "How to Filter Block Inputs/Outputs".

4. Select the desired chart and then select the block and the I/O from it.

5. Click "Apply" to enter your selection in the active address box (or drag it to the address box).

   The dialog box remains open until you explicitly close it with the "Close" button or you close the "Object Properties" dialog.
If you make the selection by means of the "Browse" dialog box or using a drag-and-drop operation from the CFC chart, the entries are expanded to include the path of the plant hierarchy (if this exists). The hierarchy path and the chart name are separated by double backslashes ( \ ).

Notes

- Accesses to CFC blocks can also be modified in the relevant CFC chart. This modification, however, is restricted to "rewiring" SFC accesses; in other words, moving the access to another block I/O (with <Alt> + Drag-and-Drop).
- Do not write any values to outputs of blocks and charts (CFC and SFC). Generally, these are overwritten again by the processing of the block or chart.

Example: Turning an SFC chart on and off

The statement "<SFC_chart>.INTONOFF := TRUE", activates an SFC chart. The statement "<SFC_chart>.INTONOFF := FALSE" deactivates an SFC chart; that is, its final step is processed before the chart is terminated.

Selecting Value Identifiers

To enable the value identifiers to be displayed in SFC, activate the "Parameters: Value identifier" check box in the dialog box opened with the menu command Options > Customize > Layout...

If you insert a block I/O with a value identifier in the address box, the value identifier is also entered in the right (empty) address box. If there are several value identifiers for this I/O, you can open the list box with the value identifiers in the right address box and select the desired value identifier for this address from the drop-down list.

Editing Addresses

When making textual entries, make sure that names are consistent. A symbol that does not exist in the symbol list (or a referenced symbol that is subsequently renamed) cannot be checked in the editor and is set up as a textual interconnection.
Notes

- When you enter statements, they are checked for consistency to ensure the correct syntactic and semantic formulation. The program, for example, checks if the data types of the logically combined addresses are compatible.

- In the addresses, you can enter accesses to CFC block inputs/outputs whose block does not yet really exist in the CFC chart. These statements are displayed in the statement line on a yellow background and are set up as textual interconnections.

  You will find more information on textual interconnections in the CFC online help in the section Working with Textual Interconnections

Going to the Point of Use

If you want to see the point of use of an address, place the cursor in the address box and click "Go To". The corresponding chart opens. If the address is an input or output of a block in the CFC chart, the I/O of the relevant block is selected. You can also move to the point of use by double-clicking on the address.

With shared addresses, you jump to HW Config if the address is known there. Otherwise, an error message is displayed.

The "Go To" function cannot be used for runtime groups.
6.4.2.4 Valid Entries for Addresses

Left Address

SFC Chart
The following entries are permitted in the SFC chart for the left address:

- A block input of a block in a CFC chart
  Syntax: `<chart_name>\<block_name>.<IO_name>`
- An SFC chart (on/off)
  Syntax: `<chart_name>.INTONOFF`
- An interface I/O of the SFC/CFC chart (own or another SFC chart)
  Syntax: `<chart_name>.<IO_name>`
- A runtime group (on/off)
  Syntax: `<group_name>.EN`
- A shared address, to which write access is permitted
  Syntax: `<symbolic_name>`
- A textual interconnection
  Syntax: `<any characters>` or path reference to an object that does not yet exist (syntax same as for block I/O)
- Structures

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Structure:</th>
<th><code>&lt;I/O_name&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Substructures:</td>
<td><code>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Substructure&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td><code>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Element&gt;</code></td>
</tr>
</tbody>
</table>

SFC Type
The following entries are permitted in the SFC type for the left address:

- Interface elements (inputs/outputs, structures, substructures, structure elements)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Input/output:</th>
<th><code>&lt;I/O_name&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Structure:</td>
<td><code>&lt;I/O_name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Substructures:</td>
<td><code>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Substructure&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td><code>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Element&gt;</code></td>
</tr>
</tbody>
</table>

- A textual interconnection
  Syntax: `<any characters>` or path reference to an object that does not yet exist (syntax same as for block I/O)
Right Address

The following entries are permitted in the SFC chart for the right address:

**SFC Chart**

- A block I/O of a block in a CFC chart  
  Syntax: `<chart_name>`\`<block_name>`\`.<IO_name>
- An SFC chart (on/off)  
  Syntax: `<chart_name>`\`.<BUSY`
- An interface I/O of the SFC/CFC chart (own or another SFC chart)  
  Syntax: `<chart_name>`\`.<IO_name>`
- A runtime group (on/off)  
  Syntax: `<group_name>`\`.<EN`
- A shared address  
  Syntax: `<symbolic_name>`
- A textual interconnection  
  Syntax: `<any characters>` or  
  path reference to an object that does not yet exist (syntax same as for block I/O)
- A constant  
  Syntax: depends on data type

For the data types BOOL, BYTE, INT, DINT, WORD, DWORD, instead of the absolute numeric values, you can also specify their symbolic identifiers (value identifiers).

- Structures

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Structure:</th>
<th><code>&lt;I/O_name&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Substructures:</td>
<td><code>&lt;I/O_name&gt;</code>`.&lt;Substructure&gt;<code>... </code>&lt;Substructure&gt;`</td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td><code>&lt;I/O_name&gt;</code>`.&lt;Substructure&gt;<code>... </code>&lt;Element&gt;`</td>
</tr>
</tbody>
</table>

**SFC Type**

The following entries are permitted in the SFC type for the right address:

- Interface elements (inputs/outputs, structures, substructures, structure elements)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Input/output:</th>
<th><code>&lt;I/O_name&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Structure:</td>
<td><code>&lt;I/O_name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Substructures:</td>
<td><code>&lt;I/O_name&gt;</code>`.&lt;Substructure&gt;<code>... </code>&lt;Substructure&gt;`</td>
</tr>
<tr>
<td></td>
<td>Structure element:</td>
<td><code>&lt;I/O_name&gt;</code>`.&lt;Substructure&gt;<code>... </code>&lt;Element&gt;`</td>
</tr>
</tbody>
</table>

- A textual interconnection  
  Syntax: `<any characters>` or  
  path reference to an object that does not yet exist (syntax same as for block I/O)
6.4.2.5 How to Filter Block Inputs/Outputs

Procedure

In the "CFC Charts" tab of the "Browse" dialog, you can use a filter to display only the block inputs/outputs that are relevant for assignment in the current address box. In the "Filter – I/Os" dialog box, you can specify the criteria that decide which inputs/outputs of the selected block are displayed or not displayed.

Filter Criteria

The following filter criteria are ANDed with each other.

<table>
<thead>
<tr>
<th>Filter Criterion</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List Boxes</strong></td>
<td></td>
</tr>
<tr>
<td>Name:</td>
<td>In the list boxes, you can enter the text to identify an I/O name or I/O comment. This does not need to be the full name/comment but rather can also be initials (without gaps).</td>
</tr>
<tr>
<td>Comment:</td>
<td></td>
</tr>
<tr>
<td>Visible in CFC chart:</td>
<td>An input/output can be visible in the CFC chart or, although present, invisible (S7_visible := 'false').</td>
</tr>
<tr>
<td>Listed:</td>
<td>Listed means that these inputs/outputs (attribute: S7_edit := 'param' or S7_edit := 'signal' can be edited in a list in the process object view in SIMATIC Manager without having to open the relevant chart (menu command Options &gt; Process Objects &gt; Select I/Os...).</td>
</tr>
<tr>
<td>Operator control and monitoring:</td>
<td>These are block inputs/outputs intended for operator control and monitoring on the OS (attribute: S7_m_c := 'true').</td>
</tr>
<tr>
<td>Interconnected in CFC chart:</td>
<td>As a practical matter, SFC can only use the inputs/outputs interconnected in CFC for read accesses. If block inputs are write-accessed, these values would be overwritten by the values coming from the CFC interconnection.</td>
</tr>
<tr>
<td>Write access in SFC:</td>
<td>The SFC chart cannot write to one block I/O more than once. These inputs/outputs can therefore be hidden if they have been write-accessed.</td>
</tr>
<tr>
<td><strong>Check Boxes</strong></td>
<td></td>
</tr>
<tr>
<td>Inputs (IN) Outputs (OUT) In/outs (IN_OUT)</td>
<td>If you reset a check box, no inputs/outputs of this I/O type are displayed.</td>
</tr>
<tr>
<td>Suitable I/Os only:</td>
<td>'Suitable I/Os only' means that the assignment for this address must be suitable for the entry for the other address. <strong>Example:</strong> If you have assigned an I/O with data type INT in the first address, only inputs/outputs of data type INT are displayed when you click in the box for the second address. Filtering is performed only when criteria can be explicitly defined; in other words, if an address is a constant, for example, all inputs/outputs are displayed unfiltered and can be selected for the second address.</td>
</tr>
</tbody>
</table>

You can reset all the changed settings using the "Default" button. The default for the list boxes is <all> and all check boxes are activated.
6.4.2.6 How to Access Structures

Introduction

In the step properties, you can configure structure assignments. Structures, substructures or structure elements are possible according to the following syntax:

<table>
<thead>
<tr>
<th>Structure:</th>
<th>&lt;I/O_name&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substructures:</td>
<td>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Substructure&gt;</td>
</tr>
<tr>
<td>Structure element:</td>
<td>&lt;I/O_name&gt;.[&lt;Substructure&gt;...]&lt;Element&gt;</td>
</tr>
</tbody>
</table>

You can enter this information directly in the statement lines or by means of the "Browse" dialog box. In the "Browse" dialog box, you can enter the desired structure in the statement line by double-clicking or by selecting the structure and clicking "Apply" or by selecting the context menu command Apply I/O. You apply substructures or structure elements in the "Structure" dialog box.

In the Transition Properties, it is only possible to compare structure elements.

Note on SFC Types

The use of structures of I/O type IN.OUT is not permitted. Although SFC tolerates the assignment, this is detected as an error when the S7 program is compiled.

Selecting a Structure

1. Select the desired structure in the "Browse" dialog box.
2. In the context menu, select the menu command Open Structure. The "Structure" dialog box opens.
   The name of the structure is specified in the title bar. The table of the dialog box contains the same columns as found in the "I/Os" column of the "Browse" dialog box.
3. Double-click the table line and click "Apply". The substructure, structure, or structure element is entered in the "Properties" dialog box.

Note

Structures and substructures are not entered in the "Properties" dialog of the transition.
Meaning of the Columns in the "Structure" Dialog Box

<table>
<thead>
<tr>
<th>Name</th>
<th>Shows the names of the structure elements of the entire structure, for example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>var01_char</td>
<td></td>
</tr>
<tr>
<td>var04_struct</td>
<td></td>
</tr>
<tr>
<td>var02_bool</td>
<td></td>
</tr>
<tr>
<td>var02_int</td>
<td></td>
</tr>
<tr>
<td>var06_struct</td>
<td></td>
</tr>
<tr>
<td>var03_word</td>
<td></td>
</tr>
<tr>
<td>var03_date</td>
<td></td>
</tr>
<tr>
<td>var01_time</td>
<td></td>
</tr>
</tbody>
</table>

**Data type**
Shows the data type of the structure element (BOOL, DINT or CHAR) or STRUCT for substructures.

**I/O**
Shows the I/O type of the structure element or substructure (IN, OUT, IN_OUT).

**CFC interconnection**
If the structure is interconnected in CFC, this is indicated here by an 'x' (entire column).

**SFC access (writing)**
An existing (write) access by the SFC to a structure element is indicated by an "x".

**Comment**
Shows the comment of the structure element, for example: "1=CPU DPV1 Mode".
6.4.3 Editing Transitions

6.4.3.1 How to Edit the Transition

Opening the "Properties" Dialog of the Transition

1. Double-click the transition to be edited or select the menu command **Edit > Object Properties...**
   The dialog box opens.
2. Edit the properties (name, comment), formulate the conditions and enter the OS comment.

   The dialog box is divided into three tabs:
   - "General"
   - Condition
   - "OS Comment"

"General" Tab

In the "General" tab, you can enter or change the name and comment.

The number was assigned by SFC when the transition was generated and is unique in this sequencer. It is read-only and cannot be modified. The number sequence has no gaps. If a transition is deleted and a new one inserted later, the new transition is given the number of the previously deleted transition.
**"Condition" Tab**

In the "Condition" tab, you can combine 2 x 5 and 2 x 3 conditions using three-stage transition logic to form a Boolean expression.

**"OS Comment" Tab**

In the "OS Comment" tab, you can enter a text for every condition. This text will be displayed on the OS during process control. The text of the condition is entered by default.

**Documenting the Configuration**

You can document the configured conditions of the transition. By clicking "Print" in the Object Properties dialog, you obtain a log of the transition with information about the properties and parameters of the conditions.
Changes to the Configuration

If you change the configuration of a transition (name, comment, condition, OS comment), you can compile changes only (SFC > Compile..., range: Changes menu command) and download them while the CPU is in RUN mode (CPU > Download..., download mode: Changes menu command) without having to first deactivate the active SFC.

You will find more information on editing a transition in the sections:

- How to Formulate the Conditions in a Transition
- How to Edit Addresses in a Transition
- How to Edit OS Comments for a Transition
- How to Copy Object Properties of SFC Elements
6.4.3.2 Formulating the Conditions of a Transition

Introduction
You specify the step control conditions for the selected transition in the "Condition" tab.

Note
Note that an SFC type can only access its own interface and not external objects.

Formulating a Transition
You formulate the transition as a Boolean expression, which can consist of 2 x 5 and 2 x 3 conditions (expression segments). The conditions are combined using three-stage transition logic.

The Boolean operators are designed as buttons. By clicking the operator, you can change it from "AND (\&)" to "OR (=1)". To make a "NAND" from an "AND" and a "NOR" from an "OR", click the output of the operator. The negation is displayed by a bolded dot on the output line.

Alternative Operation: If you position the cursor over an operator, you can right-click to open the context menu, which displays all the available Boolean operators. After you select the menu command, the operator is changed accordingly.

You will find more information on editing a transition in the sections:

- How to Edit Addresses in a Transition
- Valid Data Types
6.4.3.3 How to Edit Addresses in a Transition

Selecting Addresses

You can edit addresses or, as described in the section "How to Edit Addresses in a Step", define them in the "Browse" dialog box. The advantage of browsing is that the addresses are then unique. As a third possibility, you can use a drag-and-drop operation to move the block inputs/outputs from CFC charts directly to the box for the address.

Note

Note that an SFC type can only access its own interface and not external objects.

As when selecting addresses for the steps, you can also enter the value identifiers of the inputs/outputs for the transitions.

If you make the selection by means of the "Browse" dialog box or using a drag-and-drop operation from the CFC chart, the entries are expanded to include the path of the plant hierarchy (if this exists). The hierarchy path and the chart name are separated by double backslashes (\).

Texts with a yellow background reference objects that no longer exist or do not yet actually exist (block inputs/outputs, charts, runtime groups).

This reference is a textual interconnection that you can complete during compiling or explicitly using the Options > Make Textual Interconnection menu command if the interconnection partner actually exists. The textual interconnection is displayed on a yellow background in the line of the address. The same display is used if a former actual interconnection becomes a textual interconnection due to subsequent deletion of the interconnection partner.

Textual interconnections that cannot be made are ignored during compilation. A corresponding warning is entered in the log indicating which inputs/outputs still have a textual interconnection. An unmade textual interconnection is also tolerated in the download.
Notes

- Accesses to CFC blocks can also be modified in the relevant CFC chart. This modification is, however, restricted to "rewiring" SFC accesses; in other words, moving the access to another block I/O (with <Alt> + Drag-and-Drop).

- Access to structures is possible but is restricted to the structure elements. In the "Browse" dialog, you can open the structure by right-clicking the structure and selecting the context menu command Open Structure... and then select the desired structure element.

- Interconnections cannot be set up if the target of the interconnection is not unique; in other words, its name occurs more than once. The interconnection is then displayed as a textual interconnection and cannot be made. Example: The object name of an SFC is the same as the symbolic name of a DB.

- When you enter conditions, they are checked for consistency to ensure the correct syntactic and semantic formulation of the conditions. The program also checks if the data types of the logically combined addresses are compatible.

- The predefined logic is normally sufficient. If you require more complex formulations, you can create them with blocks in a CFC chart and enter the results that were calculated in the chart as the address in the transition conditions.

Going to the Point of Use

If you want to see the point of use of an address, place the cursor in the address box and click "Go To". The corresponding chart opens. If the address is an input or output of a block in the CFC chart, the I/O of the relevant block is selected. You can also move to the point of use by double-clicking on the address.

With shared addresses, you jump to HW Config if the address is known there. Otherwise, an error message is displayed.

The "Go To" function cannot be used for runtime groups.
6.4.3.4 How to Edit OS Comments in a Transition

Entering an OS Comment

In the "OS Comment" tab, you can enter a text for every condition. This text will be displayed on the OS during process control. The text of the condition is entered by default.

You cannot change the Boolean operators in this part of the dialog box; the buttons are only for visualizing the existing logic operations.

If comment lines are labeled with the symbol, the comment is identical to the text of the condition (default).

Notes

- The OS comment for the SFC type and SFC instance can be different. If the SFC type has an I/O that is interconnected in the SFC instance, the interconnection partner is indicated for the instance. If this is an output with multiple interconnections, only one of the interconnections is displayed. If the inputs/outputs are not interconnected, the OS comment of the SFC type and SFC instance are identical.

  Example:

<table>
<thead>
<tr>
<th>Interconnected</th>
<th>SFC Type</th>
<th>SFC Instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN = TRUE</td>
<td>chart\block.io = TRUE</td>
<td></td>
</tr>
<tr>
<td>Not interconnected</td>
<td>RUN = TRUE</td>
<td>chart\sfc_instance.RUN = TRUE</td>
</tr>
</tbody>
</table>

- Provided you do not edit the OS comment, it will be adapted automatically whenever the compare condition is changed. The OS comment is also automatically adapted when the referenced CFC blocks are renamed, copied, moved and deleted.

- If you change the condition and a user-edited comment text is associated with this condition, this comment text is not automatically adapted. In this case, a dialog box appears indicating that you should check the comment text. You can cancel the change in this dialog box by clicking "Cancel".

- You can initialize an individual OS comment in the SFC editor by deleting the OS comment. The text of the compare condition is then used again as the OS comment and from this time onwards is automatically adapted whenever the condition is changed, providing you do not edit the OS comment.

  Alternative Operation: You enter the original OS comment (text of the condition) again using the context menu command Use Default.
You can edit the OS comments later.

The menu command **Options > Edit OS Comments...** opens a dialog box in which you specify how you want to use the OS comment for the transitions:

- Leave unchanged
- Use all conditions

You can also specify how any edits to the OS comments are to apply in this dialog box:

- The entire chart folder
- The current chart
- The selected steps/ transitions
6.4.4 Shared Addresses and Valid Data Types

6.4.4.1 Shared Addresses

Shared Addresses

Shared addresses are connection partners that are outside the CFC/SFC charts. Shared addresses can be read- and write-accessed. Note that the data type of the shared address and of the accessing object (address of a statement or condition in SFC, block I/O in CFC) must match.

You can specify addresses as symbolic or absolute addresses.

6.4.4.2 Absolute Addressing

Rules

The address of a value is used for absolute addressing.

Follow these rules:

- The address must not be located in the area reserved for compiling the CFC chart menu command (Options > Settings for Compilation...).
- The address must not be located in a value range that does not exist for the current CPU.
- The address must be compatible with the data type of the accessing object (address of a statement or condition in SFC, block I/O in CFC). If the case of a peripheral input word (PIW), the first interconnection determines the type.
- The data width must accommodate the address and I/O.

Examples

The following examples illustrate how to specify addresses in absolute form:

<table>
<thead>
<tr>
<th>Address</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>I5.1</td>
<td>Access to input 5.1</td>
</tr>
<tr>
<td>Q5.1</td>
<td>Access to output 5.1</td>
</tr>
<tr>
<td>M6.7</td>
<td>Access to memory bit 6.7</td>
</tr>
<tr>
<td>MW10</td>
<td>Access to memory word 10</td>
</tr>
<tr>
<td>DB10.DW20</td>
<td>Access to data block 10, data word 20</td>
</tr>
<tr>
<td>DB20.DX2.1</td>
<td>Access to data block 20, bit 2.1</td>
</tr>
</tbody>
</table>
6.4.4.3 How to Perform Symbolic Addressing

Symbolic Addressing

With symbolic addressing, you specify the address to be processed as a symbol. Symbols and addresses are assigned in the symbol table. The menu command Options > Symbol Table opens the symbol table where you can add or edit entries.

When you make your entries in the symbol table, remember to adhere to the STEP 7 conventions.

Checking the Syntax

You can use the menu command Chart > Consistency Check to check that all the entries are present in the symbol table before you compile. You can display the log of the consistency check with the menu command Options > Logs....

Examples

Below, you can see several examples of possible entries. The following examples illustrate how addresses can be specified symbolically.

<table>
<thead>
<tr>
<th>Address</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limitswitch</td>
<td>For example access to an input bit. The absolute address is defined in the symbol table.</td>
</tr>
<tr>
<td>Recipe.setpoint</td>
<td>Access to a data block (recipe). The structure or the type of the data block determines the data block element (value).</td>
</tr>
<tr>
<td>DB17.setpoint</td>
<td>As above, but with absolute addressing of the data block</td>
</tr>
<tr>
<td>Recipe.DW5</td>
<td>As above, but with absolute addressing of the data word</td>
</tr>
<tr>
<td>&quot;I5.1&quot;</td>
<td>Access to the symbol with the name I5.1. To avoid the absolute address with the same name being addressed instead of the symbol, the symbol is enclosed in quotation marks.</td>
</tr>
</tbody>
</table>
### 6.4.4.4 Valid Data Types

#### Valid Data Types

The following data types are permitted for formulating actions and conditions in SFC:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Permitted in steps</th>
<th>Permitted in transitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL, BO</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>BYTE, BY</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CHAR, C</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DATE, D</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DINT, DI</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DWORD, DW</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>INT, I</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>REAL, R</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S5TIME, T5</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>STRING, S</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>STRUCT, ST</td>
<td>Yes</td>
<td>Yes *)</td>
</tr>
<tr>
<td>TIME, TI</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TIME OF DAY, T</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>WORD, W</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*) only to structure elements
6.5 Specifying Runtime Properties

6.5.1 Runtime Properties of an SFC

Runtime Properties
The runtime properties of an SFC chart or SFC instance determine how the SFC is included in the chronological execution sequence within the overall structure in the CPU. These properties determine the behavior of the target system with respect to response times, dead times, or the stability of time-dependent structures, such as control loops.

Insertion in the Run Sequence
Each SFC chart is inserted in a run sequence by default. Specifically, it is inserted in a task that corresponds to an organization block (OB) in S7. SFC charts can be inserted in runtime groups and thereby given the attributes of the runtime group (reduction ratio, phase offset).

An SFC type does not have any runtime properties, since it is not relevant to execution of the program. An SFC type cannot be inserted in the run sequence.

You edit the run sequence with the run sequence editor of CFC.

SFC instances are inserted in runtime groups of the associated CFC chart by default.

You will find information on editing the run sequence in the sections:

- How to Edit the Run Sequence
- Runtime Attributes for Runtime Groups and SFC Chart
6.5.2 How to Edit the Run Sequence

Editing the Run Sequence

You can edit the run sequence of SFC charts/SFC instances in several ways. The run sequence includes the insertion position of the SFCs in the tasks and the runtime attributes "reduction ratio" and "phase offset" by means of the attributes of the runtime group.

Changing the Run Sequence

1. Select the icon in the toolbar or select the menu command Edit > Run Sequence. The SFC starts and the "Run Sequence" window opens. If the catalog also opens in SFC, you can close it.
2. Select the task containing the SFC you want to upgrade in the left window.
3. Select the SFC and select the "Cut" function.
4. Select the new position in the run sequence (task or object in the task) and select "Insert". If you have selected a task, the SFC is inserted at the beginning of the task. If you have selected an object within the task, the SFC chart is inserted after the object.

As an alternative to Cut/Paste, you can also use a drag-and-drop operation to move an SFC from an open task to another task.

Inserting an SFC in Other Tasks

Each SFC (chart-instance) must be inserted in at least two tasks:
- In OB 100 for the startup behavior
- In one cyclic interrupt OB (for example, OB 32) for cyclic execution

Note
You cannot insert the same SFC more than once in the same task. Inserting an SFC in several cyclic tasks is not allowed because this can result in unpredictable behavior. No provision is made for insertion of the SFC in other non-cyclic tasks (except in OB 100).

Removing an SFC from a Task

Select the SFC in the task and delete it by selecting the menu command Delete or by pressing the <Del> key. The SFC is deleted from the task following a prompt for confirmation.

You will find more information in the section "Runtime Attributes for Runtime Groups and SFCs"
6.5.3 Runtime Attributes for Runtime Groups and SFCs

Introduction
You can insert SFCs in runtime groups if they have the "reduction ratio" and/or "phase offset" attributes. You set the attributes in the object properties of the runtime group. All charts of the runtime group then have the same "reduction ratio" and "phase offset".

Inserting and Editing a Runtime Group
You can generate a runtime group in the run sequence editor as follows:

1. Select the menu command Edit > Run Sequence… or click the icon.
2. Select the insertion position in the run sequence.
3. Select the menu command Insert > Runtime Group….
4. You can enter the name and any desired comment in the "Insert Runtime Group" dialog box. You can also change the default setting of the runtime attributes for the reduction ratio and phase offset here (see information below).
5. Click "OK".

If you want to change the runtime attributes later, select the runtime group in the window of the run sequence and select the menu command Edit > Object Properties.

Note
SFCs can run in different cyclic tasks when they are inserted in runtime groups. From a technological point of view, this enables you to structure the project better, which will result in considerably better performance when configuration changes are made (including reducing the time needed for compilation).

Enable Attribute of the SFC Chart
The Enable attribute (EN) enables (EN=1) or disables (EN=0) the execution of the SFC chart. As long as EN is set to 0, the SFC chart will not be processed regardless of any other conditions.

You can make the enable attribute dynamic. In this case, the value of a block output or the statement of a step decides whether or not the SFC chart is processed.
Runtime Attributes of the Runtime Group

You can also use the enable attribute to enable and disable a runtime group, same as an SFC chart.

You cannot assign the following attributes to an SFC chart directly; they are assigned by inserting them into a runtime group:

- Reduction Ratio
- Phase Offset

The SFC receives the attributes set for this runtime group.

An SFC that is not inserted in a runtime group has the following defaults:

- "Reduction ratio = 1"
- "Phase offset = 0"

If you want SFCs in a CPU to run with different runtime attributes, you must insert these charts in different runtime groups.

- Reduction Ratio

The reduction ratio specifies whether the SFC chart is processed each time the task is executed or only every n\textsuperscript{th} time the task is executed. "n" is an integer ($n = 2^t$, where $0 \leq t \leq 15$). The increments are a multiple of the basic cycle clock of the task.

**Example:**
Basic cycle of a cyclic interrupt (OB 33): 500 ms
Possible clock cycles with reduction ratio: 1 s, 2 s, 4 s, 8 s, 16 s, etc.

If a chart is not installed in a runtime group, the number 1 is preset; in other words, the SFC chart is processed in each run (every 500 ms).
• Phase Offset

Phase offset allows a uniform distribution of load within the CPU. It must be considered in conjunction with "n", the reduction ratio. The SFC chart is processed as often as specified by "n", offset in each case by "m" units of the task cycle. "m" is an integer, where \(0 \leq m \leq (n-1)\).

**Example:**
Basic cycle of a cyclic interrupt: 500 ms
Reduction ratio: 16 (i.e., the SFC chart is processed every 8 s)
phase offset: 3. The SFC chart is thus processed after 1.5 s; 9.5 s; 17.5 s, etc.

If a chart is not installed in a runtime group, the number 0 is preset; in other words, the SFC chart is processed without phase offset.

---

**Note**
You should only use reduction ratio and phase offset in the tasks that are executed in defined cycles; in other words, in (cyclic) interrupt tasks. In all other tasks you should use extreme caution, particularly in process interrupt tasks and special tasks. Here, you should not change the default reduction ratio=1 and phase offset=0.
6.6 Standard Interface and Chart Inputs/Outputs

6.6.1 Inputs/Outputs of the SFC Chart Standard Interface

Standard Interface of the SFC Chart

The standard interface of the SFC chart includes the necessary inputs/outputs for controlling the SFC chart from the user program or by means of operator control and monitoring.

For more information on the I/Os, refer to the following sections:

- Standard Interface of the SFC Chart
- Inputs/Outputs of the SFC Chart Sorted by Usage
### 6.6.1.1 Standard Interface of the SFC Chart

**Standard Interface of the SFC Chart**

The following table lists the inputs/outputs of the standard interface for the SFC chart in alphabetical order.

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABORT</td>
<td>&quot;Abort&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ABORTED</td>
<td>&quot;Aborted&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABORTING</td>
<td>&quot;Aborting&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Change to AUTO (Process mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>BA_ADDSTATE</td>
<td>BATCH: Additional status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q +</td>
<td></td>
</tr>
<tr>
<td>BA_ID</td>
<td>BATCH: Batch serial number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q +</td>
<td></td>
</tr>
<tr>
<td>BA_NA</td>
<td>BATCH: Batch ID</td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td>I</td>
<td>Q +</td>
<td></td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>BUSY</td>
<td>Status &quot;Busy&quot; (= neither &quot;Idle&quot; nor &quot;Completed&quot; nor &quot;Aborted&quot; nor &quot;Stopped&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPLETE</td>
<td>&quot;Complete&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>COMPLETED</td>
<td>&quot;Completed&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPLETING</td>
<td>&quot;Completing&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONT</td>
<td>Continuous Mode</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>CPU_RESTART</td>
<td>Restart of the CPU</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSEQ</td>
<td>No. of current sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>CUSTEP</td>
<td>No. of current step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPACTSTATE</td>
<td>Active state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPCOUNT</td>
<td>Number of active steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPERRSTATE</td>
<td>Error state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPHELDSTATE</td>
<td>Held state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPMAXRT</td>
<td>Max. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPMINRT</td>
<td>Min. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPRT</td>
<td>Run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUTRANS</td>
<td>Number of the current transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUTRANSCOUNT</td>
<td>Number of active transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUTRANSRESULT</td>
<td>Result of first active transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CYCLEXEC</td>
<td>Cyclic execution (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>1</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>DIS_START_STATE</td>
<td>Reason for start disturbance</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Active&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENCOMPLETE</td>
<td>Enable &quot;Complete&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>I/O</td>
<td>Meaning</td>
<td>Data type</td>
<td>Default</td>
<td>Type</td>
<td>Attr.</td>
<td>OCM</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENRESET</td>
<td>Enable &quot;Reset&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENRESTART</td>
<td>Enable &quot;Restart&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENRESUME</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENRESET</td>
<td>Enable &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENRESTART</td>
<td>Enable &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENRESUME</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ERRG</td>
<td>Group error (EXT_ERR</td>
<td>OP_ERR</td>
<td>LI_ERR</td>
<td>S_ERRG)</td>
<td>BOOL</td>
<td>0</td>
</tr>
<tr>
<td>ERROR</td>
<td>&quot;Error&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ERROR_COMPLETING</td>
<td>&quot;Error (Completing)&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXEC_ERR</td>
<td>Runtime error, e.g., step error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>HELD</td>
<td>&quot;Held&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELD_ERROR</td>
<td>&quot;Held (Error)&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSEQ</td>
<td>No. of held sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>HELDSTEP</td>
<td>No. of held step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSTEPCOUNT</td>
<td>Number of held steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSTEPERRSTATE</td>
<td>Error status of held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSTEPHELDSTATE</td>
<td>State of the held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDTMSTEP</td>
<td>Run time of the held step (ms)</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDTMTRANS</td>
<td>Number of the held transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDTMTRANSCOUNT</td>
<td>Number of held transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDTRANSRESULT</td>
<td>Result of first held transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HOLD</td>
<td>&quot;Hold&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>HOLDING</td>
<td>&quot;Holding&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IDLE</td>
<td>&quot;Idle&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INSTABORT</td>
<td>Instruction output (only in AUTO)</td>
<td>BOOL</td>
<td>1</td>
<td>2</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>INTCOMplete</td>
<td>Internal command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTERROr</td>
<td>Internal command &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT HOLD</td>
<td>Internal command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT ON OFF</td>
<td>Internal command &quot;Switch SFC on/off&quot;: 0: Switch off, 1: Switch on</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT RESEt</td>
<td>Internal command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT RESTART</td>
<td>Internal command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT RESUME</td>
<td>Internal command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT START</td>
<td>Internal command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT STOP</td>
<td>Internal command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IO RES 1..6</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IO RES 1..5</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAST SEQ</td>
<td>No. of the last active sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAST STEP</td>
<td>No. of the last active step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configuring Sequential Control Systems

#### SFC for SIMATIC S7

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>LI_ERR</td>
<td>Parameter assignment error (e.g. invalid combination at inputs)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LI_ERR_STATE</td>
<td>Status word for parameter error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>LOCKABORT</td>
<td>External interlock &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKCOMPLETE</td>
<td>External interlock &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKERROR</td>
<td>External interlock &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKHOLD</td>
<td>External interlock &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKSTOP</td>
<td>External interlock &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>MAN</td>
<td>Change to MAN (operator control mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>MODE</td>
<td>Processing mode:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_EVID</td>
<td>Message number (ALARM_8P)</td>
<td>DWORD</td>
<td>2</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>MSG_LOCK</td>
<td>Lock messages:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>MSG_SUP</td>
<td>Message suppression (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID</td>
<td>Message number (NOTIFY)</td>
<td>DWORD</td>
<td>1</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>OCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; ID</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>OP_ERR</td>
<td>Operator error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OP_ERR_STATE</td>
<td>Status word for operator error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>ORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES1_15</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>Operating mode: 0: MAN, 1: AUTO</td>
<td>BOOL</td>
<td>0</td>
<td>4)</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QBA_ID</td>
<td>BATCH: Batch serial number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QBA_NA</td>
<td>BATCH: Batch ID</td>
<td>STRING</td>
<td>''</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g. LI_ERR, OP_ERR, etc.)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QEMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QEXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QFORCEMAN</td>
<td>Changeover to MAN without enable (= forced manual, 1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QOCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCC</td>
<td>Step enabling with operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCCT</td>
<td>Step enabling with transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCCTAC</td>
<td>Step enabling with transition and Confirmation by operator</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCTOC</td>
<td>Step enabling with transition or operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O</td>
<td>Meaning</td>
<td>Data type</td>
<td>Default</td>
<td>Type</td>
<td>Attr.</td>
<td>OCM</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>READY_TC</td>
<td>&quot;Ready to complete&quot; state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>&quot;Reset&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESTART</td>
<td>&quot;Restart&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESU_ERROR</td>
<td>&quot;Resuming (Error)&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESUME</td>
<td>&quot;Resume&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESUMING</td>
<td>&quot;Resuming&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>&quot;Active&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUNCOUNT</td>
<td>Number of runs in &quot;cyclic execution&quot;</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUNHOLD</td>
<td>Response of the RUN sequencer to the &quot;Hold&quot; Command: 0: Hold sequencer, 1: Abort sequencer</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>S_ERRCA</td>
<td>Confirm all step errors (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>S_ERRG</td>
<td>Group display &quot;Step error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCT</td>
<td>Step enabling with transition (only in AUTO)</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Active&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes automatically from &quot;Completed/Aborted/Stopped&quot; to &quot;Idle&quot; (only in MAN)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SFC_ADDSTATE</td>
<td>Additional SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SFC_CONTROL</td>
<td>SFC control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SFC_INIT</td>
<td>Initialize SFC</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFC_STATE</td>
<td>SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SIG_2...8</td>
<td>Generate message 2...8 (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>&quot;Start&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>&quot;Starting&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>STOP</td>
<td>&quot;Stop&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STOPPED</td>
<td>&quot;Stopped&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STOPPING</td>
<td>&quot;Stopping&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T_OPRQCA</td>
<td>Confirmation of all operator prompts (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>T_OPRQG</td>
<td>Group display &quot;Operator prompt at transition&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TARGETSEQ</td>
<td>Sequencer number for &quot;Set target step&quot;</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TARGETSTEP</td>
<td>Step number for &quot;Set target step&quot;</td>
<td>WORD</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIMEMON</td>
<td>Time monitoring (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>3)</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>TRIG_CPU_RESTART</td>
<td>Start trigger for sequencer after CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.6.1.2 Meanings in the Table

Explanations of the Table

- In the "I/O" column, text in **bold print** signifies that the attribute S7_visible = 'true' is set. The I/O is visible.
- The following abbreviations are used in the "Type" column
  - I = IN (input)
  - IO = INOUT (in/out)
  - O = OUT (output)
- The following abbreviations are used in the "Attr." column
  - "Q" means that attribute S7_link = 'true' is set. The I/O is interconnectable.
  - "M" means that this is a MESSAGE ID for a message block (e.g., ALARM_8P). Parameters cannot be assigned for the I/O; the ID is assigned by the message server.
  - "B" means operator controllable (only via a faceplate). Write access is allowed to the I/O from the OS.
  - . Hidden in the CFC.
- In the "OCM" column, "+" means that attribute S7_m_c = 'true' is set. The I/O can be controlled and monitored by the operator.

You can find the meanings of the individual system attributes in "Help on STEP 7" under the topic
- "System Attributes for Block I/Os"
6.6.1.3 Inputs/Outputs of the SFC Chart Sorted According to Usage

Inputs/Outputs of SFC Chart

The inputs/outputs of the standard interface for the SFC chart are sorted according to their use and summarized in the following sections:

- Operating Modes
- Commands and Operating States
- Execution Options
- Group Displays + Group Acknowledgements
- Data from Sequences and Steps to be Processed
- BATCH Parameters
- Continuous Mode
- Error Handling
- Messages
- Control Words
- Status Words
- System Parameters
- Reserves
6.6.2 Standard Interface of the SFC Type

Standard Interface of the SFC Type

The standard interface of the SFC type includes the necessary inputs/outputs for the user program for controlling the SFC instances via the user program or for operator control and monitoring of the SFC instances.

Additional Information

You can find additional information about the inputs/outputs in the following sections:

- SFC Type: Standard-Interface
- Inputs/Outputs of an SFC Type Sorted by Usage
- "Characteristics" Interface Parameter Assignments
- "Characteristics" Interface Expansions
- Changing the Control Strategy and Setpoints for an SFC Instance
- "Inputs/Outputs" Interface Expansions
### 6.6.2.1 Inputs/Outputs of the SFC Type Standard Interface

**SFC Type: Inputs/Outputs of the Standard Interface**

The following table lists the inputs/outputs of the standard interface of the SFC type in alphabetical order.

For explanations of the table entries, refer to the section "Meanings in the Table".

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABORT</td>
<td>&quot;Abort&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ABORTED</td>
<td>&quot;Aborted&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABORTING</td>
<td>&quot;Aborting&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>Q</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Change to AUTO (Process mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>AUX_PRO4..10</td>
<td>Associated value 4..10</td>
<td>ANY</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>BA_ADDSTATE</td>
<td>BATCH: Additional status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BA_CONTROL</td>
<td>BATCH control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>BA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>1</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>BA_ID</td>
<td>BATCH: Batch serial number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>BATCH: Batch ID</td>
<td>STRING</td>
<td>' '</td>
<td>Q</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BUSY</td>
<td>Status &quot;Busy&quot; (= neither &quot;Idle&quot; nor &quot;Completed&quot; nor &quot;Aborted&quot; nor &quot;Stopped&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPLETE</td>
<td>&quot;Complete&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>COMPLETED</td>
<td>&quot;Completed&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPLETING</td>
<td>&quot;Completing&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>CONT</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>CONT_T</td>
<td>Max. run time for &quot;Continuous mode&quot; [ms]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU_RESTART</td>
<td>Restart of the CPU</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CS</td>
<td>AUTO: Prepared control strategy (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>CS_HL</td>
<td>Control strategy &quot;high limit&quot;</td>
<td>INT</td>
<td>0</td>
<td>1)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CS_LL</td>
<td>Control strategy &quot;low limit&quot;</td>
<td>INT</td>
<td>0</td>
<td>1)</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>CSP_DEFAULT</td>
<td>Initial value of the prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>CSP_OP</td>
<td>MANUAL: Prepared control strategy by operator (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>CSSPACCEPT</td>
<td>Control strategy+ setpoints applied (1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSEQ</td>
<td>No. of current sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>CUSTEP</td>
<td>No. of current step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPACTSTATE</td>
<td>Active state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPDEFAULT</td>
<td>Number of active steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPERRSTATE</td>
<td>Error state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configuring Sequential Control Systems

#### Table: Configuring Sequential Control Systems

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSTEPMAXRT</td>
<td>Max. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPMINRT</td>
<td>Min. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTEPRRT</td>
<td>Run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUTRANTRANS</td>
<td>Number of the current transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUTRANSCOUNT</td>
<td>Number of active transitions</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUTRANSRESULT</td>
<td>Result of first active transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CYCLEEXEC</td>
<td>Cyclic execution (only in AUTO)</td>
<td>BOOL</td>
<td>0 2</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>DIS_START_STATE</td>
<td>Reason for start disturbance</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Active&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENCOMPLETE</td>
<td>Enable &quot;Complete&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENCSP</td>
<td>Enable for &quot;prepare control strategy&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>ENFORCEMAN</td>
<td>Enable change to MAN if ENMAN = 0</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENRESTART</td>
<td>Enable &quot;Restart&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENRESUME</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ERRG</td>
<td>Group error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXEC_ERR</td>
<td>Runtime error, e.g., step error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXIST_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>HELD</td>
<td>&quot;Held&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDERROR</td>
<td>&quot;Held (Error)&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSEQ</td>
<td>No. of held sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>HELDSTEP</td>
<td>No. of held step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSTEPSERSTATE</td>
<td>Error status of held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSTEPHELDSTATE</td>
<td>State of the held step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDSTEPRT</td>
<td>Run time of the held step (ms)</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDTRANS</td>
<td>Number of the held transition</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELDTRANSRESULT</td>
<td>Result of first held transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HOLD</td>
<td>&quot;Hold&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>HOLDING</td>
<td>&quot;Holding&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IDLE</td>
<td>&quot;Idle&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INSTROUT</td>
<td>Instruction output (only in AUTO)</td>
<td>BOOL</td>
<td>1 3</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
</tbody>
</table>
### Configuring Sequential Control Systems

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTABORT</td>
<td>Internal command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTCOMPLETE</td>
<td>Internal command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTERERROR</td>
<td>Internal command &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTHOLD</td>
<td>Internal command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTRESET</td>
<td>Internal command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTRESTART</td>
<td>Internal command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTRESUME</td>
<td>Internal command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTSTART</td>
<td>Internal command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTSTOP</td>
<td>Internal command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES0..7</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IRES1..3</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LASTSEQ</td>
<td>No. of the last active sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LASTSTEP</td>
<td>No. of the last active step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LI_ERR</td>
<td>Parameter assignment error (e.g. invalid combination at inputs)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LI_ERR_STATE</td>
<td>Status word for parameter error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>LOCKABORT</td>
<td>External interlock &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKCOMPLETE</td>
<td>External interlock &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKERROR</td>
<td>External interlock &quot;Error&quot;</td>
<td>BOO</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKHOLD</td>
<td>External interlock &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>LOCKSTOP</td>
<td>External interlock &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>MAN</td>
<td>Change to MAN (operator control mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>MODE</td>
<td>Processing mode:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: Cyclic processing in cyclic interrupt OB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: One-time processing in startup OB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_ACK</td>
<td>Acknowledge messages (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_ERR</td>
<td>Message error (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_EVID</td>
<td>Message number (ALARM_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>MSG_LOCK</td>
<td>Lock messages:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>0: Messages not locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: Messages locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_STAT</td>
<td>Message status (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_SUP</td>
<td>Message suppression (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID1</td>
<td>Message number 1 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID2</td>
<td>Message number 2 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT1</td>
<td>Message status 1 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT2</td>
<td>Message status 2 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NSIG_12..16</td>
<td>Generate event message 12..16 (NOTIFY_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>OCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>OP_ERR</td>
<td>Operator error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OP_ERR_STATE</td>
<td>Status word for operator error</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>OPTIPNO</td>
<td>Information number for operator</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>ORES_BY1..3</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES1..24</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Configuring Sequential Control Systems

### SFC for SIMATIC S7

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARAM</td>
<td>Check control strategy + setpoints</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>POSINO</td>
<td>Position text number</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>Operating mode: 0: MAN, 1: AUTO</td>
<td>BOOL</td>
<td>0</td>
<td>5)</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QBA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QBA_ID</td>
<td>BATCH: Batch serial number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QBA_NA</td>
<td>BATCH: Batch ID</td>
<td>STRING[3]</td>
<td></td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCONT</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCONT_T</td>
<td>Current run time for &quot;Continuous mode&quot; [ms]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCONT_T_ERR</td>
<td>Max. run time for &quot;Continuous mode&quot; exceeded</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCS</td>
<td>Current control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>QCS_0</td>
<td>1: No control strategy</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCS_1...32</td>
<td>1: Current control strategy 1 - 32</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCSP</td>
<td>Prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g., faulty control strategy and/or setpoints, LI_ERR, OP_ERR, etc.)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QENMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QEXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QFORCETRAN</td>
<td>Changeover to MAN without enable (=forced manual, 1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCACOUPLED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QPARAM</td>
<td>Control strategy + setpoints were checked and are ok</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QREFRESH</td>
<td>BATCH: Read in setpoint/process values again</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCC</td>
<td>Step enabling with operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QST</td>
<td>Step enabling with transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QST_T</td>
<td>Step enabling with transition and step-specific operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QST_TAC</td>
<td>Step enabling with transition and operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTOC</td>
<td>Step enabling with transition or operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTEP_T</td>
<td>BATCH: Current step run time [ms]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>QTAKESP</td>
<td>Adopt setpoints immediately</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>READY_TC</td>
<td>&quot;Ready to complete&quot; state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REFRESH</td>
<td>BATCH: Read in setpoint/process values again</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>&quot;Reset&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESTART</td>
<td>&quot;Restart&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESU_ERROR</td>
<td>&quot;Resuming (Error)&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESUME</td>
<td>&quot;Resume&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESUMING</td>
<td>&quot;Resuming&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O</td>
<td>Meaning</td>
<td>Data type</td>
<td>Default</td>
<td>Type</td>
<td>Attr.</td>
<td>OCM</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>RUN</td>
<td>&quot;Active&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>RUNCOUNT</td>
<td>Number of runs in &quot;cyclic execution&quot;</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUNHOLD</td>
<td>Response of the RUN Sequencer to the &quot;Hold&quot; 0: Hold sequencer, 1: Abort sequencer</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RUNUPCYC</td>
<td>Number of run-up cycles</td>
<td>INT</td>
<td>3</td>
<td>I</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>S_ERRCA</td>
<td>Confirm all step errors (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>S_ERRG</td>
<td>Group display &quot;Step error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>SCT</td>
<td>Step enabling with transition (only in AUTO)</td>
<td>BOOL</td>
<td>1</td>
<td>6)</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>SCT_TAC</td>
<td>Step enabling with transition or step-specific operator confirmation (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>6)</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>SELCS</td>
<td>Enable control strategies: Bit 0..31: Control strategy 1..32</td>
<td>DWORD</td>
<td>0 1 7)</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Active&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes independently from &quot;Finished/Canceled/Stopped&quot; to &quot;Ready&quot; (only with MANUAL)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SFC_ADDSTATE</td>
<td>Additional SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SFC_CONTROL</td>
<td>SFC control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SFC_INIT</td>
<td>Initialize SFC</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFC_STATE</td>
<td>SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SIG_2_8</td>
<td>Generate message 2..8 (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>&quot;Start&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>&quot;Starting&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>STEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>STEP_T</td>
<td>BATCH: Max. step run time [ms]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>STOP</td>
<td>&quot;Stop&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STOPPED</td>
<td>&quot;Stopped&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>STOPPING</td>
<td>&quot;Stopping&quot; operating state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>T_OPRQCA</td>
<td>Confirmation of all operator prompts (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>T_OPRQG</td>
<td>Group display &quot;Operator prompt at transition&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>TAKESP</td>
<td>Adopt setpoints immediately</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>TARGETSEQ</td>
<td>Sequencer number for &quot;Set target step&quot;</td>
<td>BYTE</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TARGETSTEP</td>
<td>Step number for &quot;Set target step&quot;</td>
<td>WORD</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIMEMON</td>
<td>Time monitoring (only in AUTO)</td>
<td>BOOL</td>
<td>0 4)</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>TRIG_CPU_RESTART</td>
<td>Start trigger for sequencer after CPU restart</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>USTATUS</td>
<td>Status word in VSTATUS (can be used freely by user)</td>
<td>WORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>VSTATUS</td>
<td>Status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>
### Key

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Depends on the number of control strategies in the characteristics editor</td>
</tr>
<tr>
<td>2</td>
<td>Depends on &quot;SFC Properties/Operating Parameters CPU/Cyclic Execution&quot;</td>
</tr>
<tr>
<td>3</td>
<td>Depends on &quot;SFC Properties/Operating Parameters CPU/Instruction Output&quot;</td>
</tr>
<tr>
<td>4</td>
<td>Depends on &quot;SFC Properties/Operating Parameters CPU/Time Monitoring&quot;</td>
</tr>
<tr>
<td>5</td>
<td>Depends on &quot;SFC Properties/Operating Parameters CPU/Operating Mode&quot;</td>
</tr>
<tr>
<td>6</td>
<td>Depends on &quot;SFC Properties/Operating Parameters CPU/Step Control Mod&quot;</td>
</tr>
<tr>
<td>7</td>
<td>Depends on &quot;SFC Properties/Options/Control Strategy Selection&quot;</td>
</tr>
</tbody>
</table>
6.6.2.2 Inputs/Outputs of the SFC Type Sorted According to Usage

The inputs/outputs of the standard interface for the SFC type are sorted according to their use and summarized in the following sections:

- Operating Modes (SFC Inputs/Outputs)
- Commands and Operating States (SFC Inputs/Outputs)
- Execution Options SFC Inputs/Outputs)
- Group Displays and Group Acknowledgements (SFC Inputs/Outputs)
- Data from Sequencers and Steps to be Processed)
- BATCH Parameters (SFC Inputs/Outputs)
- Continuous operation (SFC connections)
- Error Handling (SFC Inputs/Outputs)
- Messages (SFC Inputs/Outputs)
- Control Words (SFC Inputs/Outputs)
- Status Words (SFC Inputs/Outputs
- System Parameters (SFC Inputs/Outputs)
- Reserves (SFC Inputs/Outputs)

6.6.2.3 "Inputs/Outputs" Interface Expansions

Valid Inputs/Outputs

The "Inputs/Outputs" interface editor is available for interface expansions. The following data types are permitted for the inputs/outputs in the IN, OUT and IN_OUT sections:

**INPUT** (IN section):

- BOOL, BYTE, CHAR, WORD, DWORD, INT, DINT, REAL, S5TIME, TIME,
- DATE,
- TIME_OF_DAY, STRING

**OUTPUT** (OUT section):

- BOOL, BYTE, CHAR, WORD, DWORD, INT, DINT, REAL, S5TIME, TIME,
- DATE,
- TIME_OF_DAY, STRING

**IN_OUT** (IN_OUT section):

- BOOL, BYTE, CHAR, WORD, DWORD, INT, DINT, REAL, S5TIME, TIME,
- DATE,
- TIME_OF_DAY, STRING
6.6.3 "Characteristics" Interface Parameter Assignments

"Characteristics" Interface Parameter Assignments

Characteristics are only relevant for the SFC type.

The inputs/outputs of the following characteristics are contained in the standard interface:

- Control strategies
- Note texts
- Position texts

6.6.3.1 "Control Strategies" Characteristic

"Control Strategies" Characteristic

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS</td>
<td>AUTO: Prepared control strategy (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>CS_LL</td>
<td>Control strategy &quot;low limit&quot;</td>
<td>INT</td>
<td>0</td>
<td>1) I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CS_HL</td>
<td>Control strategy &quot;high limit&quot;</td>
<td>INT</td>
<td>0</td>
<td>1) I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSP_DEFAULT</td>
<td>Initial value of the prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>CSP_OP</td>
<td>MANUAL: Prepared control strategy by operator (apply at next &quot;Start&quot;)</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>CSSP_ACCEPT</td>
<td>Control strategy and setpoints applied (1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENCSP</td>
<td>Enable for &quot;prepared control strategy&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>QCS</td>
<td>Current control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>QCS_0</td>
<td>1: No control strategy</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCS_1...32</td>
<td>1: Current control strategy 1 - 32</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCSP</td>
<td>Prepared control strategy</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>SELCS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0</td>
<td>1) I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Bit 0..31: Control strategy 1..32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "SFC Properties/Options/Control Strategy Selection"

For more information, refer to the section:
Changing the Control Strategy and Setpoints for an SFC Instance
6.6.3.2 Characteristic for Note Texts

Characteristic for Note Texts

Using the assignment of a note text number in a step action, the corresponding note text is displayed in the SFC faceplate.

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPTIPNO</td>
<td>Note text number for operator</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

6.6.3.3 Characteristic for Position Texts

Characteristic for Position Texts

When a position text number is assigned in a step action, the corresponding position text is displayed in the SFC faceplate.

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>POSINO</td>
<td>Position text number</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

For more information, refer to the section: How to Configure Note Texts and Position Texts
6.6.4 "Characteristics" Interface Expansions

"Characteristics" Interface Expansions

Characteristics are only relevant for the SFC type.

The inputs/outputs for the following characteristics are not included in the standard interface but can be configured as needed:

- Setpoints
- Process values
- Control values
- Parameters
- Bit memory
- Timers
- Block Contacts

---

Note

In the following tables of characteristics, "name" stands for "I/O name". It is not the name of a characteristic.
6.6.4.1 "Setpoints" Characteristic

"Setpoints" Characteristic

For more detailed information about the inputs/outputs for setpoints, refer to the section [Meaning and Usage of Inputs/Outputs for Setpoints](#).

For explanations of the table entries, refer to the section [Meanings in the Table](#).

"BOOL" Data Type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0</td>
<td>1)</td>
<td>2)</td>
<td>IO</td>
</tr>
<tr>
<td>&quot;name&quot;_EN0OP</td>
<td>Enable operator control of setpoint on &quot;0&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN1OP</td>
<td>Enable operator control of setpoint on &quot;1&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN0OPP</td>
<td>Enable operator control of prepared setpoint on &quot;0&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_EN1OPP</td>
<td>Enable operator control of prepared setpoint on &quot;1&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<setpoint>/properties/control strategy assignment"
"INT" Data Type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0 1) 2)</td>
<td>IO</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Bit0..31 = control strategy 1..32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>setpoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_LL</td>
<td>Low limit setpoint</td>
<td>INT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>High limit setpoint</td>
<td>INT</td>
<td>100</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>INT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

1) Depends on the number of control strategies in the characteristics editor

2) Depends on "<setpoint>/properties/control strategy assignment"
### "DINT", "SOURCE", "DEST" and "VIA" Data Types

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0 1) 2)</td>
<td>IO</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>High limit setpoint</td>
<td>DINT</td>
<td>DINT: 100, SOURCE, DEST, VIA: 2147483647</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_LL</td>
<td>Low limit setpoint</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

### Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<setpoint>/properties/control strategy assignment"
"REAL" Data Type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0</td>
<td>1)</td>
<td>2)</td>
<td>IO</td>
</tr>
<tr>
<td></td>
<td>Bit0..31 = control strategy 1..32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>High limit setpoint</td>
<td>REAL</td>
<td>100.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_LL</td>
<td>Low limit setpoint</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<setpoint>/properties/control strategy assignment"
"STRING" Data Type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>STRING</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>STRING</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>STRING</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies:</td>
<td>DWORD</td>
<td>0 1)</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bit0..31 = control strategy 1..32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>STRING</td>
<td>&quot;</td>
<td>O *)</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>STRING</td>
<td>&quot;</td>
<td>O *)</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>STRING</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>STRING</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

Key

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<setpoint>/properties/control strategy assignment"
*) The parameters are implemented as outputs because no IN_OUT parameters are permitted with the "STRING" data type!
### "PI" Data Type (Process Input = Parameter for Input Materials)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AI</td>
<td>Process value input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_AO</td>
<td>Process value output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_B</td>
<td>Setpoint tracking ID</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BAI</td>
<td>BATCH process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BAO</td>
<td>BATCH process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BOP</td>
<td>BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BOPP</td>
<td>Prepared BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BQ</td>
<td>BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_BQP</td>
<td>Prepared BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_CS</td>
<td>Enable control strategies: Bit0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0</td>
<td>1) 2)</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_HL</td>
<td>High limit setpoint</td>
<td>REAL</td>
<td>100.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_LL</td>
<td>Low limit setpoint</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_M</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MAI</td>
<td>&quot;Material&quot; process value input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MAO</td>
<td>&quot;Material&quot; process value output</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MOP</td>
<td>&quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MOPP</td>
<td>Prepared &quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MQ</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_MQP</td>
<td>Prepared &quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OP</td>
<td>Setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_OPP</td>
<td>Prepared setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_Q</td>
<td>Setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;_QP</td>
<td>Prepared setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<setpoint>/properties/control strategy assignment"
"PO" data type (Process Output = Parameter for Main Products, By-Products, and Waste Products)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>name</em></td>
<td>Setpoint automatic input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AI</td>
<td>Process value input</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_AO</td>
<td>Process value output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_B</td>
<td>Setpoint tracking ID</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BAI</td>
<td>BATCH process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BAO</td>
<td>BATCH process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BAI</td>
<td>BATCH operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BAO</td>
<td>BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_BQ</td>
<td>BATCH setpoint</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_CS</td>
<td>Enable control strategies: Bit0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0</td>
<td>1) 2)</td>
<td>IO</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ENOP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>name</em>_LL</td>
<td>Low limit setpoint</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_HL</td>
<td>High limit setpoint</td>
<td>REAL</td>
<td>100.0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_M</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MAI</td>
<td>&quot;Material&quot; process value input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MAO</td>
<td>&quot;Material&quot; process value output</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MOP</td>
<td>&quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MOPP</td>
<td>Prepared &quot;Material&quot; operator input</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MQ</td>
<td>&quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_MQP</td>
<td>Prepared &quot;Material&quot; setpoint</td>
<td>STRING[16]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OP</td>
<td>Setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_OPP</td>
<td>Prepared setpoint operator input</td>
<td>REAL</td>
<td>0.0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_Q</td>
<td>Setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td><em>name</em>_QP</td>
<td>Prepared setpoint output</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

1) Depends on the number of control strategies in the characteristics editor
2) Depends on "<setpoint>/properties/control strategy assignment"
### "TKEY" Data Type

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Setpoint automatic input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.AI</td>
<td>Process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.AO</td>
<td>Process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.CS</td>
<td>Enable control strategies: Bit0..31 = control strategy 1..32</td>
<td>DWORD</td>
<td>0 1 2</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;.ENOP</td>
<td>Enable operator control of setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.ENOPP</td>
<td>Enable operator control of prepared setpoint</td>
<td>BOOL</td>
<td>1</td>
<td>IO</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.ERR</td>
<td>Setpoint error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;.LL</td>
<td>Low limit setpoint</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.HL</td>
<td>High limit setpoint</td>
<td>DINT</td>
<td>DINT: 100, SOURCE, DEST, VIA: 2147483647</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.OP</td>
<td>Setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.OPP</td>
<td>Prepared setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.Q</td>
<td>Setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.QP</td>
<td>Prepared setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.ID</td>
<td>Transfer ID&quot; automatic input</td>
<td>STRING[16]</td>
<td>*</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.IDAI</td>
<td>Transfer ID&quot; process value input</td>
<td>STRING[16]</td>
<td>*</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.IDAQ</td>
<td>Transfer ID&quot; process value output</td>
<td>STRING[16]</td>
<td>*</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.IDQ</td>
<td>Transfer ID&quot; setpoint output</td>
<td>STRING[16]</td>
<td>*</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.IDQP</td>
<td>Transfer ID&quot; prepared setpoint output</td>
<td>STRING[16]</td>
<td>*</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.IDOP</td>
<td>Prepared setpoint operator input</td>
<td>STRING[16]</td>
<td>*</td>
<td>O</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.IDOPP</td>
<td>Prepared setpoint operator input</td>
<td>STRING[16]</td>
<td>*</td>
<td>O</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.C</td>
<td>Transfer COUNTER&quot; automatic input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.CAI</td>
<td>Transfer COUNTER&quot; process value input</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.CAO</td>
<td>Transfer COUNTER&quot; process value output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.CQ</td>
<td>Transfer COUNTER&quot; setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.CQP</td>
<td>Transfer COUNTER&quot; prepared setpoint output</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.COP</td>
<td>Setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
<tr>
<td>&quot;name&quot;.COPP</td>
<td>Prepared setpoint operator input</td>
<td>DINT</td>
<td>0</td>
<td>IO</td>
<td>C</td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

1. Depends on the number of control strategies in the characteristics editor
2. Depends on "<setpoint>/properties/control strategy assignment"
6.6.4.2 Meaning and Usage of Setpoints

Inputs/Outputs of Setpoints

The following explanations apply to all setpoints regardless of their data type. Specific explanations are indicated as such.

Process values

The process value input is used to read out the actual process value from the plant. The process value can be value from the process or a calculated value. The value is output unmodified on the output.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._AI</td>
<td>Actual Value Input</td>
</tr>
<tr>
<td>PI</td>
<td>..._BAI</td>
<td>Tracking ID Actual Value Input</td>
</tr>
<tr>
<td>PI</td>
<td>..._MAI</td>
<td>Material Actual Value Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDAI</td>
<td>Transfer ID Actual Value Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CAI</td>
<td>Transfer Counter Actual Value Input</td>
</tr>
<tr>
<td>Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._AO</td>
<td>Actual Value Output</td>
</tr>
<tr>
<td>PI</td>
<td>..._BAO</td>
<td>Tracking ID Actual Value Output</td>
</tr>
<tr>
<td>PI</td>
<td>..._MAO</td>
<td>Material Actual Value Output</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._DAO</td>
<td>Transfer ID Actual Value Output</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CAO</td>
<td>Transfer Counter Actual Value Output</td>
</tr>
</tbody>
</table>
Prepared Setpoints

On the setpoint inputs for AUTO or MANUAL mode the word the word that will be used at the next start of the SFC instance is "prepared.

You can assign parameters for the MANUAL mode inputs in the "Prepared values" view of the SFC faceplate. The prepared values will be output on the outputs.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>...</td>
<td>Setpoint Automatic Input</td>
</tr>
<tr>
<td>all</td>
<td>..._OPP</td>
<td>Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._BOPP</td>
<td>Tracking ID Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._B..._B</td>
<td>Tracking ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._M..._M</td>
<td>Material Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._MOPP</td>
<td>Material Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._ID</td>
<td>Transfer ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDOPP</td>
<td>Transfer ID Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._C..._C</td>
<td>Transfer Counter Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._COPP</td>
<td>Transfer Counter Setpoint Operator Input Prepare</td>
</tr>
<tr>
<td>Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._QP</td>
<td>Valid Setpoint Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._BQP</td>
<td>Tracking ID Valid Setpoint Prepare</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._MQP</td>
<td>Material Valid Setpoint Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDQP</td>
<td>Transfer ID Valid Setpoint Prepare</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CQP</td>
<td>Transfer Counter Valid Setpoint Prepare</td>
</tr>
</tbody>
</table>
Setpoints that will be applied immediately

A value that will be applied immediately is set on the setpoint inputs for AUTO or MANUAL mode. In AUTO mode, the TAKESP input must also be set.

The inputs of the operating mode MANUAL can be parameterized in the view "Current values" of the SFC image block. You can assign parameters for the MANUAL mode inputs in the "Current values" view. The current values will be output at the outputs.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>...</td>
<td>Setpoint Automatic Input</td>
</tr>
<tr>
<td>all</td>
<td>..._OP</td>
<td>Setpoint Operator Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._B..._B</td>
<td>Tracking ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._BOP</td>
<td>Tracking ID Setpoint Operator Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._M..._M</td>
<td>Material Setpoint Automatic Input</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._MOP</td>
<td>Material Setpoint Operator Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._ID</td>
<td>Transfer ID Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDOP</td>
<td>Transfer ID Setpoint Operator Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._C..._C</td>
<td>Transfer Counter Setpoint Automatic Input</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._COP</td>
<td>Transfer Counter Setpoint Operator Input</td>
</tr>
<tr>
<td>Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all</td>
<td>..._Q..._Q</td>
<td>Active Setpoint</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._BQ</td>
<td>Tracking ID Active Setpoint</td>
</tr>
<tr>
<td>PI, PO</td>
<td>..._MQ</td>
<td>Material Active Setpoint</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._IDQ</td>
<td>Transfer ID Active Setpoint</td>
</tr>
<tr>
<td>TKEY</td>
<td>..._CQ</td>
<td>Transfer Counter Active Setpoint</td>
</tr>
</tbody>
</table>

Operator Enables (Preparation and Modification of setpoints in MANUAL)

The preparation or modification of the setpoint in MANUAL mode is only possible if the corresponding operator enables are set.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BOOL</td>
<td>..._EN0OP</td>
<td>&quot;Enable Setpoint&quot; &quot;0&quot; &quot;Operator Input&quot;</td>
</tr>
<tr>
<td>BOOL</td>
<td>..._EN1OP</td>
<td>&quot;Enable Setpoint&quot; &quot;1&quot; &quot;Operator Input&quot;</td>
</tr>
<tr>
<td>BOOL</td>
<td>..._EN0OPP</td>
<td>&quot;Enable Setpoint&quot; &quot;0&quot; &quot;Operator Input Prepare&quot;</td>
</tr>
<tr>
<td>BOOL</td>
<td>..._EN1OPP</td>
<td>&quot;Enable Setpoint&quot; &quot;1&quot; &quot;Operator Input Prepare&quot;</td>
</tr>
<tr>
<td>all except BOOL</td>
<td>..._ENOP</td>
<td>Enable Setpoint Operator Input</td>
</tr>
<tr>
<td>all except BOOL</td>
<td>..._ENOPP</td>
<td>Enable Setpoint Operator Input Prepare</td>
</tr>
</tbody>
</table>
Checking Limit Values

Modified limit values will only be applied at the appropriate output if the new value is within the defined limits of the setpoint. If this is not the case, the limit value violation is indicated as an error at the <sw>_ERR output and the output affected remains unchanged.

<table>
<thead>
<tr>
<th>Data type</th>
<th>I/O</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all except BOOL, STRING</td>
<td>... LL</td>
<td>Low Limit</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>all except BOOL, STRING</td>
<td>... HL</td>
<td>High Limit</td>
</tr>
<tr>
<td>Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all except BOOL, STRING</td>
<td>... ERR</td>
<td>Setpoint Input Error</td>
</tr>
</tbody>
</table>

Checking Control Strategy Assignment

The value of the <sp>_CS input defines the assignment of the setpoint to the existing control strategies. This assignment is necessary for checking and applying setpoint changes and for adapting the SFC faceplate to the currently selected control strategy. Assign parameters for the input <sw>_CS via the Dialog Box "Object Properties" of a setpoint.
6.6.4.3 "Process Values" Characteristic

"Process Values" Characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Process value input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For explanations of the table entries, refer to the section Meanings in the Table.

6.6.4.4 "Control Values" Characteristic

"Control Values" Characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Control value output</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For explanations of the table entries, refer to the section Meanings in the Table.


6.6.4.5 "Parameters" Characteristic

"Parameters" Characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Parameter input</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For explanations of the table entries, refer to the section "Meanings in the Table".

6.6.4.6 "Bit Memory" Characteristic

"Bit Memory" Characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;name&quot;</td>
<td>Bit memory (static VAR area)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DINT</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REAL</td>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
<td>&quot;&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note

Bit memory is an internal variable that does not appear as a visible I/O on the interface. As a result, for example, you cannot use the "Browse" dialog box or the interface editor to incorporate this variable in the addresses of the step/transition properties. You have to enter the I/O name for the bit memory with the keyboard.
6.6.4.7 "Timers" Characteristic

"Timers" Characteristic

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE_T</td>
<td>Task scanning time in sec (is predefined by the code generator with the corresp. cycle time)</td>
<td>REAL</td>
<td>0.0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_MODE</td>
<td>Operating mode:</td>
<td>INT</td>
<td>2</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: Start timer as pulse &quot;Pulse&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: Start timer as extended pulse &quot;ExtP&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2: Start timer with on delay &quot;OnDel&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3: Start timer with retentive on delay &quot;RetOn-D&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4: Start timer with off delay &quot;Off-D&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_TIME0</td>
<td>Time in s</td>
<td>REAL</td>
<td>1.0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_RESET</td>
<td>Reset</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_I0</td>
<td>Input pulse</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_QERR</td>
<td>Error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_Q0</td>
<td>Output pulse</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;name&quot;_PTIME</td>
<td>Time remaining in s</td>
<td>REAL</td>
<td>0.0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For explanations of the table entries, refer to the section "Meanings in the Table".

6.6.4.8 "Block Contacts" Characteristic

"Block Contacts" Characteristic

You can find information about this in the section "Block Contacts" under "Inputs/Outputs for Characteristics".
### 6.6.5 Inputs/Outputs of the Sorted by Usage

#### 6.6.5.1 Operating Modes (SFC Inputs/Outputs)

**SFC Inputs/Outputs of the Operating Modes**

For explanations of the table entries, refer to the section Measings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default Ty pe</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>QENAUT</td>
<td>Enable &quot;Change to AUTO&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>AUT</td>
<td>Change to AUTO (Process mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>Operator and display section &quot;AUTO&quot;</td>
<td>Change to AUTO (Process mode) with button</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>QENMAN</td>
<td>Enable &quot;Change to MAN&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>MAN</td>
<td>Change to MAN (operator control mode)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>Operator and display section &quot;MAN&quot;</td>
<td>Change to MAN (operator control mode) with button</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>Operating mode: 0: MAN, 1: AUTO</td>
<td>BOOL</td>
<td>0</td>
<td>1</td>
<td>O</td>
</tr>
<tr>
<td>QFORCEMAN</td>
<td>Change to MAN without enable(= force manual, 1 cycle long)</td>
<td>BOOL</td>
<td>0</td>
<td></td>
<td>O</td>
</tr>
</tbody>
</table>

**Key**

1) Depends on "SFC Properties/Operating Parameters CPU/Operating Mode"
Switching the Operating Mode in the Interface

<table>
<thead>
<tr>
<th>Operating Mode before:</th>
<th>Enable MAN</th>
<th>Enable AUTO</th>
<th>Changeover</th>
<th>Operating Mode afterwards:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = MAN 1 = AUTO</td>
<td>0 &lt;-&gt; 1</td>
<td>0 &lt;-&gt; 1</td>
<td>MAN</td>
<td>0 = MAN 1 = AUTO</td>
</tr>
<tr>
<td>QAUTMAN</td>
<td>ENMAN</td>
<td>QENMAN</td>
<td>QENAUT</td>
<td>QAUTMAN</td>
</tr>
<tr>
<td>0</td>
<td>x</td>
<td>x</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>x</td>
<td>x</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>x</td>
<td>x</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0 &lt;-&gt; 1</td>
<td>0 &lt;-&gt; 1</td>
<td>x</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>x</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Switching the Operating Mode via Operator Input (SFC Test Mode/SFC Visualization)

<table>
<thead>
<tr>
<th>Operating Mode before</th>
<th>Enable MAN/AUTO</th>
<th>Changeover</th>
<th>Operating Mode afterwards</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAN</td>
<td>Closed + raised</td>
<td>Inactive</td>
<td>Click</td>
</tr>
<tr>
<td></td>
<td>Display + &quot;Padlock&quot; button</td>
<td></td>
<td>After warning box AUTO</td>
</tr>
<tr>
<td>MAN</td>
<td>Open + depressed</td>
<td>Inactive</td>
<td>Click</td>
</tr>
<tr>
<td></td>
<td>Display + &quot;Padlock&quot; button</td>
<td></td>
<td>AUTO</td>
</tr>
<tr>
<td>AUTO</td>
<td>Closed + raised</td>
<td>Click</td>
<td>Inactive</td>
</tr>
<tr>
<td></td>
<td>Display + &quot;Padlock&quot; button</td>
<td></td>
<td>After warning box MAN</td>
</tr>
<tr>
<td>AUTO</td>
<td>Open + depressed</td>
<td>Click</td>
<td>Inactive</td>
</tr>
<tr>
<td></td>
<td>Display + &quot;Padlock&quot; button</td>
<td></td>
<td>MAN</td>
</tr>
</tbody>
</table>

The "padlock" enable button also shows the status of QENMAN or QENAUT.

The QFORCEMAN output is set for one cycle when there is a changeover from AUTO to MAN if no enable was set.
6.6.5.2 Commands and Operating States (SFC Inputs/Outputs)

SFC Inputs/Outputs of the Commands and Operating States

For explanations of the table entries, refer to the section “Meanings in the Table”

"Start" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Active&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g. LI_ERR, OP_ERR, ...)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>&quot;Start&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>INTSTART</td>
<td>Internal command &quot;Start&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>New operating state &quot;Starting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Active&quot; (after &quot;Starting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

"Hold" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENHOLD</td>
<td>Enable &quot;Hold&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>HOLD</td>
<td>&quot;Hold&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>INTHOLD</td>
<td>Internal command &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOCKHOLD</td>
<td>External interlock &quot;Hold&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>HOLDING</td>
<td>New operating state &quot;Holding&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELD</td>
<td>New operating state &quot;Held&quot; (after &quot;Holding&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### "Resume" (Enables, Commands)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENRESUME</td>
<td>Enable &quot;Resume&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESUME</td>
<td>&quot;Resume&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>&quot;Resume&quot; control and display section</td>
<td>&quot;Resume&quot; button for manual command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTRESUME</td>
<td>Internal command &quot;Resume&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td>O</td>
</tr>
</tbody>
</table>

### "Resume" in "Held" Operating State (New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESUMING</td>
<td>New operating state &quot;Resuming&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Active&quot; (after &quot;Resuming&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### "Resume" in "Held (Error)" Operating State (New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESU_ERROR</td>
<td>New operating state &quot;Resuming (Error)&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Active&quot; (after &quot;Resuming (Error)&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### "Abort" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ABORT</td>
<td>&quot;Abort&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>INTABORT</td>
<td>Internal command &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOCKABORT</td>
<td>External interlock &quot;Abort&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>ABORTING</td>
<td>New operating state &quot;Aborting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABORTED</td>
<td>New operating state &quot;Aborted&quot; (after &quot;Aborting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### "Complete" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENCOMPLETE</td>
<td>Enable &quot;Complete&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>COMPLETE</td>
<td>&quot;Complete&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>INTCOMPLETE</td>
<td>Internal command &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOCKCOMPLETE</td>
<td>External interlock &quot;Complete&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SELFCOMP</td>
<td>SFC changes automatically from &quot;Active&quot; to &quot;Completing&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>COMPLETING</td>
<td>New operating state &quot;Completing&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPLETED</td>
<td>New operating state &quot;Completed&quot; (after &quot;Completing&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### "Stop" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSTOP</td>
<td>Enable &quot;Stop&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STOP</td>
<td>&quot;Stop&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Operator control and display &quot;Stop&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTSTOP</td>
<td>Internal command &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOCKSTOP</td>
<td>External interlock &quot;Stop&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STOPPING</td>
<td>New operating state &quot;Stopping&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STOPPED</td>
<td>New operating state &quot;Stopped&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### "Restart" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENRESTART</td>
<td>Enable &quot;Restart&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESTART</td>
<td>&quot;Restart&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Operator control and display &quot;Restart&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTRESTART</td>
<td>Internal command &quot;Restart&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STARTING</td>
<td>New operating state &quot;Starting&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Active&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### "Reset" (Enables, Commands, New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENRESET</td>
<td>Enable &quot;Reset&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>&quot;Reset&quot; automatic command</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Operator control and display &quot;Reset&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTRESET</td>
<td>Internal command &quot;Reset&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SELFRESET</td>
<td>SFC changes automatically from &quot;Completed/Aborted/Stopped&quot; to &quot;Idle&quot; (only in MAN)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>IDLE</td>
<td>New operating state &quot;Idle&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Configuring Sequential Control Systems

### "Error" (Enables, Commands)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator control</td>
<td>&quot;Error&quot; button for manual command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>and display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Error&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INTERROR</td>
<td>Internal command &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOCKERROR</td>
<td>External interlock &quot;Error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I-Q</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### "Error" Not in Operating State "Completing" (New Operating State)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR_ COMPLETING</td>
<td>New operating state &quot;Error (Completing)&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPLETING</td>
<td>New operating state &quot;Completing&quot; after &quot;Error (Completing)&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Explanations of the Commands and Operating State Transitions

The "Start,..." MAN commands are entered from the control and display section by means of the command buttons and control word SFC_CONTROL and reset after they have been executed.

Whether or not the command buttons are enabled is derived from the status word SFC_STATE and depends on the particular "EN..." enable, the operating mode, and the operating state:

- In AUTO mode, all buttons for the commands are disabled.
- In MAN mode, the buttons for the commands are enabled or disabled depending on the enable and the operating state.

The command inputs "START, ....." are evaluated in AUTO mode depending on the "ENSTART, ....." enable. Whether they are permitted depends on the current operating state.

For more information on this subject, refer to the section Operating Mode.

The LOCK commands are evaluated in AUTO and MAN modes regardless of the enable. Whether they are permitted depends on the current operating state.

The INT commands are evaluated in AUTO and MAN modes regardless of the enable. They are used in step actions and reset after they have been executed. Whether they are permitted depends on the current operating state.

Note the special conditions for the "Start" command:

**QDIS_START**

"Start" is possible only when QDIS_START is set to 0 (in IDLE, RUN, COMPLETED, ABORTED).

For more information on this subject, refer to the section Error Handling

**ENASTART**

In RUN mode, "Start" is possible only when ENASTART is set to 1 and the following conditions are also met:

- AUTO mode: CONT = 1 (Continuous mode) and READY_TC = 1 (RUN sequencer is completed or after action)

"READY_TC:=1")

For more information on this subject, refer to the section Start Requirements of an SFC (Chart or Instance)
Special INT Command (for SFC Chart Only)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTONOFF</td>
<td>Internal command &quot;Turn SFC off/on&quot;, 1: on, 0: off</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
</tr>
</tbody>
</table>

This command exists to allow compatibility with SFC V5.2 (<SFCname>.EN) and is used in step actions.

**Note**
The I/O INTONOFF is not an available SFC type in V6.1 and higher. It has been changed to a reserve (IORES0). Existing accesses to INTONOFF are converted to textual interconnections.

Enable SFC (INTONOFF=1)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSTART</td>
<td>Enable &quot;Start&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>STARTING</td>
<td>New operating state &quot;Starting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>New operating state &quot;Active&quot; (after &quot;Starting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

Disable SFC (INTONOFF=0)

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABORT</td>
<td>Enable &quot;Abort&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>ABORTING</td>
<td>New operating state &quot;Aborting&quot; (transitional state)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>ABORTED</td>
<td>New operating state &quot;Aborted&quot; (after &quot;Aborting&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
Special States

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>READY_TC</td>
<td>&quot;Ready to complete&quot; state</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BUSY</td>
<td>Status &quot;Busy&quot; (= neither &quot;Idle&quot; nor &quot;Completed&quot; nor &quot;Aborted&quot; nor &quot;Stopped&quot;)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**READY_TC**

With the READY_TC (Ready to complete) output of the standard interface, the SFC provides a signal for synchronization between the SFC and the higher-level controller for the transition from "Active" to "Completing." The SFC sets the READY_TC to "1" if "Active" has finished executing, in other words, the start conditions for a sequencer are not fulfilled or a started sequencer has been executed completely. Regardless of the reason, READY_TC can also be set in increments. This enables the actual SFC execution completion to be signaled. A higher-level controller issues the "Complete" command to the SFC only when the READY_TC output is set.

If "Active" state is exited (for example, due to a "Complete," "Hold," or "Error"), READY_TC = 0 is set. If the SFC has been placed in "Hold" state and then resumed, READY_TC is not automatically reset to the previous value; rather, it remains set to 0 because the SFC cannot decide whether the conditions for READY_TC = 1 have been fulfilled again when a resumption occurs. The project engineer is responsible for proper handling of READY_TC in this case.

**BUSY**

BUSY = 1 indicates that the SFC is "busy," i.e., has been started. This signal replaces the signal <SfcName.EN> used for transitions in SFC V5.2 and lower.

**Priorities**

For more information on this subject, refer to the section Priorities of the Commands.

**Programmed Targets Steps / "Set Target Step" Enable**

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTARGETSTEP</td>
<td>Enable &quot;Set target steps&quot;</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>TARGETSEQ</td>
<td>Sequencer number for &quot;Set target step&quot;</td>
<td>BYTE</td>
<td>0</td>
<td>I</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>TARGETSTEP</td>
<td>Step number for &quot;Set target step&quot;</td>
<td>WORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
</tbody>
</table>

With ENTARGETSTEP, you can enable or disable the manual setting of target steps in MAN mode (relevant only in MAN, in contrast to other "EN..."). ENTARGETSTEP has no effect on programmed target steps.

With TARGETSEQ and TARGETSTEP, only one target step can be set in a sequencer. A target step that has already been set is reset.
6.6.5.3 Execution Options (SFC Inputs/Outputs)

SFC Inputs/Outputs of the Execution Options

For explanations of the table entries, refer to the section Meanings in the Table

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYCLEEXEC</td>
<td>Cyclic execution (only in AUTO)</td>
<td>BOOL</td>
<td>0 2</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Cyclic execution&quot; control and display section</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Option: Cyclic execution (only in MAN)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 2</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RUNCOUNT</td>
<td>Number of runs in &quot;cyclic execution&quot;</td>
<td>INT</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INSTROUT</td>
<td>Instruction output (only in AUTO)</td>
<td>BOOL</td>
<td>1 3</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Instruction output&quot; control and display section</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Option: Instruction output (only in MAN)</td>
<td></td>
<td>1 3</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>TIMEMON</td>
<td>Time monitoring (only in AUTO)</td>
<td>BOOL</td>
<td>0 4</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Time monitoring&quot; control and display section</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Option: Time monitoring (only in MAN)</td>
<td></td>
<td>0 4</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SCT</td>
<td>Step enabling with transition (only in AUTO)</td>
<td>BOOL</td>
<td>1 6</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Step control mode&quot; control and display section</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MANUAL: T: Step enabling with transition</td>
<td></td>
<td>T 6</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td></td>
<td>T or C: Step enabling with transition or operator confirmation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>T and C: Step enabling with transition and operator confirmation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C: Step enabling with operator confirmation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>T/T and C: Step enabling with transition and step-specific Confirmation by operator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCC</td>
<td>Step enabling with operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCST</td>
<td>Step enabling with transition</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCT_TAC</td>
<td>Step enabling with transition and step-specific operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCTAC</td>
<td>Step enabling with transition and operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSCTOC</td>
<td>Step enabling with transition or operator confirmation</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configuring Sequential Control Systems

#### SFC for SIMATIC S7

- **RUNHOLD**: Response of the RUN sequencer to the "Hold" Command
  - 0: Hold sequencer, 1: Abort sequencer
  - Type: BOOL
  - Default: 0
  - Attribute: I
  - Output Class Mark: Q

- **SELFCOMP**: SFC changes automatically from "Active" to "Completing"
  - Type: BOOL
  - Default: 1
  - Attribute: I
  - Output Class Mark: Q

- **SELFRESET**: SFC changes automatically from "Completed/Aborted/Stopped" to "Idle" (only in MAN)
  - Type: BOOL
  - Default: 0
  - Attribute: I
  - Output Class Mark: Q

### Key

| 2) | Depends on "SFC Properties/Operating Parameters CPU/Cyclic Execution"
| 3) | Depends on "SFC Properties/Operating Parameters CPU/Instruction Output"
| 4) | Depends on "SFC Properties/Operating Parameters CPU/Time Monitoring"
| 6) | Depends on "SFC Properties/Operating Parameters CPU/Step Control Mod"

### 6.6.5.4 Group Displays and Group Acknowledgements (SFC Inputs/Outputs)

#### SFC Inputs/Outputs of the Group Displays and Group Acknowledgements

For explanations of the table entries, refer to the section "Meanings in the Table".

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attribute</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_ERRCA</td>
<td>Confirmation of all step errors (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>S_ERRG</td>
<td>Group display &quot;Step error&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T_OPRQCA</td>
<td>Confirmation of all operator prompts (only in AUTO)</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>T_OPRQG</td>
<td>Group display &quot;Operator prompt at transition&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Confirm all&quot; control and display section</td>
<td>Confirm all step errors and all operator prompts with button</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 6.6.5.5 Data from Sequencers and Steps to be Processed (SFC Inputs/Outputs)

**SFC Inputs/Outputs of the Data from Sequencers and Steps to be Processed**

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSEQ</td>
<td>No. of current sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>CUSTEP</td>
<td>No. of current step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPPACTSTATE</td>
<td>Active state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPCOUNT</td>
<td>Number of active steps</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPERRSTATE</td>
<td>Error state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPELDSTATE</td>
<td>Held state of current step</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMAXRT</td>
<td>Max. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>CUSTEPMINRT</td>
<td>Min. run time of the current step</td>
<td>TIME</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>HELDSEQ</td>
<td>No. of held sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td>+</td>
</tr>
<tr>
<td>HELDSTEP</td>
<td>No. of held step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LASTSEQ</td>
<td>No. of the last active sequencer</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>LASTSTEP</td>
<td>No. of the last active step</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
### 6.6.5.6 BATCH Parameters (SFC Inputs/Outputs)

**SFC Inputs/Outputs of the BATCH Parameters**

For explanations of the table entries, refer to the section **Meanings in the Table**.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA_CONTROL *)</td>
<td>BATCH control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>BA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>1</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>BA_ID</td>
<td>BATCH: Batch serial number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>BATCH: Batch ID</td>
<td>STRING [32]</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>OCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>QBA_EN</td>
<td>BATCH: Enable</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QBA_ID</td>
<td>BATCH: Batch serial number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QBA_NA</td>
<td>BATCH: Batch ID</td>
<td>STRING [32]</td>
<td>&quot;</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QOCCUPIED</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QREFRESH *)</td>
<td>BATCH: Read in setpoint/process values again</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QSTEP_T *)</td>
<td>BATCH: Current step run time [ms]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>REFRESH *)</td>
<td>BATCH: Read in setpoint/process values again</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>STEP_NO</td>
<td>BATCH: Step number</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>STEP_T *)</td>
<td>BATCH: Max. step run time [ms]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

*) Only for SFC type  
**) Only for SFC chart
### 6.6.5.7 Continuous Mode (SFC Inputs/Outputs)

**SFC connections for continuous operation**

For explanations of the table entries, refer to the section *Meanings in the Table*.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONT</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>CONT_T *)</td>
<td>Max. run time for &quot;continuous mode&quot; [ms]</td>
<td>DINT</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCONT *)</td>
<td>&quot;Continuous mode&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCONT_T *)</td>
<td>Current run time for &quot;continuous mode&quot; [ms]</td>
<td>DINT</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QCONT_T_ERR *)</td>
<td>Max. run time for &quot;continuous mode&quot; exceeded</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENASTART</td>
<td>Enable &quot;Start in Active&quot;</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
</tbody>
</table>

**Key**

* Only for SFC type

For explanations of the cooperation between user controls and SFC, refer to the section *Continuous Mode*. 
Configuring Sequential Control Systems

6.6.5.8 Error Handling (SFC Inputs/Outputs)

SFC Inputs/Outputs of the Error Handling

For explanations of the table entries, refer to the section Meanings in the Table

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERRG</td>
<td>Group error (EXT_ERR</td>
<td>OP_ERR</td>
<td>LI_ERR</td>
<td>S_ERRG)</td>
<td>BOOL</td>
</tr>
<tr>
<td>EXEC_ERR</td>
<td>Runtime error, e.g., step error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>EXT_ERR</td>
<td>External error</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
</tr>
<tr>
<td>LI_ERR</td>
<td>Parameter assignment error (for example, invalid combination at inputs)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>OP_ERR</td>
<td>Operator error</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QEXT_ERR</td>
<td>External error (= EXT_ERR)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>QDIS_START</td>
<td>&quot;Start&quot; not possible (e.g. LI_ERR, OP_ERR, ...)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

Calculation of LI_ERR

AUTO

- Execution options:
  - SCT = 0 and SCT_TAC = 0
  - SCT = 1 and SCT_TAC = 1

- Control strategy (SFC type only)
  The control strategy is checked when QPARAM = 1:
  - If control strategy high limit is violated (CS > CS_HL)
  - If control strategy low limit is violated (CS < CS_LL)
  - If control strategies exist (CS_LL > 0) and the prepared control strategy (CS) is not enabled (SELCS)

- Setpoint (SFC type only)
  The setpoint is checked when QPARAM = 1:
  - If setpoint high limit is violated (<setpoint> > <setpoint>_HL)
  - If setpoint low limit is violated (<setpoint> < <setpoint>_LL)

- Automatic commands:
  - More than one command at the same time (e.g., START and HOLD, etc.)
  - Simultaneous changeover to MAN and AUTO (MAN = 1 and AUT = 1)
MAN

- Execution options:
  - SELFRESET = 1 and "Cyclic execution" control and display section
    (neither SELFRESET nor "Cyclic execution" is executed)

AUTO + MAN

- Internal commands and external interlocks:
  - More than one internal command at the same time (e.g., INTABORT and
    INTCOMPLETE)
  - More than one external interlock at the same time (e.g., LOCKABORT and
    LOCKCOMPLETE)

Command Execution and LI_ERR

The following commands are not executed if LI_ERR is set to 1:

AUTO

- START (see also QDIS_START), COMPLETE, HOLD, RESUME, RESET

AUTO + MAN

- INTCOMPLETE, INTHOLD, INTRESUME, INTRESET
- LOCKCOMPLETE, LOCKHOLD

The following commands are also executed if LI_ERR is set to 1:

AUTO + MAN

- INTEERROR, INTSTOP, INTABORT
- LOCKERROR, LOCKSTOP, LOCKABORT

Calculation of OP_ERR (SFC type only)

The following checks in MANUAL mode result in OP_ERR (for one AS execution cycle):

- Control strategy
  - If control strategy high limit is violated (CS_OP > CS_HL).
  - If control strategy low limit is violated (CS_OP < CS_LL).
  - If control strategies exist (CS_LL > 0) and the prepared control strategy
    (CSP_OP) is not enabled (SELCS)

- Setpoints
  - If setpoint high limit is violated (<setpoint> > <setpoint>_HL)
  - If setpoint low limit is violated (<setpoint> < <setpoint>_LL)
Calculation of QDIS_START

**AUTO + MAN**
- No "Start" enable (ENSTART = 0)
- There is an external interlock (LOCKERROR, LOCKHOLD, LOCKABORT, LOCKCOMPLETE, LOCKSTOP)
- There is the internal command INERROR
- (SFC type only) If control strategies are configured but none is selected (QCSP = 0)
- The transition after STARTING has been executed
- An AUTO/HAND changeover has just been executed (1 cycle long)

**AUTO**
- (SFC type only) Control strategy and setpoint have not yet been checked (QPARAM = 0) or are bad
- In RUN mode, the "Start in Run" enable is not set (ENASTART = 0) and/or continuous mode is not set (QCONT = 0)
- There is an LI_ERR

**MAN**
- In RUN mode, the "Start in Run" enable is not set (ENASTART = 0)
- There is an LI_ERR
- There is an OP_ERR
## 6.6.5.9 Messages (SFC Inputs/Outputs)

**SFC Inputs/Outputs of the Messages**

For explanations of the table entries, refer to the section Meanings in the Table

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUX_PR04..10 *)</td>
<td>Associated value 4..10</td>
<td>ANY</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_ACK *)</td>
<td>Acknowledge messages (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_ERR *)</td>
<td>Message error (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_EVID</td>
<td>Message number (ALARM_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>MSG_LOCK</td>
<td>Lock messages: 0: Messages not locked 1: Messages locked</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>MSG_STAT</td>
<td>Message status (ALARM_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSG_SUP</td>
<td>Message suppression (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>NMSG_EVID **</td>
<td>Message number (NOTIFY)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>NMSG_EVID2 *)</td>
<td>Message number 1 (NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT1 *)</td>
<td>Message status 1 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NMSG_STAT2 *)</td>
<td>Message status 2 (NOTIFY_8P)</td>
<td>WORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NSIG_12..16 *)</td>
<td>Generate event message 12..16</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>RUNUPCYC *)</td>
<td>Number of run-up cycles</td>
<td>INT</td>
<td>3</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>SIG_2..8</td>
<td>Generate message 2..8 (ALARM_8P)</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>BA_ID</td>
<td>Associated value 1 (ALARM_8P, NOTIFY, NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>BA_NA</td>
<td>Associated value 2 (ALARM_8P, NOTIFY, NOTIFY_8P)</td>
<td>STRING [32]</td>
<td>&quot;</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
<tr>
<td>STEP_NO</td>
<td>Associated value 3 (ALARM_8P, NOTIFY, NOTIFY_8P)</td>
<td>DWORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td>+</td>
</tr>
</tbody>
</table>

**Key**

* Only for SFC type

** Only for SFC chart
6.6.5.10 Control Words (SFC Inputs/Outputs)

SFC Inputs/Outputs of the Control Words

For explanations of the table entries, refer to the section Meanings in the Table

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA_CONTROL *)</td>
<td>BATCH control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SFC_CONTROL</td>
<td>SFC control word (internal interface)</td>
<td>DWORD</td>
<td>0</td>
<td>IO</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

Key

*) Only for SFC type

Use of the Inputs/Outputs

- Via **BA_CONTROL**, SIMATIC BATCH sends commands to the SFC (in AUTO).
- Via **SFC_CONTROL**, the control and display section sends commands to the SFC (in MAN).
6.6.5.11 Status Words (SFC Inputs/Outputs)

Status Words of the SFC Inputs/Outputs

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA_STATE</td>
<td>BATCH status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>SFC_STATE</td>
<td>SFC status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>USTATUS *)</td>
<td>Status word in VSTATUS (can be used freely by user)</td>
<td>WORD</td>
<td>0</td>
<td>I</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>VSTATUS *)</td>
<td>Status word</td>
<td>DWORD</td>
<td>0</td>
<td>O</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

Key

*) Only for SFC type

BA_STATE
<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>&quot;Idle&quot; operating state</td>
<td>IDLE</td>
</tr>
<tr>
<td>1</td>
<td>&quot;Active&quot; operating state</td>
<td>RUN / HELD_ERROR)**</td>
</tr>
<tr>
<td>2</td>
<td>&quot;Completed&quot; operating state</td>
<td>COMPLETED</td>
</tr>
<tr>
<td>3</td>
<td>&quot;Held&quot; operating state</td>
<td>HELD</td>
</tr>
<tr>
<td>4</td>
<td>&quot;Aborted&quot; operating state</td>
<td>ABORTED</td>
</tr>
<tr>
<td>5</td>
<td>&quot;Ready to complete&quot; state</td>
<td>READY_TC</td>
</tr>
<tr>
<td>6</td>
<td>&quot;Stopped&quot; operating state</td>
<td>STOPPED</td>
</tr>
<tr>
<td>7</td>
<td>reserved</td>
<td>-</td>
</tr>
<tr>
<td>8 *)</td>
<td>Identifier &quot;Monitoring time for continuous mode exceeded&quot;</td>
<td>QCONT_T_ERR</td>
</tr>
<tr>
<td>9</td>
<td>&quot;Starting&quot; operating state</td>
<td>STARTING</td>
</tr>
<tr>
<td>10</td>
<td>&quot;Resuming&quot; operating state</td>
<td>RESUMING / RESU_ERROR **)</td>
</tr>
<tr>
<td>11</td>
<td>&quot;Completing&quot; operating state</td>
<td>COMPLETING / ERROR_COMPLETING **)</td>
</tr>
<tr>
<td>12</td>
<td>&quot;Holding&quot; operating state</td>
<td>HOLDING</td>
</tr>
<tr>
<td>13</td>
<td>&quot;Aborting&quot; operating state</td>
<td>ABORTING</td>
</tr>
<tr>
<td>14</td>
<td>&quot;Stopping&quot; operating state</td>
<td>STOPPING</td>
</tr>
<tr>
<td>15</td>
<td>Reserved for S88 &quot;Pausing&quot;</td>
<td>-</td>
</tr>
<tr>
<td>16</td>
<td>Default MAN/AUTO mode</td>
<td>SFC Properties/ Operating Parameters CPU/ &quot;Mode&quot;</td>
</tr>
<tr>
<td>17</td>
<td>MAN/AUTO mode</td>
<td>QAUTMAN</td>
</tr>
<tr>
<td>18</td>
<td>BATCH: Enable</td>
<td>BA_EN/QBA_EN</td>
</tr>
<tr>
<td>19 *)</td>
<td>BATCH: Identifier &quot;Run time exceeded&quot;</td>
<td>QSTEP_T &gt; STEP_T</td>
</tr>
<tr>
<td>20</td>
<td>Group display &quot;Operator prompt transition&quot;</td>
<td>T_OPRQG</td>
</tr>
<tr>
<td>21 *)</td>
<td>BATCH: Read in setpoint/process values again</td>
<td>REFRESH / QREFRESH</td>
</tr>
<tr>
<td>22</td>
<td>Identifier &quot;Start lock&quot;</td>
<td>QDIS_START</td>
</tr>
<tr>
<td>23</td>
<td>ID &quot;Continuous mode&quot; (Continuous)</td>
<td>CONT &amp; RUN &amp; READY_TC</td>
</tr>
<tr>
<td>24</td>
<td>BATCH: &quot;Occupied&quot; identifier</td>
<td>OCCUPIED/QOCCUPIED</td>
</tr>
<tr>
<td>25</td>
<td>&quot;Error&quot; operating state</td>
<td>ERROR / ERROR_COMPLETING **)</td>
</tr>
<tr>
<td>26</td>
<td>&quot;Execution&quot; error</td>
<td>EXEC_ERR</td>
</tr>
<tr>
<td>27</td>
<td>Group display &quot;Step execution time exceeded&quot;</td>
<td>S_ERRG</td>
</tr>
<tr>
<td>28</td>
<td>&quot;Parameter assignment/interconnection&quot; error</td>
<td>LI_ERR</td>
</tr>
<tr>
<td>29</td>
<td>&quot;Operator input&quot; error</td>
<td>OP_ERR</td>
</tr>
<tr>
<td>30</td>
<td>&quot;External&quot; error</td>
<td>EXT_ERR/QEXT_ERR</td>
</tr>
<tr>
<td>31</td>
<td>BATCH: Group error</td>
<td>Bit25-30 ORed</td>
</tr>
</tbody>
</table>

**Key**

*) Only for SFC type

**) The state that was in effect before the error state is also displayed.
## SFC_STATE

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
</table>
| 0-4 | Operating state Bit0-4 (states 0 to 4 are identical to the coding of SFC V5.2!) | 0: IDLE  
1: RUN  
2: COMPLETED  
3: HELD  
4: ABORTED  
5: STARTING  
6: COMPLETING  
7: ERROR_COMPLETING  
8: HOLDING  
9: RESUMING  
10: ERROR  
11: HELD_ERROR  
12: RESU_ERROR  
13: ABORTING  
14: STOPPING  
15: STOPPED  
16-31: free |
| 5 | "Continuous mode" state CONT & RUN & READY_TC |
| 6 | "Ready to complete" state READY_TC |
| 7 | AUTO/MAN mode QAUTMAN (0=MAN, 1=AUT) |
| 8 | Operator control error OP_ERR |
| 9 | Interconnection/parameter assignment error LI_ERR |
| 10 | "AUTO" operator enable ENAUT/QENAUT |
| 11 | "MAN" enable ENMAN/QENMAN |
| 12 | "Start" operator enable ENSTART & *) |
| 13 | "Complete" operator enable ENCOMPLETE & *) |
| 14 | "Hold" operator enable ENHOLD & *) |
| 15 | "Resume" operator enable ENRESUME & *) |
| 16 | "Abort" operator enable ENABORT & *) |
| 17 | "Stop" operator enable ENSTOP & *) |
| 18 | "Restart" operator enable ENRESTART & *) |
| 19 | "Reset" operator enable ENRESET & *) |
| 20 | "Error" operator enable *) |
| 21 | Adopt default operating parameters when SFC starts SFC Properties/ Operating Parameters CPU/ "Use default operating parameters..." |
| 22 | Group display "Operator prompt" T_OPRQG |
| 23 | Group display "Step error" S_ERRG |
### Configuring Sequential Control Systems

#### SFC for SIMATIC S7

**A5E00807946-01**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>24-26</td>
<td>Step control mode Bit0..2</td>
<td>0: QSCT&lt;br&gt;1: QSCTOC&lt;br&gt;2: QSCTAC&lt;br&gt;3: QSCC&lt;br&gt;4: QSCT_TAC</td>
</tr>
<tr>
<td>27</td>
<td>CPU restart after stop with active SFC</td>
<td>CPU-RESTART (consistent data)</td>
</tr>
<tr>
<td>28</td>
<td>CPU restart after stop during module processing</td>
<td>CPU-RESTART (inconsistent data)</td>
</tr>
</tbody>
</table>
| 29   | Instruction output                           | MAN: Control and display section<br>"Instruction output"
|      |                                              | AUTO:INSTROUT                              |
| 30   | Cyclic execution                             | MAN: Control and display section<br>"Cyclic execution"
|      |                                              | AUTO:CYCLEXEC                              |
| 31   | Time monitoring                              | MAN: Control and display section<br>"Time monitoring"
|      |                                              | AUTO:TIMEMON                               |

*) Depending on the operating state (see [Operating State Logic for SFC (SFC-OSL)](https://example.com)

#### USTATUS (SFC type only)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15</td>
<td>User-assigned</td>
</tr>
</tbody>
</table>
## VSTATUS (SFC type only)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>&quot;Idle&quot; operating state</td>
<td>IDLE</td>
</tr>
<tr>
<td>1</td>
<td>&quot;Starting / Active&quot; operating state</td>
<td>RUN / STARTING / RESU_ERROR</td>
</tr>
<tr>
<td>2</td>
<td>&quot;Completing / Completed&quot; operating state</td>
<td>COMPLETED / COMPLETING /</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ERROR_COMPLETING</td>
</tr>
<tr>
<td>3</td>
<td>&quot;Held / Error&quot; operating state</td>
<td>HELD / HOLDING / ERROR /</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELD_ERROR</td>
</tr>
<tr>
<td>4</td>
<td>&quot;Aborted&quot; operating state</td>
<td>ABORTED / ABORTING</td>
</tr>
<tr>
<td>5</td>
<td>&quot;Ready to complete&quot; operating state</td>
<td>READY_TC</td>
</tr>
<tr>
<td>6</td>
<td>&quot;Stopped&quot; operating state</td>
<td>STOPPED / STOPPING</td>
</tr>
<tr>
<td>7</td>
<td>reserved</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>&quot;Error&quot; operating state</td>
<td>ERROR / ERROR_COMPETING</td>
</tr>
<tr>
<td>9</td>
<td>Transitional state &quot;...ING&quot;</td>
<td>&quot;...ING&quot; / ERROR</td>
</tr>
<tr>
<td>10</td>
<td>MAN/AUTO mode</td>
<td>QAUTMAN (0=M AN, 1=AUT)</td>
</tr>
<tr>
<td>11</td>
<td>ID &quot;Continuous mode&quot; (Continuous)</td>
<td>CONT &amp; RUN &amp; READY_TC</td>
</tr>
<tr>
<td>12</td>
<td>SFC group error</td>
<td>ERRG</td>
</tr>
<tr>
<td>13</td>
<td>free</td>
<td>-</td>
</tr>
<tr>
<td>14</td>
<td>free</td>
<td>-</td>
</tr>
<tr>
<td>15</td>
<td>free</td>
<td>-</td>
</tr>
<tr>
<td>16-31</td>
<td>USTATUS Bit0-15</td>
<td>-</td>
</tr>
</tbody>
</table>
6.6.5.12 System Parameters (SFC Inputs/Outputs)

SFC Inputs/Outputs of the System Parameters

For explanations of the table entries, refer to the section Meanings in the Table.

Special

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE</td>
<td>Processing mode:</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: Cyclic processing in cyclic interrupt OB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: One-time processing in startup OB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFC_INIT</td>
<td>Initialize SFC</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note
- The MODE parameter is preset by the SFC code generator for insertion of the SFC instance in the startup OB or cyclic interrupt OB and must not be modified.
- The SFC_INIT parameter is used to initialize the SFC instance for test purposes and must not be used.

6.6.5.13 Reserves (SFC Inputs/Outputs)

SFC Inputs/Outputs of the Reserves

The reserve parameters fill offset gaps and are intended for future expansions and must therefore not be used!

For explanations of the table entries, refer to the section Meanings in the Table.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Meaning</th>
<th>Data type</th>
<th>Default</th>
<th>Type</th>
<th>Attr.</th>
<th>OCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC Chart</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES1..6</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IRES1..5</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES_BY</td>
<td>Reserved for internal use</td>
<td>BYTE</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES1..15</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFC Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES_BY</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IORES1..7</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>IO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IRES1..3</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES_BY1..3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORES1..24</td>
<td>Reserved for internal use</td>
<td>BOOL</td>
<td>0</td>
<td>O</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
7 Compiling SFC Types and SFC Instances

7.1 Overview of Compiling Charts, Types, and Instances

Compiling

When compiling (scope: entire program), all charts, SFC types, and SFC instances of the current chart folder are converted to the source language and then compiled. If you have modified an SFC chart, SFC type or SFC instance, you have the option of compiling the changes only.

When you compile, first all SFC types then all SFC instances and then all SFC charts are compiled. Finally, the CFC charts are compiled.

The SFC type is compiled only if a compilation-relevant change in the type has been made since the last compilation.

A function block type containing the inputs/outputs defined in the interface and the configured sequencers is generated from the SFC type provided with an interface. As with the SFC chart, an action FC and a transition FC are also generated.

During compilation, a consistency check is performed automatically. You can also start this check manually.

Logs are created during the consistency check and when compiling and downloading. You can view the logs in SIMATIC Manager with the menu command Options > Charts > Logs... and in the SFC and CFC with the menu command Options > Logs....

After compilation, you can download the user program to the target system and perform testing and commissioning.

Saving Settings without Compiling/Downloading

You can save the settings in the dialog box without starting the compilation or download operations by clicking the "Apply" button. This can be useful, for example, when you want to use the "Compile and Download" function in SIMATIC Manager. You can find additional information on this in the online help of SIMATIC Manager.
CPU Comparison

Select the menu command CPU > Compare if you want to compare the time stamp of the most recent changes before downloading.

A dialog box opens listing the date and time of the following changes:

- Last download-relevant change
- Last compilation
- Compilation of the loaded program

If the time stamp of the last download-relevant change is older than the last offline program change, this has no effect on the execution of the program in the CPU. You do not need to download the program again.

If the time stamp of the "Last compilation" is older than that of the download-relevant modification, you must compile the charts and download them to the CPU so that they match.

If the time stamp of the "Compilation of the loaded program" is older than the time stamp of the "Last compilation," you must download the user program from the PC or programming device to the CPU so that they match.

Additional Information

You can find additional information about compiling in the following sections:

- Settings for Compiling
- How to Compile
- Overview of the Blocks Generated during Compilation
- Consistency Check
- Logs
7.2 Settings for Compiling/Downloading

Making the Settings
Select the menu command Options > Customize > Compile/Download....
A dialog box opens in which you can find information about the resources related to compiling:

- You can specify which warning limits are to apply so that possible dangers are detected before you download.
- You can specify which resources should remain unused during compilation of the current chart folder. This can be useful, for example, if you want to solve an automation task partly with charts and partly by programming (for example, STL, LAD or SCL programs) and when you have functions (FCs) or data blocks (DBs) from other sources in your user program.
- You can see the statistics showing how many resources (DBs, FCs) are available for compiling and how many are already being used.
- You can specify whether an image of the loaded program will be generated for the comparison. The image is created as an XML document and assigned to the program. With it you can determine which differences exist between the data to be loaded and the loaded data exist prior to reloading.

Note
If you work only with CFC and SFC in your program, you can leave the default compilation settings unchanged.
7.2.1 How to Compile

Compiling the Chart Folder

1. Select the menu command SFC > Compile....
   A dialog box opens where you can select the relevant radio button to specify compilation of the "Entire program" (all objects are compiled) or "Changes" (only the objects changed since the last compilation are compiled).
   A dialog box for configuring the compilation settings opens.
2. Select whether to compile the "Entire program" or "Changes".
3. Optional: Deactivate the check box "Generate Module Driver" if for example your hardware is still incomplete for this compiling process. This deactivation only applies for this compile, for the next compile the check box is reactivated.
4. Optional: Activate the check box "Generate SCL Source" if you want to view a certain part of the program, for reasons of better understanding for example or for troubleshooting in the SCL code.
   An SCL source file will be generated and saved in the source folder only if the check box is selected. This source file is not needed for compiling the program.
   The deactivated check box is only valid for one compile; at the next compile it is deactivated again.
5. Click "OK". The dialog box closes and the compilation starts.

Result

The charts of the current program (chart folder) are checked for consistency and then compiled. The messages from the consistency check are written to a log file. If "errors" and "warnings" occur, you can jump to the relevant SFC by double-clicking the message.

During compilation, a dialog box with a progress bar is displayed. You can stop the compilation at any time by clicking "Cancel".

Viewing and Printing Logs

Select the menu command Options > Logs... to view and print messages from the consistency check or compilation.
Note
You can also perform a consistency check without compiling. To do so, select the menu command SFC > Check Consistency....
You will find additional information under "Consistency Check"


7.3 Overview of the Blocks Generated during Compilation

Introduction

Understanding the following relationships can be helpful if you want to control the use of resources in the CPU.

Overview

The structure you have configured in SFCs is mapped to the S7 objects function block, function (FC) and data block (DB). All charts (CFC and SFC) of a chart folder are always compiled.

Each SFC in the chart folder is mapped as follows during compilation:

- SFC chart: 1 instance DB + n sequencer DBs + 2 FCs
- SFC type: 1 FB + 2 FCs
- SFC instance: 1 instance DB + n sequencer DBs

In order for the SFC charts / SFC instances to be executed in the AS, the following blocks are also present in the block folder (depending on the configuration):

<table>
<thead>
<tr>
<th>Object name</th>
<th>Symbolic name</th>
<th>For Chart (C) / Type (T)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB 245</td>
<td>@SFC_BZL</td>
<td>C / T</td>
<td>Operating State Logic</td>
</tr>
<tr>
<td>FB 246</td>
<td>@SFC_ESM</td>
<td>C / T</td>
<td>Sequencer processing</td>
</tr>
<tr>
<td>FB 300</td>
<td>@SFC_RTS</td>
<td>P (V6.0 and higher)</td>
<td>Runtime system</td>
</tr>
<tr>
<td>FB 300</td>
<td>@SFC_INTP</td>
<td>C (up to V5)</td>
<td>Runtime system</td>
</tr>
<tr>
<td>FC 240</td>
<td>@SFC_OPI</td>
<td>T</td>
<td>Auxiliary block for INT</td>
</tr>
<tr>
<td>FC 241</td>
<td>@SFC_OPDI</td>
<td>T</td>
<td>Auxiliary block for DINT</td>
</tr>
<tr>
<td>FC 242</td>
<td>@SFC_OPR</td>
<td>T</td>
<td>Auxiliary block for REAL</td>
</tr>
<tr>
<td>FC 243</td>
<td>@SFC_OPB</td>
<td>T</td>
<td>Auxiliary block for BOOL</td>
</tr>
<tr>
<td>FC 244</td>
<td>@SFC_OPS</td>
<td>T</td>
<td>Auxiliary block for STRING</td>
</tr>
<tr>
<td>FC 250</td>
<td>@SFC_INDCA LL</td>
<td>T</td>
<td>Auxiliary block for block calls</td>
</tr>
<tr>
<td>SFB 35</td>
<td>ALARM_8P</td>
<td>C / T</td>
<td>Messages with associated values for 8 signals</td>
</tr>
<tr>
<td>SFB 36</td>
<td>NOTIFY</td>
<td>P</td>
<td>Messages without acknowledgement display</td>
</tr>
<tr>
<td>SFB 31</td>
<td>NOTIFY_8P</td>
<td>T</td>
<td>Messages without acknowledgement display for 8 signals</td>
</tr>
</tbody>
</table>
If a "time" characteristic exists, the following block is also required:

| FB 5 | TIMER_P | T | Pulse generator |

When you create a new SFC chart or SFC type, the required blocks are automatically copied to the block folder. For an SFC type, an additional copy of FB 247 is created (FB number is the first available number, for example, FB 1025).

Furthermore, additional FCs are required in order to call the blocks processed in the CFC according to the configured run sequence, as follows:

- One FC for each OB used
- One FC for each runtime group

DBs are used by the CFC as follows:

- An instance DB is created for each inserted block of a block type (FB).
- Pool DBs are created for storing interim results of FCs, for example. One pool DB is required per data type. When the maximum length (4 Kbytes) is reached, another DB is created.

The quantity of FCs and DBs available varies according to the CPU. You must allocate these as follows:

- FCs for block types
- FCs and DBs for the structures created with the STL, LAD and SCL programming languages
- FCs and DBs for compiled charts

**Calculation of SFC Resources**

The section "Notes on Usage" in the SFC Readme contains an Excel file "SFC Resources" that you can use to calculate your approximate system resource requirements.
7.4 Consistency Check

Scope of the Check

Prior to the actual compilation, the system automatically performs the following consistency checks:

- Check to determine whether the block types in the user program match the types imported in the CFC
  Inconsistencies can occur if block types in the user program have been changed or deleted following the block type import into the CFC.

- Check to determine whether symbolic references to shared addresses are entered in the symbol table
  Inconsistencies can occur if the relevant entries have not yet been made in the symbol table or if they have been changed or deleted.

- Check to determine whether the interconnected data blocks (DBs) are present in the user program
  Inconsistencies can occur if data blocks in the user program have been subsequently changed or deleted.

- Check to determine whether in/out parameters or block outputs of type "ANY", "STRING", "DATE_AND_TIME" or "POINTER" have been assigned (i.e., interconnected)
  Check to determine whether all blocks accessed by conditions and instructions from the SFC are present

You can also perform this consistency check without compiling, for example, if you want to check whether there is any point at all in compiling.

Procedure

1. Select the menu command Chart > Check Consistency.
   All charts in the current chart folder are checked. When the check is completed, the result is shown in the "Logs" dialog box.

2. You can also read or print the log at a later time.

3. In SFC, select the menu command Options > Logs..., or in SIMATIC Manager, select the menu command Options > Chart > Logs....
   You will find additional information about this under "Logs".
8 Downloading to the AS

8.1 How to Download Programs

Introduction

In order to commission graphically generated charts/types for a CPU, the program must first be compiled and downloaded to the target system. The charts are downloaded to the CPU to which the user program containing the current chart folder is assigned.

Note

Programs created with SFC must always be downloaded to the CPU from SFC or CFC, since only this download function guarantees the consistency of the configuration data with the CPU data. The same download function is also used if you select the menu command PLC > Compile and Download Objects… in SIMATIC Manager.

On the other hand, copying blocks in the "Offline Block Folder" to insert them in the "Online Block Folder" is not permitted.

Change Log

With S7, loading into the CPU - and working in test mode - are functions that are logged if the SIEMATIC Logon Service is installed and the access protection and change log are activated.

In addition to the change log of the SIEMATIC Manager, in the ES the actions and the time stamp can be listed in the ES log when loading, if the current chart folder is activated for the ES log. Activate the selected chart folder in the Dialog Box of the object characteristics in the tab "ES Log".

You will find information about this in the CFC manual or in the CFC online help under The Change Log.
Requirements for Downloading

Before you can download, the following requirements must be met:

- There must be a connection between the CPU and your programming device or PC.
- Edit mode is set.
- The program is compiled.

Procedure

1. Select the menu command **PLC > Download**. The "Download" dialog box opens.
2. Select the download mode to specify if the "Entire program" or only "Changes" are to be downloaded to the CPU. You can also select the entire program in a "Download to test CPU".
3. Click "OK" to download the program.

If you have made download-relevant changes in the configuration and have not compiled since you made the changes, you will be prompted to compile before you download. If the compilation is free of errors, the download will be started automatically when the compilation is complete.

Downloading the Entire Program

The following is performed with the "Entire program" download mode:

- The CPU is set to "STOP" after a prompt for confirmation.
- All blocks in the CPU are deleted.
- All charts in the current chart folder are downloaded to the CPU.

Notes on Downloading the Entire Program

- Compiling the entire program does not necessarily mean that a complete download is necessary. If the program was already downloaded to the CPU prior to compiling, it is possible to download the changes only.
- If you cancel a full download, no download of changes is possible until a full download has been completed. Reason: The blocks were deleted on the CPU prior to the download.

Downloading Changes

In the "Changes" download mode with CPU in "RUN-P" mode, you can download changes in your configuration to the AS without having to change the CPU to STOP mode. With this type of download, you only download changes that have been made since the last download.
Notes on Downloading Changes

- If the sequencer topology has been changed in the SFC charts/SFC types, for example, steps or transitions have been added, deleted, copied, moved or jump destination has been changed, and if the modified sequencer is active in the AS, these charts or all instances of the type must be disabled. Disabling before the download and enabling after the download is handled by the download program following positive acknowledgment of a prompt. Otherwise, the download is aborted.
  
  If you perform the download with the SIMATIC Manager function "Compile and Download Objects", the SFCs are not automatically disabled. In this case, the download will not be performed and an error message is entered in the log.

- Modifications to the interface of the SFC type are transferred to the SFC instances immediately. For this reason, the SFC instances must be disabled during the downloads and execution must be suspended in the CPU. Disabling before the download and enabling after the download is handled by the download program following positive acknowledgment of a prompt. Otherwise, the download is aborted.

Note
A sequencer running in the "Aborting" state cannot be disabled by the download program if operator confirmation is required for the configured step control mode.

- If SFC charts/types/instances have been modified (SFC properties, sequencer properties, object properties of the steps/transitions) without changing their sequencer topology, you can download the charts after they have been compiled while the CPU is in RUN without having to disable the modified SFC chart.

- If you have not changed the SFC itself, but only the objects that are accessed (for example, a symbol in the symbol table, runtime groups, block I/O), you do not have to disable the SFC before downloading changes.

- Following a download of changes, a disabled SFC with the "Autostart: on" property is not started automatically but must be started again by the operator (MAN) or using the external view/SFC instance (AUTO).
Notes on H CPUs

- If the H CPU is in solo mode, for example, due to the failure of a CPU, and a CPU failover has taken place, when there is an online access, (in this case, downloading changes), a selection dialog box opens. You can select the required CPU in this dialog box. This dialog box does not appear in redundant mode.

- If you download program changes to a CPU that is operating in solo mode and then perform a "switchover with modified configuration" using the menu command PLC > Operating Mode..., these changes are lost and you can only download the entire program.

  **Remedy:** Download in redundant mode. In this case, make sure that the operating state remains unchanged until the download is complete.

Note on F Systems

Downloading changes in programs with a modified F component requires the entry of an F password. Without this legitimating, downloading is aborted.

Including User Data Blocks when Downloading Changes

The "Also download user data blocks" option is used as the default setting and is only relevant for downloading changes. All blocks, even user data blocks, are always downloaded when the entire program is downloaded.

If this check box is selected when you download changes, the following functions are performed for data blocks that are not in the SFC area:

- The data blocks are included in the download if the time stamp is different or data blocks have been added.

- The data blocks are deleted in the CPU if they do not exist in the S7 program.

If you want the user data blocks to be ignored when downloading changes, clear this check box. This can have the following consequences:

- If a user data block exists in the S7 program but does not exist in the CPU, downloading will be aborted with an error message.
You receive a warning under the following conditions:

- When the user data block is present in the CPU but is no longer present in the S7 program
- When the user data block in the S7 program differs from the one in the CPU.

Correct execution of the program is then the user's responsibility.

Note
Note that there is no absolute guarantee that the CPU will be prevented from changing to STOP mode when you download changes.

You can find additional information about this in the CFC documentation under "System Support for Avoiding Causes of CPU STOP".

Downloading a Modified Program to a Test CPU

In the "Download to test CPU (Entire program)" download mode, you can download a modified program to a different CPU or to PLCSIM for testing purposes without losing the ability to download changes to the original CPU.

The entire program is downloaded to the test CPU (or to PLCSIM) without loss of the download identifiers and without the comparison time stamp being written to the ES data management.

You will find detailed information about downloading to the test CPU in the CFC online help under Downloading the Changed Program to the Test CPU.

Displaying Modifications before Loading

The "Show Changes" function is only available if the optional package Version Cross Manager (VXM) is installed and if an image of the downloaded program was generated.

Generating an Image of the Downloaded Program

Assuming you have selected "Generate image of downloaded program for comparison" in the "Settings for Compilation/Download" dialog box, the image will be generated as an XML document and assigned to the program following a successful download operation.
Comparing Programs

If you generated an image of the downloaded program, you can click "Show Changes" in the "S7 Download" dialog box to run a comparison between the XML file and the program you now want to download before it is actually downloaded.

The VXM is then called and runs the comparison. After the comparison you can see which data has changed compared with the downloaded program and decide whether you really want to download the new version.
9 Behavior of the Sequential Control System in the AS

9.1 Sequential Control Systems in the AS

Requirements

- The SFC created with the SFC editor has been specified with the following:
  - The sequencers (start condition and pre/postprocessing) and their sequencer topologies
  - The action functions of the steps
  - The conditions of the transitions
  - The runtime properties
- The program has been compiled and its blocks have been downloaded to the CPU.

Changing the State of the Sequential Control System

After the program has been downloaded to the CPU, the sequential control system is in a defined state. You specify this defined state with the SFC editor (default setting: "Idle"). By assigning start conditions and processing sequences for the sequencers, different sequences are executed in the AS depending of the SFC status.

You can change the runtime behavior as follows.

- You can change operating parameters with the SFC editor for testing and commissioning or on the OS.
  Example: Switch from "Transition (T)" to "Confirmation by operator (C)" step control mode
  or
- Switch the time monitoring from "off" to "on".

In order to achieve a desired operating state, for example, the SFC is influenced using commands that are input by the operator or are applied by the program.
Interaction with the Basic Automation

The sequential control system in the AS relates to the basic automation by means of the action and transition functions. With parameter control, there are also relationships to the parameter data.

Each SFC is assigned a certain runtime behavior. The basic automation, including the blocks located in CFC charts, may have a different runtime behavior from that of the SFC chart. This can be controlled by placing the external view of an SFC chart in the CFC chart. In the same way, an SFC instance is controlled by the blocks placed in the CFC chart.

The structure of the runtime system allows the sequential control system and the blocks of the basic automation to run in different cycles, thereby reducing the cycle load. In the same way, SFCs can be inserted in runtime groups and can thus be given different reduction ratios / phase offsets.
9.2 Specifying the Runtime Behavior

9.2.1 Runtime Behavior of the Sequential Control System

Basics of Runtime Behavior

The behavior of a sequential control system depends on operating parameters "Operating state", "Operating mode", and "Step control mode" and the execution options.

You can set the operating parameters when testing and commissioning or on the OS (SFC Visualization). Exception: The "Autostart" parameter can only be set in the properties dialog box for the SFC chart, SFC type or SFC instance in the "Operating Parameters CPU" tab.

The default settings for the operating parameters are as follows:

<table>
<thead>
<tr>
<th>&quot;Defaults&quot; Group</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Control Mode</td>
<td>T</td>
</tr>
<tr>
<td>Operating Mode</td>
<td>MAN</td>
</tr>
<tr>
<td>Instruction output</td>
<td>On</td>
</tr>
<tr>
<td>Cyclic execution</td>
<td>Off</td>
</tr>
<tr>
<td>Time monitoring</td>
<td>Off</td>
</tr>
<tr>
<td>&quot;Start Options&quot; Group</td>
<td></td>
</tr>
<tr>
<td>Autostart</td>
<td>Off</td>
</tr>
<tr>
<td>Use default operating parameters when SFC starts</td>
<td>Off</td>
</tr>
</tbody>
</table>

The following operating state is set after the CPU starts:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle</td>
<td>(if Autostart = off)</td>
</tr>
<tr>
<td>Starting</td>
<td>(if Autostart = on)</td>
</tr>
</tbody>
</table>

You will find more information on the AUTO/MAN changeover in the section: Operating Modes
9.2.2 Operating Modes

SFC Operating Modes

The operating mode decides whether the running of the program is controlled by
the operator or automatically controlled by the CPU program.

SFC recognizes the following operating modes:

- **AUTO (Process mode)**
  Execution is controlled by the AS program.
  The program uses the parameter assignment and interconnections of inputs in
  the external view of the SFC chart or SFC instance set that you specified in the
  CFC chart to perform control.

- **MANUAL (operator mode)**
  Execution is controlled by operator commands or by changing the execution
  options (for example, with commissioning or SFV).

You can enable the changeover from MANUAL to AUTO or AUTO to MANUAL with
an operator input in test mode or in SFC Visualization or in the interface of the
chart (external view) or the SFC instance. The ENAUT and ENMAN inputs/outputs
are provided for this.

You will find more information on I/Os in the section:
- Modes of the SFC Inputs/Outputs
9.2.3 Step Control Modes

Overview

The various step control modes change the behavior of the SFC when passing control from active steps to successor steps.

You can change the step control mode in all operating states. The individual step control modes are mutually exclusive. SFC recognizes the following step control modes:

<table>
<thead>
<tr>
<th>Code of the switching modes</th>
<th>Control using...</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Transition</td>
</tr>
<tr>
<td>C</td>
<td>Confirmation by operator</td>
</tr>
<tr>
<td>T and C</td>
<td>Transition and confirmation by operator</td>
</tr>
<tr>
<td>T or C</td>
<td>Transition or confirmation by operator</td>
</tr>
<tr>
<td>T / T and C</td>
<td>Step-specific confirmation by operator</td>
</tr>
</tbody>
</table>

Step Control Modes

T

Transition:
The sequential control system is process-driven (running automatically). When a transition is fulfilled, control is passed by disabling the predecessor steps and enabling the successor steps.

Step control mode "T" is possible in MANUAL mode (operator mode) or AUTO mode (process mode).

C

Confirmation by operator:
The sequential control system is controlled exclusively by the operator. The transitions do not need to be fulfilled. An operator prompt is set for all successor transitions of each active step, and the next step is enabled after the operator input.

Step control mode "C" is only possible in MANUAL mode (operator mode).

T and C

Transition and confirmation by operator:
The sequential control system is process-driven and operator-controlled. When the successor transition of an active step is fulfilled, an operator prompt is set and the next step is enabled only after operator input has been made.

Step control mode "T and C" is only possible in MANUAL mode (operator mode).
**Behavior of the Sequential Control System in the AS**

**T or C**
Transition or confirmation by operator:
The sequential control system is process-driven or operator-controlled. An operator prompt is set for each successor transition of an active step, and the next step is enabled after operator input is made. If the transition is fulfilled before the operator input, the next step is enabled without operator input (automatically).

Step control mode "T or C" is only possible in MANUAL mode (operator mode).

**T / T and C**
Step-specific confirmation by operator:
The "Confirmation" label is set or reset on a step-specific basis in the "Properties" dialog box for the step. The sequential control system runs in the following modes:

- **Process-driven** for steps without the "Confirmation" option.
  Each fulfilled successor transition of a step without the "Confirmation" option enables the next step without operator intervention (corresponds to "T").

- **Operator-controlled** for steps with the "Confirmation" option.
  If the successor transition of an active step with the "Confirmation" option is fulfilled, an operator prompt is set and the next step is enabled after operator input (corresponds to "T and C").

Step control mode "T /T and C" is possible in MANUAL mode (operator mode) or AUTO mode (Process mode).

**Note**
In step control modes "C" and "T or C", the minimum run time of the step can be overridden by the operator.
9.2.4 Execution Options

Introduction
You use the execution options to specify the behavior of the sequential control system. The individual execution options can be combined.
You can set the execution options in the "Operating Parameters CPU" tab of the "Properties" dialog box. You open the dialog box with the menu command SFC > Properties....

Execution Options of the SFC

- Instruction output
  If "instruction output: on" is set, the actions of active steps are processed; If "instruction output: off" is set, they are not processed.
  During commissioning, or if errors occur, blocking the instruction output in conjunction with suitable step control modes ("C", "T or C") can bring the sequential control system to a defined state without affecting the process.
  - If instruction output is off, the minimum runtime of a step has no effect.
  - Changing the instruction output first takes effect after transition to the next step. Therefore, either all actions or no actions of a step are executed.

- Cyclic execution
  If "Cyclic execution: on" is set, execution is resumed automatically with "Starting" state after "Completed" state.
  A sequencer that is to be processed in "Completed" state is exited again immediately in cyclic execution. Only the start step and final step are processed.
  - If you are working in MANUAL mode and using SFC inputs/outputs for state control, SELFRESET = 0 must be set in cyclic execution.
  - If you are working in AUTO mode, PARAM = 1 must be set (so that start disable QDIS_START = 0 can be set).
  If "Cyclic execution: off" is set, the sequential control system remains in "Completed" state.
  As long as no command to exit this state is issued, the "Completed" state is processed cyclically on a continuing basis.
  This behavior applies to all operating states that can be exited only by means of commands.
  You will find information on modes in the section: Operating State Logic for SFC (SFC OSL)
• **Time monitoring**
  
  If "Time monitoring: on" is set, after a step has been enabled the active time ("Current run time") of the step is continuously compared with the monitoring time ("Maximum run time") and a step error is reported if the time is exceeded.

  If "Time monitoring: off" is set, there is no comparison of the active time and monitoring time.

• **Autostart**

  When an SFC has the property "Autostart: on", the SFC goes immediately to "Starting" state after a restart in the CPU without any operator intervention. An automatic start does not occur after downloading changes (CPU does not go to STOP). The SFC must be restarted by the operator or via the program (for example, from the external view in the CFC).

  If "Use default operating parameters when SFC starts : on" is set, all the defaults/options set in the runtime properties that, for example, have been changed in test mode are effective again when the SFC chart starts.

  The setting for "Autostart" can only be changed in the SFC > Properties > "Operating Parameters AS" dialog box.

• **Use default operating parameters when SFC starts**

  If "Use default operating parameters when SFC starts : on" is set, all the defaults/options set in the runtime properties that, for example, have been changed in test mode are effective again when the SFC starts.
9.2.5 Operating States

Operating State of the Sequential Control System

The operating state of the sequential control system indicates the current execution status and the operating behavior. For example, you can see if operator intervention is necessary for continued operation or which commands are available for switching to a different operating state.

You can influence the operating state as follows:

- In operator mode (MANUAL) using commands in test mode and in SFC Visualization.
- In process mode (AUTO) using interconnections with the external view of the SFC chart or with the SFC instance.

Operating State Logic

The operating state logic of SFC (SFC OSL) describes the following:

- The possible states of an SFC chart or an SFC instance
- The transitions that are possible in a particular state
- The events that bring about a state transition

In addition to the SFC OSL, there is also a separate simpler operating state logic, i.e., the sequencer OSL, for the sequencers configured in an SFC. It describes the following:

- The possible states of a sequencer
- The transitions that are possible in a particular state
- The events that bring about a state transition

The relationship between SFC OSL and sequencer OSL results from the possibility of being able to execute one (of several) sequencers of the SFC in every state of the SFC OSL.

You will find more information on operating states in the sections:

- Operating State Logic for SFC
- Operating State Logic for SFC
- Commands
9.2.5.1 Operating State Logic for SFC (SFC OSL)

Changing the Operating States
The current operating state of the SFC OSL can be changed through the following events:

- Commands (e.g., Start, Resume, Hold, etc.) in "MANUAL" or "AUTO" mode
- External signals (inputs of the SFC or commands from another SFC, for example)
- Internal signals (commands of own sequencers, from test mode or SFC Visualization).
- Implicit state change

The operating state logic of an SFC is defined by the Diagram of State Changes for SFC OSL.

Notes on Diagram
The SFC OSL contains some state changes that have been retained in order to ensure compatibility with older projects. These are displayed with dashed blue lines in the diagram.

The numbers in the diagram are the identifiers for the individual operating states whose meaning is listed in the following tables.
## Operating States (SFC OSL)

<table>
<thead>
<tr>
<th>No.</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Idle</td>
<td>Initial state; waiting for Start command.</td>
</tr>
<tr>
<td>2</td>
<td>Starting</td>
<td>Start processing after Start command.</td>
</tr>
<tr>
<td>3</td>
<td>Active</td>
<td>Normal processing after completion of the start processing.</td>
</tr>
<tr>
<td>4</td>
<td>Completing</td>
<td>Termination processing after a Complete command or implicit completion.</td>
</tr>
<tr>
<td>5</td>
<td>Error (completing)</td>
<td>Error processing during termination processing.</td>
</tr>
<tr>
<td>6</td>
<td>Completed</td>
<td>Termination processing is complete; waiting for Reset or Start command.</td>
</tr>
<tr>
<td>7</td>
<td>Holding</td>
<td>Hold processing after Hold command.</td>
</tr>
<tr>
<td>8</td>
<td>Held</td>
<td>Hold processing is complete; waiting for Resume command.</td>
</tr>
<tr>
<td>9</td>
<td>Resuming</td>
<td>Continuation processing after Resume command.</td>
</tr>
<tr>
<td>10</td>
<td>Error</td>
<td>Error processing following error.</td>
</tr>
<tr>
<td>11</td>
<td>Held (error)</td>
<td>Error processing is complete and no more errors are present; waiting for Resume command.</td>
</tr>
<tr>
<td>12</td>
<td>Resuming (error)</td>
<td>Continuation processing after Resume command.</td>
</tr>
<tr>
<td>13</td>
<td>Aborting</td>
<td>Cancellation processing after Abort command.</td>
</tr>
<tr>
<td>14</td>
<td>Aborted</td>
<td>Cancellation processing is complete; waiting for Reset or Start command.</td>
</tr>
<tr>
<td>15</td>
<td>Stopping</td>
<td>Stop processing after Stop command.</td>
</tr>
<tr>
<td>16</td>
<td>Stopped</td>
<td>Stop processing is complete; waiting for Reset command.</td>
</tr>
</tbody>
</table>

The following tables describe the transitions between the states (Source State No. / Destination State No.) as well as their triggers.

X = Possible from several states.
## State Changes by Means of Commands (SFC OSL)

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Command MANUAL (AUTO)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>START</td>
<td>Triggers start processing by changing to &quot;Starting&quot; state</td>
</tr>
<tr>
<td>3/4</td>
<td>COMPLETE</td>
<td>Triggers termination processing by changing to &quot;Completing&quot; state</td>
</tr>
<tr>
<td>2/7 3/7</td>
<td>HOLD</td>
<td>Triggers hold processing by changing to &quot;Holding&quot; state</td>
</tr>
<tr>
<td>8/9 11/12</td>
<td>RESUME</td>
<td>Triggers continuation processing by changing to &quot;Resuming&quot; or &quot;Resuming (error)&quot; state</td>
</tr>
<tr>
<td>X/10 4/5</td>
<td>ERROR</td>
<td>Triggers error processing by changing to &quot;Error&quot; or &quot;Error (completing)&quot; state</td>
</tr>
<tr>
<td>X/13 5/4</td>
<td>ABORT</td>
<td>Triggers cancellation processing by changing to &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>X/15</td>
<td>STOP</td>
<td>Triggers stop processing by changing to &quot;Stopping&quot; state</td>
</tr>
<tr>
<td>X/2</td>
<td>RESTART</td>
<td>Triggers start processing by changing to &quot;Starting&quot; state</td>
</tr>
<tr>
<td>X/1</td>
<td>RESET</td>
<td>Changes to &quot;Idle&quot; state</td>
</tr>
</tbody>
</table>
State Changes by Means of External Signals (SFC OSL)

The external signals are inputs of the SFC that enable other blocks (for example, interlock blocks) to influence the transitions between states of the OSL.

However, the external signals work only within the limits of the OSL. Therefore, provision must be made for the state change in the state logic in order for this state change to occur.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4</td>
<td>LOCKCOMPLETE</td>
<td>Trigger termination processing by changing to &quot;Completing&quot; state</td>
</tr>
<tr>
<td>2/7 3/7</td>
<td>LOCKHOLD</td>
<td>Triggers hold processing by changing to &quot;Holding&quot; state</td>
</tr>
<tr>
<td>X/10 4/5</td>
<td>LOCKERROR</td>
<td>Triggers error processing by changing to &quot;Error&quot; or &quot;Error (completing)&quot; state. The error processing is executed completely and the state then changes to &quot;Held (error)&quot;. If an error is pending, the state changes back to &quot;Error&quot; immediately.</td>
</tr>
<tr>
<td>X/13</td>
<td>LOCKABORT</td>
<td>Triggers cancellation processing by changing to &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>X/15</td>
<td>LOCKSTOP</td>
<td>Triggers stop processing by changing to &quot;Stopping&quot; state</td>
</tr>
</tbody>
</table>
State Changes by Means of Internal Signals (SFC OSL)

Internal signals are SFC-internal commands that are set in steps to cause a state change in the SFC. The signals are checked by the OSL and reset automatically after a state change.

The internal signals only work within the limits of the OSL. Therefore, provision must be made for the state change in the state logic in order for this state change to occur.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>INTSTART</td>
<td>Triggers start processing by changing to &quot;Starting&quot; state</td>
</tr>
<tr>
<td>3/4</td>
<td>INTCOMPLETE</td>
<td>Triggers termination processing by changing to &quot;Completing&quot; state</td>
</tr>
<tr>
<td>2/7 3/7</td>
<td>INTHOLD</td>
<td>Triggers hold processing by changing to &quot;Holding&quot; state</td>
</tr>
<tr>
<td>8/9 11/12</td>
<td>INTRESUME</td>
<td>Trigger continuation of processing by changing to the status &quot;Continuing&quot; or &quot;Continuing (error)&quot;</td>
</tr>
<tr>
<td>X/10 4/5</td>
<td>INTERROR</td>
<td>Trigger error processing by changing to the status &quot;error&quot; or &quot;error (finished)&quot;</td>
</tr>
<tr>
<td>X/13</td>
<td>INTABORT</td>
<td>Triggers cancellation processing by changing to &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>X/15</td>
<td>INTSTOP</td>
<td>Triggers stop processing by changing to &quot;Stopping&quot; state</td>
</tr>
<tr>
<td>X/2</td>
<td>INTRESTART</td>
<td>Triggers start processing by changing to &quot;Starting&quot; state</td>
</tr>
<tr>
<td>X/1</td>
<td>INTRESET</td>
<td>Changes to &quot;Idle&quot; state</td>
</tr>
</tbody>
</table>
Implicit State Changes (SFC OSL)

The states "Starting", "Completing", "Holding", "Resuming", "Error", "Resuming (error)", "Aborting", and "Stopping" are transitional states. When a transitional state has been completely executed - in other words, there is no start condition fulfilled for a sequencer or a started sequencer has been completely executed - the state changes to the successor state defined in the OSL (implicit change).

The "Active" state is also treated as a transitional state if SFC input SELFCOMP=1 is set (default for chart and type). Otherwise, the "Active" state can only be exited explicitly with the "Complete" command.

Note

Switching from SELFCOMP=0 to SELFCOMP=1 only has an effect when the "Active" and "Ready to Complete" state have not yet occurred.

Transitional states can, of course, also be exited due to an external problem or with the "Abort" and "Stop" commands. In this case, the appropriate change is executed, and not the implicit change.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>SFC Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/3</td>
<td>Sequencer finished</td>
<td>Start processing finished; change to &quot;Active&quot;</td>
</tr>
<tr>
<td>3/4</td>
<td>Sequencer finished</td>
<td>Normal processing finished; change to &quot;Completed&quot; (prerequisite: external signal SELFCOMP=1)</td>
</tr>
<tr>
<td>4/6</td>
<td>Sequencer finished</td>
<td>Termination processing finished; change to &quot;Completed&quot;</td>
</tr>
<tr>
<td>7/8</td>
<td>Sequencer finished</td>
<td>Hold processing finished; change to &quot;Held&quot;</td>
</tr>
<tr>
<td>x/3</td>
<td>Sequencer finished</td>
<td>Continuation processing finished; change to &quot;Active&quot;</td>
</tr>
<tr>
<td>13/14</td>
<td>Sequencer finished</td>
<td>Cancellation processing finished; change to &quot;Aborted&quot;</td>
</tr>
<tr>
<td>15/16</td>
<td>Sequencer finished</td>
<td>Stop processing finished; change to &quot;Stopped&quot;</td>
</tr>
</tbody>
</table>
State Control using SFC Inputs/Outputs (SFC OSL)

SELFCOMP, SELFRESET, RUNHOLD and CONT are configurable inputs of the SFC and influence the behavior of the OSL.

SELFCOMP is effective in "MAN" and "AUTO" modes.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4</td>
<td>SELFCOMP</td>
<td>SELFCOMP=1 (SFC self terminating): SFC changes by implication from the &quot;Active&quot; state to the &quot;Completing&quot; state after normal processing is completed. SELFCOMP=0 (SFC not self terminating): SFC remains in the &quot;Active&quot; state until the &quot;Complete&quot; command is issued. If there is a state change by means of the &quot;Complete&quot; command, normal processing is aborted if it was not yet completed.</td>
</tr>
</tbody>
</table>

SELFRESET is effective only in "MANUAL" mode.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/1</td>
<td>SELFRESET</td>
<td>SELFRESET=1: In the &quot;Completed&quot;, &quot;Aborted&quot; and &quot;Stopped&quot; states, SFC makes an automatic and immediate change to &quot;Idle&quot; state. The result is that a sequencer is started and immediately aborted in the above states. SELFRESET=0: If the &quot;Completed&quot;, &quot;Aborted&quot; and &quot;Stopped&quot; states have been completely processed, the SFC remains in the corresponding state until the &quot;Reset&quot; or &quot;Start&quot; command is issued (does not &quot;Start&quot; when &quot;Stopped&quot;). Note: In cyclic execution, SELFRESET = 1 must not be set. This causes an error (LI_ERR).</td>
</tr>
</tbody>
</table>

RUNHOLD is effective in "MANUAL" and "AUTO" modes.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>External Signal</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/7</td>
<td>RUNHOLD</td>
<td>RUNHOLD=1: When there is a change from &quot;Active&quot; to &quot;Holding&quot;, the previous sequencer is aborted and the new sequencer is started. RUNHOLD=0: When there is a change from &quot;Active&quot; to &quot;Holding&quot;, the previous sequencer is Held and the new sequencer is started.</td>
</tr>
</tbody>
</table>

CONT

You will find more information on CONT in the section: Continuous Mode
9.2.5.2 Continuous Mode

CONT Status Flag

In AUTO mode, you can use the additive status flag (CONT input and QCONT output) to allow cooperation between a user control system (or SIMATIC BATCH) and SFC. It allows you to restart an SFC without having to first switching it off. The OSL of the SFC remains in "Active" state and sets output QCONT = 1 if RUN = 1 and READY_TC = 1. If QCONT = 1 is set, QCONT_T_ERR = 0 is set. Commands are executed regardless of the status flag.

The SFC can be restarted when READY_TC = 1 is set. This is set by the SFC after processing the final step of the sequencer to be processed in "Active" state. If the same SFC is restarted or aborted, status flag QCONT = 0 is set.

If the SFC has not been restarted within a configured time (CONT_T # ms), the error output QCONT_T_ERR = 1 is set. This output allows individual reactions to the error.

You will find more information on the continuous mode in the sections:

- Starting prerequisites of an SFC
- Continuous operation (SFC connections)
9.2.5.3 Diagram of the State Changes for SFC OSL

State Changes for SFC OSL

1. Idle
   - Start
   - Start only if CONT = 1

2. Starting
   - Hold
   - Error

3. Run
   - SELFCOMP = 0
   - Complete

4. Completing
   - Error
   - Complete

5. Error (Completing)

6. Completed
   - from all states (except Idle, Aborting, Aborted)
   - from all states (except Idle, Aborting, Stopping, Stopped)
   - Abort
   - Stopping

7. Holding
   - Error

8. Held
   - Resume / Start

9. Resuming

10. Error

11. Held (Error)

12. Resuming (Error)

13. Aborting

14. Aborted

15. Stopping

16. Stopped
### Key

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>States that are exited through events</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Transition states that are implicitly exited</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>States applied from BZL for SFC V5</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Events: Commands / Conditions / External Signals / Internal Signals</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Event: Error</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>Implicit transitions that are triggered from SFC, if the active sequencer has been processed to completion or if there is not sequencer to process.</td>
</tr>
</tbody>
</table>
9.2.5.4 Operating State Logic for Sequencers (Sequencer OSL)

Overview

The sequencer OSL controls processing of sequencers.

The operating state logic of the sequencer is defined by the "Diagram of the State Changes for Sequencer OSL".

The sequencer OSL is executed independent of the SFC-OSL when a sequencer is processed. This means that the sequencer has a state which differs from the SFC state. For example, the state of the SFC OSL can be "Holding", whereas the state of the sequencer OSL is "Active" (due to the execution of the sequencer to the "Holding" state). The execution of the sequencer OSL is subordinate to the SFC OSL. This means that the state change in the SFC OSL usually effects the state change in the sequencer OSL.

States of the Sequencer OSL

<table>
<thead>
<tr>
<th>No.</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Idle</td>
<td>Initial state; waiting for Start command</td>
</tr>
<tr>
<td>2</td>
<td>Active</td>
<td>Normal processing</td>
</tr>
<tr>
<td>3</td>
<td>Completed</td>
<td>Normal processing finished; waiting for Start command</td>
</tr>
<tr>
<td>4</td>
<td>Held</td>
<td>Waiting for Resume command</td>
</tr>
<tr>
<td>5</td>
<td>Aborted</td>
<td>Waiting for Start command</td>
</tr>
</tbody>
</table>

State Changes by Means of Commands (Sequencer OSL)

The commands for the sequencer OSL are internal commands of the SFC runtime system.

The following tables describe the transitions between the states (Source State No. / Destination State No.) as well as their triggers.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/2</td>
<td>Start</td>
<td>Triggers sequencer processing by changing to &quot;Active&quot; state.</td>
</tr>
<tr>
<td>2/4</td>
<td>Hold</td>
<td>Holds sequencer processing by changing to &quot;Held&quot; state.</td>
</tr>
<tr>
<td>4/2</td>
<td>Resume</td>
<td>Resumes sequencer processing by changing to &quot;Active&quot; state.</td>
</tr>
<tr>
<td>4/2</td>
<td>Restart</td>
<td>Restarts sequencer processing by changing to &quot;Active&quot; state.</td>
</tr>
<tr>
<td>X/5</td>
<td>Abort</td>
<td>Aborts sequencer processing by changing to &quot;Aborted&quot; state.</td>
</tr>
</tbody>
</table>

X = Possible from several states.
Implicit State Changes (Sequencer OSL)

The "Active" state is a transitional state. An implicit state change to "Completed" state occurs if "Active" and, thus, the sequencer including the final step has been processed completely.

"Active" can, of course, also be exited by means of the "Abort" and "Hold" commands. In this case, the appropriate transition triggered by the command is executed and not the implicit transition.

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Sequence status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/3</td>
<td>Completed</td>
<td>Sequencer processing is complete</td>
</tr>
</tbody>
</table>
9.2.5.5  Diagram of the State Changes for Sequencer OSL

State Changes for Sequencer OSL

Key:

- States that are changed due to commands/operations
- Operator commands
- Implicit transitions triggered by the SFC
9.3 Executing the SFC in the AS

9.3.1 Executing an SFC

Introduction
In the following description of the basic principles of cyclic execution of an SFC, it is assumed that the SFC contains several sequencers with user-defined start conditions.

How it Works
The SFC is executed based on the input signals pending in the SFC interface and the internal status of the SFC. After an entire chart folder has been downloaded to the automation system, all the SFCs are in "Idle" state or "Starting" state if Autostart = 1 is set. The following is checked:

- The operating mode, commands, and external and internal signals are checked. This determines the state the SFC should take based on the input signals.
- All start conditions of the sequencers are checked. This determines which sequencer is to be processed based on the preceding checks.

SFC Status Unchanged
If the SFC status is unchanged, the sequencer whose start condition is fulfilled and has the highest priority of all sequencers with a fulfilled start condition is executed. If there are several sequences with a fulfilled start condition and the same priority, then the sequencer with the tab furthest left in the editor is executed (similar to the execution of alternative branches). If the sequencer that was processed up to now is different from the sequencer that is to start processed now, the previous sequencer is aborted and the new sequencer starts.

The start condition triggers the start of a sequencer. While the sequencer is being processed, it is not necessary for the start condition to remain fulfilled. The sequencer is processed until it is completed or until a sequencer with a higher priority and fulfilled start condition has to be processed or the sequencer is aborted or held due to a state change.

In the "Idle", "Completed", "Aborted", "Stopped", "Held", "Held (error)", "Error" and "Active" states (when SELFCOMP=0), sequencers are processed until the state is exited by means of a command. A sequencer can, therefore, be repeated any number of times when the corresponding start condition is fulfilled and no command is pending. To prevent this behavior, you can configure the final transition of the sequencer with an unfulfilled condition. This causes the sequencer to "hang" at this transition and to exit only following a command.
SFC Status Changed

If the SFC status has changed, the SFC processes the previous sequencer and the new sequencer according to the state change that has taken place:

If the state change is from "Active" to "Holding", the previous sequencer is held or aborted (depending on RUNHOLD) and the new sequencer starts.

If the previous sequencer has been completely processed, the state changes from "Resuming" or "Resuming (Error)" to "Active". The new sequencer is resumed or started (depending on RUNHOLD) at the change from "Resuming" and is started at the change from "Resuming (error)".

If there is an implicit state change, the change is executed when the sequencer of the first transitional state has been processed completely and is therefore terminated. If there is no sequencer with a fulfilled start condition, the implicit change is executed immediately and the new sequencer starts.

With all other state changes resulting from commands, external or internal signals, the previous sequencer is aborted if it has not yet been processed completely and the new sequencer starts.

Notes

- When a sequencer aborts, the active steps are always processed completely followed by the final step. The completion of the active steps and the initialization or processing of the final step are processed in one cycle.

- A sequencer can be processed in an SFC even if the SFC has not received a start command. This is then the case when, for example, in the status "Ready" the start condition of one or several sequencers is fulfilled or sequencers exist, whose starting conditions are indicated independently of states.
Coordination of Sequencers and Target Steps

You can influence the start behavior of a sequencer that will become active in the future by setting a target step for this sequencer in step actions of the current sequencer (for example <SFCName>.TARGETSEQ:=2; <SFCName>.TARGETSTEP:=5). This corresponds to setting a target step manually during testing and commissioning; however, the difference in this case is that all other target steps of the sequencer including those set manually are reset. This means that you can specify the required start step for the sequencer to be started at any time.

TARGETSEQ = 0 is set when the step action has been executed.

Note that target steps cannot be set in simultaneous branches.

Example: By setting <SFCName>.TARGETSEQ:=2 and <SFCName>.TARGETSTEP:=0, all the target steps in the sequencer with number 2 are cleared.

A target step is taken into account when a sequencer starts or resumes and is then deleted.

Since the required execution and the target step both generally depend on the prior execution of the SFC, you can query the last active sequencer and the last active step in a transition condition (for example <SFCName>.LASTSEQ:=3; <SFCName>.LASTSTEP:=2) to set different target steps depending on the result of the query.

Sequences and steps are identified by their number. These are displayed in the "Properties" dialog boxes and can be used to configure target steps.

Cooperation between Operator Control or SIMATIC BATCH and SFC

If an SFC instance is being used by SIMATIC BATCH, the following process occurs:

- SIMATIC BATCH sets the input OCCUPIED = 1.
- The SFC sets the output QOCCUPIED = 1 and the occupied code (bit 24) for BA_STATE.
- OCCUPIED and QOCCUPIED are set to 0 by SFC with a reset (transition to "Idle").

If OCCUPIED is removed by SIMATIC BATCH itself, the output QPARAM = 0 is also set. This means that any pending, incorrect setpoint is no longer checked, i.e. an error is not displayed (LI_ERR = 0).
9.3.2 Executing an SFC after CPU Stop and Restart

Startup Characteristics

When the CPU goes into the stop state, the running sequencer stops at the step it is currently executing. When the CPU is restarted, the SFC is initialized and the data valid before the stop occurred is lost. The property of the SFC is the default state.

If you want the SFC to retain its state when the CPU restarts, you need to set the AS operating parameter defaults correspondingly (Chart > Properties > tab: Operating Parameters CPU > SFC Startup after CPU Restart > Option: Retain SFC state).

The operator can decide how the SFC should continue execution based on the SFC and process state.

Another factor to be considered is whether the CPU went to stop during the execution of a block or the execution was completed. If the first case is true, the data are inconsistent. The following procedure needs to be performed as a result:

Procedure after Restart

Requirement: The SFC is in the "Idle" state or a sequencer is active in the "Idle" state.

<table>
<thead>
<tr>
<th>Command</th>
<th>Execution dbname</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>SFC continues in the &quot;Idle&quot; operating state, whereby all sequencers are initialized.</td>
</tr>
</tbody>
</table>

CPU stop occurs during the block processing (inconsistent data)

<table>
<thead>
<tr>
<th>Command</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume</td>
<td>SFC resumes in the current operating state</td>
</tr>
<tr>
<td>Abort</td>
<td>SFC aborts according to the OSL</td>
</tr>
<tr>
<td>Stop</td>
<td>SFC stops according to the OSL</td>
</tr>
</tbody>
</table>

The "Resume" command is always allowed regardless of the operating state, but the "Abort" and "Stop" commands are only permitted when they conform to the state transitions of the SFC OSL.

The state symbols are displayed and the "CPU_RESTART" output is set until one of the commands is executed (Resume, Abort, Stop, Reset).
You can use the TRIG_CPU_RESTART output for the start condition of the sequencers that should be executed after the CPU restart. This output is only set by the system and must be reset by a configured actions (such as step action TRIG_CPU_RESTART = 0).

**Note**

After the CPU restart, the ENRESUME, ENABORT, ENSTOP and ENRESET are not considered for the command buttons Resume, Abort, Stop and Reset.

**Display in Test Mode**

In test mode, the steps for a CPU stop and after a CPU restart are accordingly identified.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU stop</td>
<td>🔄</td>
</tr>
<tr>
<td>CPU restart and SFC with consistent data</td>
<td>⛔️</td>
</tr>
<tr>
<td>CPU restart and SFC with inconsistent data</td>
<td>⚠️</td>
</tr>
</tbody>
</table>

The symbols for "CPU restart and SFC with inconsistent data" and "CPU restart and SFC with inconsistent data" are also displayed in the operator control and display section.

**Additional Information**

You will find more information on this subject in the following sections:

- States of the Steps and Transitions
- Display in Test Mode
9.3.3 Commands

Introduction

Regarding the commands for changing the operating mode, there is a distinction between commands for "MANUAL" and "AUTO" modes.

Commands for "MANUAL" Mode

In "MANUAL" mode, you can set or modify the operating states using the buttons of the operator interface in SFC test mode or in SFC Visualization (you can find information about this in the "MANUAL Commands for the SFC" table below). The ability for the operator to issue commands depends on the operating state and the command enables "EN......".

Commands for "AUTO" Mode

In "AUTO" mode, depending on the command enables "EN....", the commands are issued using the interface inputs "START, ....." by assigning parameters or interconnecting to a higher-level automatic controller.

Commands for Both Operating Modes

Regardless of the operating mode and the command enables, you can issue interlock commands via the "LOCKCOMPLETE, ....." interface inputs.

Again regardless of the mode and the command enables, you can issue the commands via the (IN_OUT) "INSTART, ....." interface inputs in the object properties of the steps. These commands are reset after they have been executed; in other words, when the state changes.

You will find more information on this subject in the section "Commands and Operating States of the SFC Inputs/Outputs" in "Explanation of the Commands and Operating State Changes".

Note

The commands arranged as buttons in the control section of the online window (test mode) are effective for the SFC chart or SFC instance only and not for sequencers.
## MANUAL Commands for the SFC

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>⏯️</td>
<td>Start</td>
<td>Triggers start processing by changing to &quot;Starting&quot; state</td>
</tr>
<tr>
<td>⏳️</td>
<td>Hold</td>
<td>Triggers hold processing by changing to &quot;Holding&quot; state</td>
</tr>
<tr>
<td>⏰️</td>
<td>Resume</td>
<td>Triggers continuation processing by changing to &quot;Resuming&quot; or &quot;Resuming (Error)&quot; state</td>
</tr>
<tr>
<td>✗️</td>
<td>Abort</td>
<td>Triggers cancellation processing by changing to &quot;Aborting&quot; state</td>
</tr>
<tr>
<td>✔️</td>
<td>Complete</td>
<td>Triggers termination processing by changing to &quot;Completing&quot; state</td>
</tr>
<tr>
<td>⏞️</td>
<td>Stop</td>
<td>Triggers stop processing by changing to &quot;Stopping&quot; state</td>
</tr>
<tr>
<td>🔁️</td>
<td>Restart</td>
<td>Triggers restart processing by changing to &quot;Starting&quot; state</td>
</tr>
<tr>
<td>⚡️</td>
<td>Reset</td>
<td>Changes to &quot;Idle&quot; state</td>
</tr>
<tr>
<td>🚨</td>
<td>Error</td>
<td>Triggers error processing by changing to &quot;Error&quot; or &quot;Error (completing)&quot; state</td>
</tr>
</tbody>
</table>

The effect of commands are graphically illustrated in the "Diagram of the State Changes for SFC OSL".
9.3.4 Priority of the Commands

Executing Multiple Commands Simultaneously

If several commands are queued simultaneously, for example, external and internal commands, an interconnection error is displayed (LI_ERR=1). The commands are then executed as follows:

- The commands "Start", "Restart", "Resume", "Reset" and "Complete" are ignored and not executed.
- From the commands "Abort", "Stop", "Error" and "Hold", the command with the highest priority is executed. "Abort" has the highest priority and "Hold" has the lowest.

Examples:

<table>
<thead>
<tr>
<th>Commands</th>
<th>Reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start + Reset</td>
<td>No command is executed</td>
</tr>
<tr>
<td>Complete + Hold</td>
<td>&quot;Hold&quot; is executed</td>
</tr>
<tr>
<td>Abort + Hold</td>
<td>&quot;Abort&quot; is executed</td>
</tr>
</tbody>
</table>

Note
The origin of the commands is not relevant here (for example, operator input, LOCKxx, INTxx, BA_CONTROL) Even if only a single command of the pending commands is permitted in the current state, this is nevertheless not executed if it belongs to the group of commands to be ignored.

Additional Information
For more information, refer to the section: Start Requirements of an SFC (Chart/Instance)
9.3.5 **Start Requirements of an SFC (Chart/Instance)**

**General Requirements**

An SFC is started only when the requirements for starting are fulfilled. The start enable must be set (ENSTART = 1) and the SFC must be in a state in which starting is permitted. The following conditions must also be met:

- There is no interlock error (LI_ERR = 0).
- None of the signals INTERERROR, LOCKERROR, LOCKCOMPLETE, LOCKHOLD, LOCKABORT or LOCKSTOP is active at the same time.
- There is no operator error in MANUAL mode (OP_ERR = 0).

If you are using control strategies for an SFC instance, you must have selected one of the defined control strategies (CS=<defined control strategy>). With CS=0 or CS>CS_HL, it is not possible to start the SFC instance. If you have not configured any control strategies, the CS, CS_LL, CS_HL inputs/outputs are assigned the value 0 during compilation and must not be modified.

If you are using setpoints, you must specify them within the respective limits. Otherwise it is not possible to start the SFC instance.

With an SFC instance in AUTO mode, you must have set the parameter transfer (PARAM=1) before starting. The transferred control strategies and setpoints are then checked and the start disable reset (QDIS_START=0) if the parameters are valid. The start disable remains set until a PARAM is set by a parameter transfer. Following a successful start, the start disable remains until the next parameter transfer.

If one of the conditions above is not fulfilled, the start disable (QDIS_START=1) is set and the start is not executed. The "Start" button is not enabled in this case.
Starting in the "Active" State

To be able to start in "Active" state, you must have set the additional start enable (ENASTART=1) and deactivated the self termination (SELFCOMP=0).

In AUTO mode, you must have also activated continuous mode (CONT=1).

The start condition of the sequencer that is to be processed in the "Active" state must also ensure that the sequencer has not already been processed completely (READY_TC=0). This prevents the sequencer from being repeated cyclically under certain circumstances because the start condition is satisfied.

Example of the start condition:

RUN=TRUE AND READY_TC=FALSE.

When an SFC starts, the finished ID is reset (READY_TC=0) and after complete execution of the sequencer in "Run" state it is set again (READY_TC=1).

Restart in the "Held / Held (Error)" State

ENSTART = 1 and ENRESTART = 1 must be set to be able to restart in the "Held / Held (Error)" state.

You will find more information on simultaneous pending commands in the sections:

- Priority of the Commands
- Continuous Mode
9.3.6 Executing the SFC Elements

9.3.6.1 Runtime Phases of a Step

Runtime Phases

Each step is divided into three phases (actions):

- Initialization: Action for initial processing
- Executing: Action for cyclic processing
- Termination: Action for final processing

The following figure shows the runtime phases of a step in conjunction with a successor transition: On the left are the elements of the sequencer topology and on the right the corresponding runtime phases.
9.3.6.2 Executing a Step and Transition

Executing a Step and Transition

The **start step** is enabled when the sequential control system starts without querying conditions, and its actions are executed.

A (normal) **step** can have "active" and "inactive" states. A step becomes active after the preceding transition passes control to it. The actions are then triggered and controlled. A step becomes inactive after the successor transition is fulfilled.

If there is an abort, the termination processing of the previously active step is still executed and the initialization of the final step is activated (overlapping in the same cycle).

A **transition** can have "FALSE" and "TRUE" states. The state of the successor transition of the active step is checked. If a successor transition is fulfilled and the step enabling condition is true, the previous step is disabled and the next step is enabled. The transition is not checked in accordance with the step control mode until any configured minimum run time has expired.

The actions of the **final step** are executed once only.

When the chart progresses from one step to the next, the termination action is executed in the same cycle as the first action (initialization or processing) of the next step.

This allows the "non-latching behavior" specified in IEC 1131 - 3 to be achieved.
Example:
In step S4, the processing phase opens a valve and the termination phase closes it again. If the same valve is opened again in the first action of the next step (S5), the overlapping of the two actions (both in one cycle) means that the valve is not closed.

Special Situations

The example in the schematic shows the time behavior when all three actions of a step are configured.

Other combinations are also possible:

- If no "initialization" action is configured, the "processing" action begins immediately when the step is enabled.
- If no "termination" action is configured, the step is disabled immediately as soon as the transition is fulfilled.

The minimum time that a step is active depends on the number of configured actions. This is one or two actions with a normal step, and up to three actions with a final step.

If a minimum run time is set for the step, the step remains active for at least this time even if the transition condition is fulfilled earlier.

9.3.6.3 Executing a Simultaneous Branch

Executing a Simultaneous Branch

Simultaneous branches are executed in one cycle. In so doing, the simultaneous branches are executed independent of each other.

The transition after the simultaneous branch becomes true when all steps at the end of the sequencers are active and the conditions are fulfilled.
9.3.6.4 Executing an Alternative Branch

Executing an Alternative Branch

The sequencer that is executed in an alternative branch is the one whose transition condition is fulfilled first.

If several conditions are fulfilled at the same time, the transition that is located furthest left in the sequencer topology is activated.

Note

In an alternative branch, there must not be no unassigned transition at the start of a sequencer.
Reason: Unassigned transitions are always preset to TRUE and are therefore automatically fulfilled. This means that they are always fulfilled before an assigned transition.

9.3.6.5 Executing a Loop

Executing a Loop

The figure below shows the execution phases of a loop: On the left are the elements of the sequencer topology and on the right the corresponding phases in execution.
9.3.6.6 Executing a Jump

Executing a Jump

The jump is executed when the transition of the jump is satisfied.

Example on the left in the figure: If there is more than one jump following the origin of a jump (S4), then – similar to processing in an alternative branch - the jump whose transition is fulfilled first is executed. If several transitions are fulfilled at the same time, the transition that is located furthest left is activated.

Example on the right in the figure: If an alternative branch follows instead of a successor transition (such as T4 in the left configuration) in the sequencer, all the transitions of the alternative branch (T5 and T7) are queried before the transitions of the jumps.
9.4 Changing Control Strategies and Setpoints

9.4.1 Changing the Control Strategy and Setpoints for an SFC Instance

Introduction

You can change the control strategy and/or setpoints before restarting an SFC instance or change the setpoints and apply them immediately.

Changing Control Strategy and Setpoints

There are two mechanisms for changing the control strategy and/or setpoints:

1. Changing the control strategy and/or setpoints and applying them at the next start

   In AUTO mode, proceed as follows:

   Use the PARAM and START inputs/outputs. The CS inputs for the control strategy and <setpoint> for the setpoints are assigned the new values and then PARAM input = 1 is set. The QPARAM output signals that a change of control strategy and/or setpoints at the next start has been requested; the output is reset after the start. When the SFC instance starts, the control strategy and/or setpoints are applied.

   In MANUAL mode, follow the steps outlined below:

   Set the appropriate enables for changing the control strategy ENCSP or the setpoints <setpoint>_ENOPP, to allow changes to be performed. This enables the corresponding input options in the faceplate for SFC instances.

   The inputs CSP_OP for the control strategy and <setpoint>_OPP for the setpoints are assigned the new values. You can do this in CFC test mode directly in the SFC instance or in the faceplate of the SFC instance in the "Prepared values" tab. The control strategy and/or setpoints are applied when the start is executed.

   If the values are valid, they are displayed at the outputs QCSP for the control strategy and <setpoint>_QP for the setpoints in both modes. If the limits for the control strategy or setpoints are exceeded, this is displayed at the corresponding outputs <setpoint>_ERR. Invalid values are not applied to the outputs QCSP or <setpoint>_QP. After the start, the current control strategy is displayed at the QCS output and the current setpoints at the <setpoint>_Q outputs (QCS = QCSP, "sw"_Q = "sw"_QP).
2. Changing setpoints and applying them immediately

This mechanism cannot be used to change the control strategy.

In **AUTO mode**, proceed as follows:

Use the TAKESP input/output. The inputs `<setpoint>` for the setpoints are assigned the new value and the TAKESP input is set. The setpoints are adopted immediately if the TAKESP input is set and no error has been found in the setpoints (high/low limit). The QTAKESP output signals that an immediate change of setpoints was requested.

The PARAM signal must always be set when setpoint changes are made because the setpoints are checked and adopted in the prepared values only when PARAM is set. Only checked values are applied at START or TAKESP.

In **MANUAL mode**, follow the steps outlined below:

You must set the appropriate enables for changing the setpoints `<setpoint>_ENOP` to allow changes to be made. This enables the corresponding input options in the faceplate for SFC instances.

The `<setpoint>_OP` inputs for the setpoints are assigned the new values. You can do this in the CFC test mode directly in the SFC instance or in the faceplate of the SFC instance in the "Current values" tab. The setpoints are applied immediately.

**Note on Working in the Faceplate:** The control of setpoints must be enabled on the "Current values" page. To do this, the "Current setpoints" page changes enabled' property must have been selected in the faceplate picture "@pg_@sfc_type_actualsp.pdl".

You can find additional information on this in the online help of **SFC Visualization**.

Assuming the values are valid, they are displayed at the `<setpoint>_Q` outputs for the setpoints in both modes. If the limits for the control strategy or setpoints have been exceeded (error case), this is displayed at the corresponding outputs `<setpoint>_ERR`. Invalid values are not applied at the `<setpoint>_Q` outputs.
Summary

In both mechanisms, the output CSSP_ACCEPT indicates whether or not the requested changes were applied. This output is set after applying the control strategy and/or setpoints by the SFC instance at the relevant outputs. The CSSP_ACCEPT output is set for one processing cycle (for 1.) or remains set until the TAKESP request is reset (for 2.).

Output LI_ERR indicates whether or not an error occurred when attempting to apply value changes with the result that the values could not be completely applied. If LI_ERR is set, QDIS_START is not reset and a start and, thus, the adoption of the control strategy and/or setpoints is prevented (for 1.).

9.4.2 Tracking the Control Strategy and Setpoints in AUTO Mode

Tracking the Control Strategy and Setpoints

"Tracking" involves writing back of the current control strategy and setpoint values to the corresponding operator inputs (only in AUTO mode). As a result, the setpoints of the last active control strategy used is immediately available at the next start.

<table>
<thead>
<tr>
<th>Control strategy tracking:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MAN → At start if CSP_DEFAULT &gt; 0 : CSP_OP = CSP_DEFAULT</td>
<td></td>
</tr>
<tr>
<td>AUTO → if CSP_DEFAULT &gt; 0 : CSP_OP = CSP_DEFAULT</td>
<td></td>
</tr>
<tr>
<td>if CSP_DEFAULT = 0 : CSP_OP = QCSP</td>
<td></td>
</tr>
</tbody>
</table>

Setpoint tracking:

<table>
<thead>
<tr>
<th>&lt;Setpoint&gt;_OP</th>
<th>=</th>
<th>&lt;Setpoint&gt;_Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Setpoint&gt;_OPP</td>
<td>=</td>
<td>&lt;Setpoint&gt;_QP</td>
</tr>
</tbody>
</table>
10 Testing and Commissioning Sequential Control Systems

10.1 Operator Control and Monitoring during Testing

Overview
Test functions are integrated in the SFC editor for the following tasks to provide support for commissioning:
- Monitoring the work process of the sequential control system
- Influencing the operating modes
- Changing setpoints

Test Modes
You can start test mode in either of the following test operating modes:
- Process mode
- Laboratory mode

You can select the test operating mode while in edit mode using the menu commands in the "Debug" menu. You cannot switch once you are in test mode.

In process mode, the communication for the online dynamic display of the SFC charts and SFC instances is restricted to keep the load on the CP and bus to a minimum. If overload occurs in this test operating mode, a message is displayed indicating that the limit of the bus load has been reached. In this case, stop the testing of the SFCs that are not absolutely necessary for the test.

In laboratory mode, communication for the online dynamic updates of the SFCs is unrestricted. Use laboratory mode to perform convenient and efficient testing and commissioning.
Setting the Test Environment

With the menu command Debug > Test Settings..., you can open a dialog box in which you can change the monitoring cycle for the current program (default: 2 s.). The cycle time is uniformly stored with the CFC in the chart folder. This means that the same monitoring cycle is valid for both applications (SFC and CFC).

Note
If the cycle time is changed in the SFC chart, this affects charts/instances with dynamic properties. A change in CFC affects only newly registered SFC charts/instances.

Requirements

• The sequential control system (chart or instance) to be tested including the necessary basic automation functions (CFC charts) have been compiled without errors and downloaded to the CPU.
• The chart is open in SFC or SIMATIC Manager, the SFC instance is open in the CFC chart.

Note
With S7, loading into the CPU - and working in test mode - are functions that are logged if the SIEMATIC Logon Service is installed and the access protection and change log are activated.

Information in this regard is available in the CFC documentation under Change Log and ES Log.
Activating Test Mode

Click the icon in the toolbar
or
select the menu command Test > Test Mode.
You change from edit mode to test mode.
You can switch back to edit mode at any time during testing.

Note
Make sure that the sequential control system is not waiting for operator input when you switch to edit mode.

The mode switch always relates to the currently active SFC. The overview display of this SFC is dynamically and cyclically updated.

After you have switched to test mode, the current state of the sequential control system is displayed. This does not mean that a sequential control system that has already started can necessarily be monitored or controlled from the start. For example, this is the case with sequential control systems that are started immediately after they are downloaded to the AS without requiring any operator command (autostart).

Note on H CPUs
If the H CPU is being operated in solo mode, for example, due to CPU failure, and a CPU failover has taken place, if there is online access (here: Activate Test Mode), a selection dialog is displayed. You can select the required CPU in this dialog box. This dialog box does not appear in redundant mode.
Operator Control and Monitoring

You operate and monitor the sequential control system in the overview display of the SFC. Here, you can change the operating states, operating modes, step control modes, and the execution options as required.

Open the properties if you wish to see and/or modify the values of the individual steps.

If you double-click on a step or a transition, a dialog box appears similar to the object properties dialog box in edit mode.

The actions of the steps can be viewed in two different modes, i.e. the tabs exist twice. In normal view, the interconnecting information is displayed, in the additional view the OS comment is also shown. In the Object Properties of the transition, you will see in the formulated condition in the "Current Cond." tab and the OS comment of the current condition in the "OS Comment" tab.

You can also open the object properties for the step and transition at the same time. To do this, select the required transition and double-click a step to open both dialog boxes (or in the opposite order: select a step and double-click a transition). The step and transition do not need to be associated in order to be able to see both dialog boxes at the same time.

A selected element in the sequencer is indicated by a blue background.

Tooltips for Steps and Transitions

Instead of opening the object properties to get specific information, you can also do the following:

- **Step**: If you position the mouse pointer on a step, the name, number, run times, comments and acknowledgement information are displayed.
- **Transition**: If you position the mouse pointer on a transition, the name, number, run times and comments are displayed.

Acknowledging in the Sequencer and in the Object Properties Dialog

If a button is displayed for operator prompt acknowledgement or error acknowledgement for the monitored step or transition in the sequence, the object properties dialog box also has the corresponding button or buttons added to it.

In case of a step runtime error, the step is returned to the state which it had before the error occurred (active = "green", for example) after the error has been acknowledged.
Acknowledgement information

In the object properties of the step you can assign parameters for acknowledgement information. In Step Control Mode "Step-specific Confirmation by Operator (T/T and C)" this acknowledgement information is displayed at the associated acknowledgement button for an operator prompt. The text can be positioned as required using the mouse pointer, it remains connected with the button over a connecting line.

Changes during Testing (SFC chart only, not SFC instance)

The step attributes (confirmation, minimum/maximum run time, constant in assignments) and transition attributes (constant in conditions) that can be modified in test mode are adopted in the CPU and in the ES data management when the change is made and do not require recompilation and download.

Note

If you want to modify existing SFC instances, you must exit test mode and then change the corresponding SFC type. After compiling and downloading the changes, all the instances are automatically adapted.

Changing Characteristics during Testing (SFC instance only)

The characteristics "Mode" and "Setpoint values" can be changed as described in the section Changing the mode and setpoints of an SFC instance.

You can influence the "process values", "parameters", "timers" and "block contacts" characteristics in test mode of the CFC at the corresponding inputs/outputs of the SFC instance if the inputs/outputs are not already interconnected with blocks.

The "control values" and "bit memory" characteristics cannot be modified in test mode.

Trace

In test mode, you can use the Debug > Trace menu command to specify that the active sequencer is always displayed automatically. If this menu command is not set, the explicitly selected sequencer is displayed.

Note

When tracing is activated, you can only open the object properties of a step or transition that is currently active. If you open object properties of a step or transition that is not active, a dialog box appears asking if you wish to disable the tracing.
Testing a Single Sequence

If you cannot test a single sequencer without its functions affecting other sequencer, you can use the following procedure:

1. Copy the sequencer to a separate SFC chart or SFC type.
2. Adapt the start conditions (for example, RUN = TRUE).
3. If the sequencer is in an SFC type: Generate an SFC instance.
   After starting, the sequencer is executed immediately.
4. After making any necessary corrections and testing again, copy the sequencer back to the original SFC chart or SFC type.

You will find more information on test mode in the sections:

- Display in Test Mode
- Properties of a Step during Testing
- Properties of a Transition during Testing
- Properties of a Sequencer during Testing
10.2 Display in Test Mode

Layout of the SFC Window

The window of the SFC chart or SFC instance in test mode has an extra control and display section at the bottom edge of the window compared to edit mode. All operator inputs relate to the chart or the instance (not to the sequencer).
The following elements are shown in the control and display section (from left to right):

- **First row:**
  - Symbol and name of the SFC mode
  - Status display and name of the active sequencer
  - Status display and name of the held sequencer
  - Field with drop-down list for displaying and changing the switching modes

- **Second row:**
  - The current operating mode (MANUAL/AUTO)
  - Status flag "CONT" (continuous mode) for bumpless switching to AUTO mode (for example, to avoid an SFC having to be switched off before it is restarted). This is displayed when output QCONT = 1.
  - Status display "READY T.C." (Ready to complete), when the SFC is not self terminating (SELFCOMP = 0) and is waiting in the active state for the "Complete" command (display, when READY_TC = 1).
  - The  display for CPU restart with consistent data or
  - The  display for CPU restart with inconsistent data
  - The  display for an interconnection error (or empty field)
  - The  display for an operator error (or empty field)
  - The  display for a step error (or empty field)
  - The display  for an operator prompt: (or empty field)
  - The  button for group acknowledgement

- **The buttons:**
  - For selecting "MANUAL" or "AUTO" mode
  - For enabling changeover to "AUTO"  
    After the changeover enable, the icon changes to  

• The buttons of the commands:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Start]</td>
<td>![Hold]</td>
<td>![Continue]</td>
</tr>
<tr>
<td>![Abort]</td>
<td>![Complete]</td>
<td>![Stop]</td>
</tr>
<tr>
<td>![Restart]</td>
<td>![Reset]</td>
<td>![Error]</td>
</tr>
</tbody>
</table>

• The check boxes for enabling and disabling the execution options "instruction output", "cyclic execution", and "time monitoring".

**Operator Prompt**

An operator prompt (not with "T") is displayed by the [button] beside the transition icon. After clicking the button (or [button]) and continuing execution, the operator prompt disappears.

When an acknowledgement was configured for the step, this is displayed in the switching mode "Step-specific acknowledgement by operator (T/T and B)" at the associated acknowledgement button. The text can be positioned as required using the mouse pointer, it remains connected with the button over a connecting line.

**Runtime Error**

The [button] is only displayed when a runtime error [button] is displayed for the current step. You click this button (or [button]) to acknowledge the pending errors. After acknowledgment, the appearance of the step returns to the state it had before the error occurred (active = "green", for example).
Display of the States

In test mode of the SFC, both the SFC and the sequencers with their start conditions are made dynamic. The name and status of the SFC and the name and status of the sequencer that is currently being executed are displayed in the title bar of the SFC window. The start condition and the execution of the sequencer are also displayed.

The various states of the sequential control system, the sequencer, the steps and the transitions are visualized by different colors or icons.

In addition to the color frame of the steps, a status indicator also appears. The icon of the status indicator is therefore an additional visualization of the current operating state in the chart in case the colors cannot be clearly distinguished. You cannot change the colors of the state indicators.

You will find more information on displaying the states in the sections:

- Icons for Operating States
- States of the Steps and Transitions

Display of the CPU Operating Mode

The operating mode of the CPU is displayed in the status bar (right information box): green + RUN, red + STOP. Test mode is also indicated: (Laboratory) or (Process).

Display of the Sequencer

If the SFC contains more than one sequencer, the following is displayed based on the setting in the "Debug" menu:

- The active sequencer is always displayed automatically (menu command Debug > Trace set)

or

- The explicitly selected sequencer is displayed (menu command Debug > Trace not set)
10.3 States of the Steps and Transitions

<table>
<thead>
<tr>
<th>Step state</th>
<th>Step color</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive, not executed</td>
<td>Gray</td>
<td></td>
</tr>
<tr>
<td>Inactive, executed</td>
<td>Dark green</td>
<td>✓</td>
</tr>
<tr>
<td>Active</td>
<td>Light green</td>
<td>▶</td>
</tr>
<tr>
<td>Held</td>
<td>Yellow</td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td>Red</td>
<td></td>
</tr>
<tr>
<td>CPU stop (not with &quot;inactive, not executed&quot;)</td>
<td>Red</td>
<td>❌</td>
</tr>
<tr>
<td>After CPU restart (consistent)</td>
<td>Magenta</td>
<td></td>
</tr>
<tr>
<td>After CPU restart (inconsistent)</td>
<td>Magenta</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transition state</th>
<th>Transition color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive</td>
<td>Gray</td>
</tr>
<tr>
<td>Fulfilled</td>
<td>Dark green</td>
</tr>
<tr>
<td>Unfulfilled</td>
<td>Dark red</td>
</tr>
</tbody>
</table>
10.4 Icons for Operating States

<table>
<thead>
<tr>
<th>Icon</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Aborting</td>
<td>Processing after Abort command.</td>
</tr>
<tr>
<td>✗</td>
<td>Aborted</td>
<td>Cancellation processing is complete; waiting for Reset or Start command.</td>
</tr>
<tr>
<td>▶</td>
<td>Active</td>
<td>Processing after ending the processing in the &quot;Starting&quot; state.</td>
</tr>
<tr>
<td>●</td>
<td>Held</td>
<td>Cancellation processing in &quot;Held&quot; is complete; waiting for &quot;Resume&quot;, &quot;Abort&quot;, or &quot;Stop&quot; command.</td>
</tr>
<tr>
<td>✷</td>
<td>Held (Error)</td>
<td>Error processing is complete no more errors pending; waiting for &quot;Resume&quot;, &quot;Abort&quot;, or &quot;Stop&quot; command.</td>
</tr>
<tr>
<td>●</td>
<td>Holding</td>
<td>Processing after &quot;Hold&quot; command.</td>
</tr>
<tr>
<td>✔</td>
<td>Completing</td>
<td>Processing after &quot;Complete&quot; command or after implicit complete.</td>
</tr>
<tr>
<td>✔</td>
<td>Completed</td>
<td>Processing in &quot;Completing&quot; state is complete; waiting for &quot;Reset&quot;, &quot;Start&quot;, &quot;Abort&quot;, or &quot;Stop&quot; command.</td>
</tr>
<tr>
<td>🔴</td>
<td>Idle</td>
<td>Processing in initial state; waiting for &quot;Start&quot; command.</td>
</tr>
<tr>
<td>❌</td>
<td>Error</td>
<td>Processing after &quot;Error&quot; command.</td>
</tr>
<tr>
<td>❌</td>
<td>Error (closing)</td>
<td>Processing after &quot;Error&quot; command in &quot;Closing&quot; state.</td>
</tr>
<tr>
<td>✔</td>
<td>Resuming</td>
<td>Processing after command &quot;Reset&quot; or &quot;Start&quot;.</td>
</tr>
<tr>
<td>✷</td>
<td>Resuming (Error)</td>
<td>Processing after command &quot;Reset&quot; or &quot;Start&quot;.</td>
</tr>
<tr>
<td>🔴</td>
<td>Stopped</td>
<td>Processing in &quot;Stopped&quot; state completed, waiting for command &quot;Start&quot; or &quot;Reset&quot; or &quot;Abort&quot;.</td>
</tr>
<tr>
<td>✔</td>
<td>Starting</td>
<td>Processing after command &quot;Start&quot; or &quot;Restart&quot;.</td>
</tr>
<tr>
<td>🔴</td>
<td>Stopping</td>
<td>Processing after command &quot;Stopping&quot;.</td>
</tr>
</tbody>
</table>

Only operating states displayed in **bold** letters apply to sequencers.
10.5 Properties of a Step during Testing

Tabs of the "Properties" Dialog Box

The "Properties" dialog box of the step is divided into 7 tabs:

- **"General" Tab**

  The "Name" box has a frame, its color corresponds to the state of the step and is updated continuously. All occurring colors are listed in the "Default Colors" table.

  If you select the "Confirmation" check box, you set a flag that is evaluated in the "T / T and C" step control mode (step-specific confirmation by operator). This can only be modified in the SFC chart. The sequential control system runs as follows:

  - **Process-driven** for steps without the "Confirmation" option.
    Each fulfilled successor transition of a step without the "Confirmation" option enables the next step without operator intervention (corresponds to "T").

  - **Operator-driven** for steps with the "Confirmation" option.
    If the successor transition of an active step with the "Confirmation" option is satisfied, an operator prompt is set and the next step is enabled after the prompt has been confirmed (corresponds to "T and C").

If you select the "Target step" check box, the current step is selected as the target step (shown in the sequencer by: to the left of the step). This option can only be modified for the SFC chart and the SFC instance and not in the sequencer "Active" state.

Setting the target step means that:

- The inactive sequencer starts at the selected target step instead of at the start step when it is next processed.

- The held sequencer resumes at the target step when the continuation follows proper processing of the interrupted steps.

The target step marker is valid only for the next "Start" or "Resume" command. When these commands are executed or when the CPU is restarted, the target step marker is cleared.
You can also select several steps as the target step. The user is responsible for selecting the target steps in a proper way so as to ensure their processing without the formation of blockades or loops. Comprehensive information on this can be found under Processing an SFC.

**Note**

- If you use "programmed target steps", the target steps sent by the operator in the corresponding sequences are deleted.
- Target steps set in "MANUAL" mode are not deleted when there is a changeover to "AUTO".
- Setting or deleting target steps is possible only when ENTARGETSTEP = 1 is set.

You can change the "minimum run times" and "maximum run times" parameters for SFC charts. If you click in the edit box, an additional dialog box opens in which you can enter a new time. Any changes you make are entered in the ES data management when you click "OK" and take effect in the next execution cycle in the AS.

You can use the "Current run times", "Time to minimum" and "Time to maximum" fields to monitor the run time.

If no values were configured for the runtimes (time = 0), the individual fields box display "- - -".

In the field "Comment" you will see the comment of the step.

In the field "Acknowledgement information", you'll see the text that is to be displayed to the operator in the mode "Step-specific acknowledgement by the operator (T/T and B)" as information.

The information appears in test mode or in the SFC visualization on the corresponding acknowledgement button. The text can be positioned anywhere in the window but remains linked to the button with a connection line.

- **"Initialization", "Processing", "Termination" Tabs**

  On the left next to the first address there is a box displaying the current value of the address. The box on the right next to the second address contains the configured value that you can change (only in the SFC chart). If you click in the box, you open the "Change Value" dialog box, in which you can enter the new value.

  After you close the dialog box, the changed value is written to the ES data management (and in the CPU) and becomes effective in the next processing cycle.

- **Register "OS comment" (initialization), (processing), (completion)**

  In these registers you can see the initialization, processing, or completion actions. The middle column does not show the interconnection information, however, as it does in the Initialization, Processing and Termination tabs. Here it shows the configured OS comment. All other details are the same.
Buttons

If a time error occurs in the time monitoring of a step and the button for acknowledging the step runtime error is displayed next to the affected step, the button is also displayed in the dialog box. This allows you to acknowledge the error from the dialog box.

Note
When a step runtime error occurs, the step is returned to the state that it had before the error occurred (for example, active = "green") after the error has been acknowledged.

You can use the "Go To" button of an SFC chart to jump from the current address box to its point of use, for example, to the block in the CFC chart or to the I/O address in HW Config (not possible for an SFC instance).
10.6 Properties of a Transition during Testing

Tabs of the "Properties" Dialog Box

The "Properties" dialog box of the transition has four tabs:

- **General**
  The "Name" box has a frame, its color corresponds to the state of the transition and is updated continuously. All occurring colors are listed in the "Default Colors" table.

- **Current Cond.**
  This tab shows the current state of the conditions.

- **OS Comment**
  In this tab, you see the current values and the states of the transition logic, as shown in the "Current Cond." tab. The difference to the "Current Cond." tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.

- **Previous Cond.**
  This tab shows the state of the conditions of the previous processing cycle.

- **Cond. after Error**
  This tab shows the state of the conditions that led to an error

"Current Cond." Tab

There are boxes with the current value of the address on the left next to the first address and on the right next to the second address. In the SFC chart, you can change the content of both boxes (not possible with an SFC instance). If you click in one of the boxes, the "Change Value" dialog box opens where you can enter the new value for the address.

After you close the dialog box, the changed value is written to the ES data management (and to the CPU) and becomes effective in the next processing cycle.

The results of the Boolean logic operations for the conditions are visualized as colored connecting lines of varying thickness.

- A wide, green line means "fulfilled".
- A thin, red line means "unfulfilled".
- A thin, black line means "inactive".
"Previous Cond." and "Cond. after Error" Tabs

The content of these tabs is not automatically updated; they therefore have an additional "Update" button. The state of the transition is entered here as it was at the time when the object properties were opened. You can display the current state in a permanently open dialog box by clicking "Update". The values of the addresses cannot be changed.

Buttons

If an operator prompt is displayed for the monitored transition in the sequencer and the button is displayed beside the transition, the dialog box also has the button added to it. This allows you to acknowledge the operator prompt from the dialog box.

You can use the "Go To" button of an SFC chart to jump from the current address box to its point of use, for example, to the block in the CFC chart or to the I/O address in HW Config (not possible for an SFC instance).
10.7 Properties of a Sequencer during Testing

Tabs of the "Properties" Dialog Box

The "Properties" dialog box of the sequencer is divided into 7 tabs:

- **General**
  The "Name" box has a frame, its color corresponds to the state of the transition and is updated continuously. All occurring colors are listed in the "Default Colors" table.

  The "Comment" box displays the configured comment for this sequencer.

  You can see the priority of the sequencer in the "Priority" box. The priority decides which sequencer of a chart is started when the start conditions of several sequencers are met simultaneously.

- **Start condition**
  Each line represents one condition. Of the maximum 16 conditions, 2 x 5 are visible on the first page and 2 x 3 on the second page. You can move to the second page by clicking "Arrow" on the last operator.

  There are boxes with the current value of the address on the left next to the first address and on the right next to the second address. The values can only be changed for the SFC chart.

- **OS Comment (Start Condition)**
  The difference to the "Start Condition" tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.

- **Preprocessing**
  In this tab you view the actions for preprocessing of the current sequencer. The values can only be changed for the SFC chart.

  Each line represents one statement. Up to 50 statements are possible. The section of displayed statements can be moved with the scroll bar at the right of the window.

  Each statement consists of a left address, an operator, and a right address.

  There are boxes with the current value of the address on the left next to the first address and on the right next to the second address. If you click in one of the boxes, the "Change Value" dialog box opens where you can enter the new value for the address. After you close the dialog box, the changed value is written to the CPU and takes effect in the next execution cycle. A constant in the right address box is also written to the ES data management.

- **OS Comment (Preprocessing)**
  The difference to the "Preprocessing" tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.
• **Postprocessing**
  In this tab, you see the actions for postprocessing of the current sequencer. The values can only be changed for the SFC chart. The structure of the tab is identical to the "Preprocessing" tab (see relevant section).

• **OS Comment (Start Condition)**
  The difference to the "Preprocessing" tab here is that there is a column with the OS comments instead of columns with the formulated conditions. All other details are the same.
11 Documenting Programs

11.1 Documenting SFCs

Overview
The documentation of SFC charts/types.instances includes the following:

- Printout of the SFC in a variety of layouts
- Parameter assignments
- Properties
- Chart reference data

Specifying the Page Layout
If you want to change the layout, proceed as follows:
1. Select the menu command SFC > Page Setup....
   A dialog box opens.
2. Select the paper format (e.g., "A4", "A4 with margin") in the drop-down list box.

Previewing the Printout
1. Select the menu command SFC > Print Preview....
   The pages to be printed are displayed on the screen.
2. Check the layout.
   You can start the printout from this preview.
Printing an SFC

1. Click the icon in the toolbar or
   Select the menu command **SFC > Print...**
   A dialog box opens.

2. Here, you make settings for the print scope and the layout:
   - **Print What:**
     - Properties
     - Interface inputs/outputs
     - External view (for SFC chart) or characteristics (for SFC type/instance)
   - **Sequencers:**
     - Properties
     - Normal size
     - Overview (you can select either normal size or overview, but not both).
   - **Steps/Transitions**
   - Options (only with "Normal size"):  
     - Alternative branch aligned left
     - Comment/text
11.2 Chart Reference Data

Starting the Application

1. Select the menu command Extras > Chart Reference Data...
   or click the icon.
   The chart reference data are opened with an empty window.

2. In the "View" menu, select the list containing the information you want to display or click the corresponding icon in the toolbar.
   The list with the current reference data opens.

You do not need to close the window with the chart reference data if you want to continue working in SFC. You can view the generated lists while continuing your work in SFC.

Chart Reference Data

You can display and print the following chart reference data:

Run Sequence
The graphical display shows the entire run sequence of a CPU.

Cross-References Chart Element > Address
The list includes all shared addresses used in the project along with the elements that access them.

Cross-References SFC > Chart Element
The list shows all existing accesses from SFC charts to the inputs/outputs of CFC chart elements.

Cross-References Chart Element > Runtime Group
The list shows all existing accesses from CFC charts and SFC charts for all runtime groups.

Block Interconnections
The list shows all block interconnections of the project.

Accesses in SFC Types
The list shows all read and write accesses occurring within an SFC type.

Block Types
The list shows the utilized block types and their points of use (CFC chart).

S7 Resource Allocation
The list shows the assignment between CFC configuration objects and S7 resources.

Local Data
The list shows all the OBs in the program along with the calculated local data requirements and the local data amount of the individual priority classes that was configured offline and the local data amount that actually exists online.
Block Call Hierarchy
The graphical display shows the call hierarchy of all blocks in the current program.

Textual Interconnections
The list shows all textual interconnections (path reference to the interconnection target) with the chart name and chart element of the interconnection source.

Statistics
The graphical display shows the quantity of utilized CFC and SFC objects and S7 resources, the time stamp of the current program and the process objects of the project.

You will find a detailed description of the lists and the meanings of the columns in the CFC online help "Chart Reference Data" in the section: Layout of the Chart Reference Data

Export
You can save the generated lists as a file in CSV format (for use in Microsoft EXCEL, for example) by selecting the menu command Reference Data > Create Export File....
11.3 Logs

Saving and Printing Logs

The menu command **Options > Logs...** opens a dialog box with several tabs. The tabs are only available when the corresponding functions have been previously executed.

Saving the log file and printing always relates to the currently open tab.

Tabs

"Compile" tab

List of the messages that occurred during compilation (including the compiler messages); for example, if the project contains a program but no station. Example message: "The program is not assigned to an actual CPU."

"Check Consistency" tab

List of the messages that occurred during the consistency check.

"Download" tab

List of the messages that occurred during a download, for example, if the download was free of errors: Example message: "0 errors and 0 warnings found".

"ES Log" tab

Log of all protected actions (download, test mode). This requires that the SIMATIC Logon Service is installed.

"Step Processing" tab

After checking the SFC runtime behavior with the menu command **Options > Check Step Processing**, this tab lists the steps that use the same address in the terminating action of one step and in the initializing action or processing action of the next step. The log shows how many SFC charts were checked and how many accesses were found and the SFC charts with an unchanged runtime behavior.

"Convert Format" tab

After converting charts of older versions to V5.1 or later, the charts that no longer have the same properties are listed here. These include, for example, the SFC charts that had the attributes "scan rate" and "phase offset" in the older version. The information includes the insertion location (task) and the values for the scan rate and phase offset for every chart affected. Example: "SFC1: Task OB32 scan rate 4 phase offset 2"

"Make Textual Interconnections" tab

The menu command **Options > Make Textual Interconnections** is used to make all textual interconnections that are assigned to a definite interconnection partner in the current chart folder. The textual interconnections made with this action are displayed along with error messages indicating the textual interconnections that could not be made for one reason or another.
11.4 Defining Footers

Overview

The menu command **SFC > Footers...** opens a dialog box where you can enter the text to be displayed in the footers on every printed page.

With the DOCPRO optional package, you can print the SFC chart/type together with footer data. A distinction is made between global data and specific data (local data) for footers.

You can enter the global data for the project using DOCPRO or SIMATIC Manager; the specific data must be entered with the SFC editor. Remember that the specific data overwrites the entries of the global data for the particular SFC.

You can enter specific data even if you have not installed the DOCPRO optional package. These data are saved and can be printed later when DOCPRO is available for print jobs.

Specific Footer Data

You can enter the SFC-specific footer data in the active tabs "Part 1" to "Part 4" and "Available Fields". These include document type, date created, document number, dates of changes or free texts.

Keywords in Footers

In the global footers, you can enter keywords that will be replaced by current texts in the printout. Below, you can see the available keywords and their meaning:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Designation</th>
<th>Meaning</th>
<th>DOCPRO key</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$CN$$</td>
<td>Name</td>
<td>Name as entered in the properties.</td>
<td>$54</td>
</tr>
<tr>
<td>$$CC$$</td>
<td>Comment</td>
<td>Comment text as entered in the properties.</td>
<td>$60</td>
</tr>
<tr>
<td>$$A$$</td>
<td>Author</td>
<td>Name as entered in the properties.</td>
<td>$55</td>
</tr>
<tr>
<td>$$DC$$</td>
<td>Date created</td>
<td>Date as entered in the properties.</td>
<td>$56</td>
</tr>
<tr>
<td>$$DM$$</td>
<td>Last modified</td>
<td>Date as entered in the properties.</td>
<td>$57</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>$$CH$$</td>
<td>Project path</td>
<td>Path, as entered in the properties</td>
<td>---------</td>
</tr>
<tr>
<td>$$PP$$</td>
<td>Storage location of project</td>
<td>Where the project is physically stored, as entered in the properties</td>
<td>---------</td>
</tr>
</tbody>
</table>
Using DOCPRO Keys

If you are using DOCPRO V5.1 and create new projects, you can define the keys using DOCPRO keys. This means that you do not have to enter the keywords in SFC in the footers; these are, however, still supported. You still have to make the entries in older projects.

---

**Note**

If you print other objects (for example STL blocks or the DOCPRO content directory) with the keywords used in SFC, the keywords themselves appear in the printout for these objects and not the replacement. This problem no longer exists if you use DOCPRO keys.

---

When using DOCPRO keys, you must change the standard layout in DOCPRO. You can replace the default footers with specific footers in the "Modify Layout" dialog box. You can find information about this in the DOCPRO online help or in the DOCPRO manual: Creating Documentation in Conformance with Standards.

The keys for "project path" and "Location of the project" (in the lower part of the table) must continue to be used since there are no DOCPRO keys for them.
12 Configuring Parameter Controls

12.1 Parameter Control

Parameter Control

In addition to fixed sequential control systems, parameter controls are also used in batch processes. Parameter controls are sequential control systems with variable parameters.

These variable parameters are compiled in a shared data block (recipe data block). You can give the recipe data block a symbolic name, for example, "RecParDB".

The variables of the recipe data block are values assigned to the parameters of the basic automation during configuration.

You will find more information on parameter control in the sections:

- How to Configure the Execution
- Execution with Different Parameter Sets
- Example of a Recipe Data Block
12.2 How to Configure the Execution

Procedure
You configure the execution of the parameter control with the SFC editor. The procedure is similar to the configuration of the sequential control system. You assign the values from the recipe data block to the parameters of the basic automation in the "Object Properties" dialog box.

Example: Configuration of a Step
The following data is entered in the basic automation from the recipe data block "RecParDB" in the "Object Properties" dialog box for the step (example):

```plaintext
ctrllr_1.w := "RecParDB".etmp
ctrllr_4.w := "RecParDB".itmp
```

Example: Configuration of a Transition
In the "Object Properties" dialog box for the transition, a recipe parameter is used to specify the sequencer of an alternative branch that is to be executed:

```
Transition: Querying recipe data
Reg. figure:
```

<table>
<thead>
<tr>
<th>Condition in T2</th>
<th>&quot;RecParDB&quot;.altzwg</th>
<th>= 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition in T3</td>
<td>&quot;RecParDB&quot;.altzwg</td>
<td>= 2</td>
</tr>
<tr>
<td>Condition in T4</td>
<td>&quot;RecParDB&quot;.altzwg</td>
<td>= 3</td>
</tr>
</tbody>
</table>
12.3 Execution with Different Parameter Sets

Changing on the OS

If you change the content of the recipe data block, parameter control can also run with different parameter sets. You change the parameters on the OS.

Examples

The examples below show the various ways in which you can change the content of the recipe data block.

- You can integrate the variables of the recipe data block as modifiable variables in the OS process pictures and specify the current values of the variable on the OS before starting the parameter control.
- You store various recipe parameter sets in the AS. The alternative statement of a recipe parameter set for the recipe data block can result in an alternative branch in the "T and C or "C" step control mode, for example.

Step: Alternative application of recipe data from different data blocks

Reg. figure:

<table>
<thead>
<tr>
<th>Instruction in Par1</th>
<th>&quot;RezParDB&quot;.chbez : = &quot;RezParDB1&quot;.chbez</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instruction in Par2</td>
<td>&quot;RezParDB&quot;.ansmng : = &quot;RezParDB1&quot;.ansmng</td>
</tr>
<tr>
<td>Instruction in Par3</td>
<td>&quot;RezParDB&quot;.chbez : = &quot;RezParDB2&quot;.chbez</td>
</tr>
<tr>
<td>Instruction in Par3</td>
<td>&quot;RezParDB&quot;.ansmng : = &quot;RezParDB2&quot;.ansmng</td>
</tr>
<tr>
<td>Instruction in Par3</td>
<td>&quot;RezParDB&quot;.chbez : = &quot;RezParDB3&quot;.chbez</td>
</tr>
<tr>
<td>Instruction in Par3</td>
<td>&quot;RezParDB&quot;.ansmng : = &quot;RezParDB3&quot;.ansmng</td>
</tr>
</tbody>
</table>
• In the OS process picture, you have included the modifiable variables "Batch ID" and "Amount". By calling an appropriate user block in the parameter control, the parameters in the recipe data block "RecParDB" are adapted relative to a standard batch.

Step: Activate a user block for adapting amounts

Reg. figure:

<table>
<thead>
<tr>
<th>Instruction in ANW</th>
<th>ANW.EN</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>:= 1</td>
</tr>
</tbody>
</table>
12.4 Example of a Recipe Data Block

Recipe Block "RecParDB"

The table contains an example of a "RecParDB" recipe block.

<table>
<thead>
<tr>
<th>Tag name</th>
<th>Type</th>
<th>Value</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bantam</td>
<td>STRING[8]</td>
<td>'ch_4711'</td>
<td>Batch ID</td>
</tr>
<tr>
<td>vol</td>
<td>INT</td>
<td>2000</td>
<td>Amount in liters</td>
</tr>
<tr>
<td>reapr</td>
<td>INT</td>
<td>3</td>
<td>Reactor pressure in bar</td>
</tr>
<tr>
<td>etmp</td>
<td>INT</td>
<td>90</td>
<td>External temp in deg. C</td>
</tr>
<tr>
<td>ltmp</td>
<td>INT</td>
<td>125</td>
<td>Internal temp. in deg. C</td>
</tr>
<tr>
<td>tott</td>
<td>INT</td>
<td>110</td>
<td>Total reaction time in min.</td>
</tr>
<tr>
<td>stvol</td>
<td>INT</td>
<td>1000</td>
<td>Standard amount in liters</td>
</tr>
<tr>
<td>altseq</td>
<td>INT</td>
<td>3</td>
<td>Alternative branch</td>
</tr>
</tbody>
</table>

END_STRUCT
13  **Tips & Tricks**

13.1  **Configuring SFC Calls**

**Tasks**

You can use the SFC to perform the following tasks:

- Configuring hierarchical SFC chart calls
- Coordinating processing of multiple SFC charts in the automation system

**Configuring Hierarchical SFC Chart Calls**

You configure hierarchical SFC chart calls in the SFC coordination chart ("SFC Coord" chart controls "SFC Slave1" and "SFC Slave2") as follows:

- Configure the preceding transition to the next step (to coordinate SFC Coord with SFC slave1; in other words, SFC Coord waits for the termination of SFC Slave1, if this is still running). Enter the condition in the "Properties" dialog box of the transition:
  \[\text{SFC Slave1.BUSY = OFF}\]
- Configure the step for activating SFC Slave1. Enter the statement in the "Initialization" tab of the "Properties" dialog box for the step:
  \[\text{SFC Slave1.INTONOFF := ON}\]
- Configure the successor transition for the step above (to coordinate SFC Coord with SFC Slave1, in other words SFC Coord waits for termination of SFC Slave1). Enter the condition in the "Properties" dialog box of the transition:
  \[\text{SFC Slave1.BUSY = OFF}\]

SFC Slave2 is now controlled by SFC Coord.

No special configuration is necessary for SFC Slave1 and SFC Slave2.

**Coordinating the SFC Charts**

You coordinate multiple SFC charts (SFC Chart1 and SFC Chart2) using data cells (such as bit memory, data block elements) that are set in SFC Chart1 (statement in a step) and read in SFC Chart2 to enable the next step (condition in a transition).
13.2 Converting Older Projects

Using the New SFC Runtime System

Before the new functions of the SFC runtime system can be used, the data is converted the first time you write to projects of an earlier version and the FB 300 SFC runtime system is replaced following a prompt for confirmation.

You then compile and download the program as follows:

1. Select the menu command SFC > Compile...
   The program is compiled.

2. Select the menu command PLC > Download... and then "Download: Changes" with the automation system in RUN (or STOP) mode.
   The program is downloaded. Switch off all active charts in the corresponding dialog box.

3. Switch all active charts back on in the corresponding dialog box.

You can find additional information about converting older projects to SFC Version V7.0 in the manuals for PCS 7 Software Updates.

SFC Control Block

When V5 ES data are converted to V6 ES data, the SFC control block (SFC_CTRL) is eliminated and replaced by the external view of the SFC chart. All the positioned SFC control blocks are deleted and replaced in each case by the external view of the SFC chart that displays the interface of the SFC chart as a block. The settings of the SFC control block parameters and its interconnections are applied to the external view. The runtime behavior of the SFC chart is not changed.

The position in the run sequence is now also no longer important (in the past it was necessary to ensure that SFC_CTRL was installed before the SFC chart in the run sequence).

Control Strategies and/or Setpoint Changes for Projects Created with SFC < V6.1 SP1

To make control strategy and/or setpoint changes effective, the block FB 245 must be copied from the SFC library to the block folder prior to the change followed by compilation of the entire program and download of the changes.

For more information, refer to the section: Changing the Control Strategy and Setpoints for an SFC Instance
Index

:configure .............................................. 6-25

A
Absolute addressing .............................................. 6-51
Accessing structures ............................................ 6-41
adapting chart properties ...................................... 5-1, 5-2
instance properties .............................................. 5-4
Addresses valid entries ........................................ 6-38
Addressing absolute ............................................ 6-51
symbolic ...................................................... 6-52
ALARM_8P ..................................................... 5-7
Alternative branch creating ...................................... 2-20, 5-13
in the AS ..................................................... 9-36
Attributes for characteristics .................................. 5-15, 5-16
Adapting chart properties ...................................... 5-1, 5-2
instance properties .............................................. 5-4
Addresses valid entries ........................................ 6-38
Addressing absolute ............................................ 6-51
symbolic ...................................................... 6-52

B
BATCH parameters .............................................. 6-105
SFC inputs/outputs ............................................ 6-105
Bit memory ..................................................... 6-9
Block Contacts .................................................. 5-10, 5-13, 5-14
Block I/Os filtering ............................................ 6-40
Blocks generated during compilation .......................... 7-6

C
Changing control strategies and setpoints for an SFC instance .............................................. 9-38
control strategies subsequently ................................ 5-11
display size in the SFC ......................................... 3-2
window selection .............................................. 3-17
Changing the configuration of the SFC chart .............. 4-9
doing the SFC instance ........................................ 4-16
of the SFC type ................................................ 4-13
Characteristic attributes ....................................... 5-15, 5-16, 5-17, 5-18
input/outputs .................................................. 5-13
Characteristics attribute ........................................ 5-8, 5-9, 5-13, 5-15, 5-16, 5-17, 5-18

control contacts .............................................. 6-91
control strategies .............................................. 6-74
control values .................................................. 6-89
note text ....................................................... 6-75
parameters ....................................................... 6-90
position texts .................................................... 6-75
process values .................................................. 6-89
setpoints ....................................................... 6-77
timers ........................................................... 8-91

SFC type ....................................................... 7-1
SFC chart ....................................................... 7-1
SFC calls ....................................................... 7-1
SFC ............................................................. 4-2
SFC chart ....................................................... 4-7
SFC instance .................................................... 4-14

SFC for SIMATIC S7
ASE00807946-01
Index-1
Index

G
- Generated blocks ........................................ 7-6
- SFC .................................................. 7-6, 7-7
- Getting started ........................................ 1-6
- Group acknowledgements ............................... 6-103
- SFC inputs/outputs ................................... 6-103
- Group displays ......................................... 6-103
- SFC inputs/displays .................................. 6-103

H
- Help ..................................................... 3-17
- opening with the keyboard ............................. 3-17

I
- Icons .................................................... 10-12
- operating states ...................................... 10-12
- in the AS ............................................... 9-34
- Input/output groups ................................... 5-13
- inputs/outputs .......................................... 5-13
- SFC chart ............................................. 6-65
- Inputs/outputs
  - for characteristics .................................. 5-13
  - Inputs/Outputs ...................................... 5-13, 5-65, 6-73
- SFC chart ............................................. 6-73
- Inputs/outputs of standard interface .................. 6-67
- SFC type .............................................. 6-67
- Inserting/creating .................................... 5-9
- SFC elements .......................................... 5-9
- Instance properties ................................... 5-4
- adapting ............................................... 5-4
- Interface editor ...................................... 5-8
- Interface expansions for characteristics
  - [SFC inputs/outputs] ................................ 6-76
  - Interface expansions for inputs/outputs .......... 6-73
  - interface parameter assignments of
    characteristics ...................................... 6-74
  - Interface parameter assignments of
    characteristics
  - SFC inputs/outputs ................................ 6-74
- Introduction .......................................... 1-1
- SFC .................................................... 1-1

J
- Jump ..................................................... 2-22, 3-16, 9-37
- creating ............................................... 6-16
- editing ................................................ 6-16
- in the AS ............................................. 9-37

K
- Key combinations .................................... 3-10
- for menu commands ................................... 3-10
- Keyboard .............................................. 3-10
- Keyboard operation ................................... 3-14, 3-15, 3-16, 3-17
- Keyboard operations .................................. 3-10

L
- Layout .................................................. 3-8
- dialog box ............................................ 3-8
- LI_ERR.................................................. 6-107, 6-108, 6-109
- Loop .................................................... 2-21, 3-14, 9-36
- creating .............................................. 6-14
- editing ................................................ 6-14
- in the AS ............................................. 9-36

M
- Managing ................................................. 4-2
- charts ................................................. 4-4
- SFC ..................................................... 4-2
- MANUAL commands .................................... 9-29
- Meaning and Usage of Inputs/Outputs
  for Setpoints ......................................... 6-85
- Menu .................................................... 3-14
- operation ............................................. 3-14
- Messages .............................................. 6-110
- SFC inputs/outputs .................................. 6-110
- Messages in SFC ..................................... 5-6
- configuring .......................................... 5-6
- Migration from older projects ....................... 13-2
- Modes
  - SFC inputs/outputs ................................ 6-92
- Moving ............................................... 4-19, 4-21, 5-26
- SFC chart ............................................ 4-19
- SFC element .......................................... 6-26
- SFC instance ........................................ 4-21
- SFC type ............................................. 4-21

N
- Navigating .............................................. 3-2
- im SFC ................................................. 3-2
- Note text
  - configuring ........................................ 5-12
- Note texts ............................................ 5-9, 5-12, 6-75
- characteristic ....................................... 6-75
- NOTIFY ............................................... 5-7

O
- Object properties .................................... 6-25
- OCCUPIED ............................................ 9-25
- OP_ERR.................................................. 6-107, 6-108, 6-109
- Opening ............................................... 3-17, 4-17, 4-18
- Help with the keyboard ............................... 3-17
- SFC chart / SFC type ................................ 4-17
- SFC instance ......................................... 4-18
- Operating modes ..................................... 6-92
- 9-4
- Operating state logic ................................ 9-20
- for sequencers ...................................... 9-20
- Operating state logic for SFC ....................... 9-10
- Operating states ..................................... 6-94, 9-9, 10-12
- icons ............................................... 10-12
- S7 ....................................................... 9-9
- SFC inputs/outputs .................................. 6-94
- Operation ............................................ 3-14, 3-15
- dialog boxes ......................................... 3-15

SFC for SIMATIC S7
ASE00807946-01
Index-3
OSL for SFC ................................................ 9-18
OSL for sequencers..................................... 9-22
Runtime behavior........................................... 9-3
Runtime attribute.......................................... 6-56
Reserves.................................................... 6-117
OSL..........................9-13, 9-14, 9-15, 9-16, 9-20
for sequencers ........................................ 9-22
diagram .................................................. 9-22
OSL for SFC .................................................... 9-16
diagram .................................................. 9-16
Overview .................................................. 7-6
of blocks generated during compilation ... 7-6
Parameter control ........................................ 12-1, 12-3, 12-4
classifying execution .................................... 12-2
Example of a Recipe Data Block ...................... 12-5
execution with different parameter sets .......... 12-3
Parameter sets ........................................... 12-3
different .................................................. 12-3
Parameters ................................................ 5-9
Position texts............................................ 5-10, 5-12, 5-13, 5-15, 5-17, 5-19
characteristic ........................................... 5-5
Postprocessing .......................................... 2-13, 5-5
Preprocessing .......................................... 2-13, 5-5
Printing ..................................................... 11-5
logs .......................................................... 11-5
Priority ..................................................... 3-10
commands .................................................. 9-28, 9-30
commands .................................................. 9-28, 9-30, 9-32
Process values .......................................... 6-9
Programmed target steps ....................... 6-94
Programs .................................................. 8-1, 8-4, 8-6
  downloading ........................................... 8-2, 8-3, 8-4, 8-5
Project structure .................................... 4-1
  creating ................................................ 4-1
Properties ................................................ 10-13, 10-17
  of a step during testing ......................... 10-18
  sequencer during testing ....................... 10-18
  transition during testing ...................... 10-16
Recipe data block .................................... 12-5
Reserves .................................................. 6-117
SFC inputs/outputs .................................. 6-117
Resource requirements ................................ 7-6, 7-7
Run sequence........................................... 7-6
  editing .................................................. 5-56
Runtime attribute..................................... 6-56
Runtime behavior...................................... 9-3
Runtime phases ........................................ 9-33
  step .................................................... 9-33
Runtime properties ................................... 6-54
  SFC ..................................................... 6-54
Saving .................................................... 11-5
Saving/printing logs .................................. 11-5
documenting ............................................ 11-5
printing .................................................. 11-5
saving .................................................... 11-5
Selecting ................................................ 3-16, 3-20, 3-21, 6-22
text with keyboard ..................................... 3-16
when editing steps/transitions .................... 6-22
with the keyboard ..................................... 6-21
with the lasso .......................................... 6-21
with the mouse ......................................... 6-20
Selection criteria ..................................... 1-1
SFC chart ................................................ 1-1, 1-2, 1-4
SFC type .................................................. 1-1, 1-3, 1-4
Sequence ................................................ 2-18, 3-17, 8-10
creating .................................................. 8-10
Shortcut with keyboard ................................ 3-17
Sequence control ..................................... 6-25
Sequence .................................................. 1-5, 2-13, 9-23, 9-24, 9-25
Sequencer ........................................... 6-29, 6-30
  copying/moving ...................................... 6-8
  creating ............................................... 6-8
  deleting .............................................. 6-5
  editing sequencer properties .................... 6-29
  execution ............................................. 9-23, 9-25
Sequence Elements .................................. 2-14
Sequence OSL ............................................ 6-29
Sequence template .................................... 6-5
Sequence topology ................................... 6-3, 6-4
  creating ............................................... 6-3
  Sequencers ............................................ 9-23
  execution ............................................. 9-23
Sequential control system ....................... 1-4, 1-5, 5-1, 5-3, 6-9, 6-10, 5-11, 8-13
  .............................. 8-14, 8-16, 8-18, 8-20, 8-21, 8-22, 8-23
  .............................. 5-26, 5-28, 5-29, 5-31, 6-33, 6-35, 6-43
  configuring ......................................... 6-46, 6-47, 6-49, 6-54, 6-55, 6-56
  .............................. 6-46, 6-47, 6-49, 6-54, 6-55, 6-56
  .............................. 6-46, 6-47, 6-49, 6-54, 6-55, 6-56
  .............................. 6-46, 6-47, 6-49, 6-54, 6-55, 6-56
  .............................. 6-46, 6-47, 6-49, 6-54, 6-55, 6-56
  copying ................................................ 6-35
Sequential control systems in the AS .............9-1
  in the AS .............................................. 9-2
  in the AS .............................................. 9-3, 9-4, 9-5, 9-7, 9-8, 9-9, 9-28, 9-29
  in the AS .............................................. 9-3, 9-33, 9-34, 9-35, 9-36, 9-37
  configuring ........................................... 4-2
  in the AS .............................................. 9-1, 9-2
  in the AS .............................................. 9-3, 9-6
  in the AS .............................................. 9-3, 9-6
  in the STEP 7 environment ......................... 2-1
QDIS_START .............................................. 6-107, 6-109
QDIS_START .............................................. 6-107, 6-109
Recipe data block .................................... 12-5
Reserves .................................................. 6-117
SFC inputs/outputs .................................. 6-117
Resource requirements ................................ 7-6, 7-7
Run sequence........................................... 7-6
  editing .................................................. 5-56
Runtime attribute..................................... 6-56
Runtime behavior...................................... 9-3
Runtime phases ........................................ 9-33
  step .................................................... 9-33
Runtime properties ................................... 6-54
  SFC ..................................................... 6-54
Index

introduction .............................................. 1-1
managing .................................................. 4-3
navigating ................................................ 3-2
Parameter Control ...................................... 12-1
principle method of operation ....................... 1-6
Runtime properties ..................................... 6-54
Step and transition in the AS ....................... 9-34
type/instance concept .................................. 4-10
SFC and other target systems ....................... 4-3
SFC and plant hierarchy .............................. 2-3
SFC calls .................................................. 13-1
configuring .............................................. 13-1
SFC chart .................................................. 2-4, 2-5, 2-6
SFC chart and SFC type ............................... 2-10
SFC chart/instance starting ......................... 9-31
SFC chart/instance ..................................... 1-1
changing the configuration .......................... 4-9
compiling .................................................. 7-1
configuring ............................................... 4-8
copying/moving ........................................ 4-20
creating ................................................... 4-21
deleting .................................................... 4-22
external view ............................................ 2-11, 2-12
inputs/outputs ......................................... 6-65, 5-65, 5-73, 7-1
opening .................................................... 4-17
Selection criteria .................................... 1-1
standard interface ..................................... 6-59
standard interface inputs/outputs ................. 6-60
[SFC Chart] ............................................... 2-4, 2-5, 2-6
SFC chart and SFC type ............................... 2-10
comparing ............................................... 2-10
SFC chart/instance .................................... 9-31
SFC chart/instance starting ......................... 9-31
SFC editor ................................................. 2-11
starting .................................................... 3-1
working ................................................... 3-1
SFC element ............................................. 2-16, 2-17, 2-18, 2-19
...................................................... 2-20, 2-21, 2-22, 5-26, 5-28
deleting ................................................... 6-28
moving ..................................................... 6-26, 5-27
SFC elements .......................................... 8-9, 5-23, 5-24
copying ................................................... 6-23, 5-24
inserting/creating .................................... 6-9
SFC execution after CPU stop ...................... 9-26
SFC in the AS ........................................... 9-4
SFC in the CFC ......................................... 9-4
SFC inputs/outputs .................................... 6-74, 3-76, 3-92
........................................... 6-102, 6-103, 6-104, 5-105, 5-106
........................................... 6-107, 6-110, 6-111, 5-112, 6-117
BATCH parameters .................................... 6-105
commands and operating states .................... 6-94
continuous mode ....................................... 6-106
control words .......................................... 6-111
data from sequencers and steps to be processed 6-104
effect handling ........................................ 6-107
execution options ..................................... 6-102
group displays + group acknowledgements ........ 6-103
interface expansions for characteristics ........ 6-75
interface parameter assignments of characteristics 6-74
messages ............................................... 6-110
operating modes ....................................... 6-92
reserves .................................................. 6-92
status words ............................................. 6-112
system parameters .................................... 6-112
SFC instance ............................................ 1-3, 1-14, 2-7, 2-8, 4-6, 4-14
...................................................... 4-15, 4-16, 4-18, 4-21, 4-22, 7-1, 9-38
...................................................... 9-39, 9-40
changing the configuration ........................... 4-16
changing the control strategy and setpoints ....... 9-38
compiling ............................................... 7-1
configuring .............................................. 4-14
copying/moving ........................................ 4-21
creating ................................................... 1-14, 4-8
deleting .................................................... 4-22
opening .................................................... 4-18
SFC OSL .................................................... 9-10, 9-18
SFC type ................................................. 1-1, 1-11, 2-7, 2-8, 4-5, 4-10
...................................................... 4-17, 4-21, 4-22, 5-66, 5-67, 7-1
compiling ............................................... 7-1, 7-2
configuring .............................................. 4-10, 4-11
copying/moving ........................................ 4-21
creating ................................................. 1-11, 5-5
deleting .................................................... 4-22
inputs/outputs of standard interface ............. 6-67
opening .................................................... 4-17
selection criteria ..................................... 1-1
standard interface .................................... 6-66
SFC types .................................................. 5-4
update ..................................................... 5-4
Shared addresses ...................................... 6-51, 5-52
Shortcuts .................................................. 5-12
for menu commands .................................... 5-12
Simultaneous branch .................................. 2-19, 5-11, 9-35
creating ............................................... 6-11
in the AS ................................................. 9-35
Standard interface .................................... 6-59, 6-66
of SFC chart ............................................ 6-59
of the SFC type ......................................... 6-66
Start conditions ....................................... 2-13, 5-5
sequencer ............................................... 2-13
Starting ................................................... 3-1, 9-31, 9-32
SFC chart ............................................... 9-31
SFC editor ............................................... 3-1
SFC instance ............................................ 6-31
States ..................................................... 10-11
steps ....................................................... 10-11
transitions ............................................. 10-11
Status words ........................................... 6-112
BA_STATE ............................................. 6-112
SFC_STATE ............................................ 6-112
USTATUS .............................................. 6-112, 5-115
VSTATUS .............................................. 6-112, 5-116
Step ......................................................... 2-16, 6-31, 3-36, 3-41, 9-33
accessing structures ................................... 6-41
editing .................................................... 6-31
ingation ................................................... 6-31
editing addresses ..................................... 6-36
editing general properties ......................... 8-33
runtime phases ......................................... 9-33
STEP 7 ..................................................... 2-1
Step and transition .................................... 9-34
Step control modes .................................... 9-5, 9-6
Structures ................................................ 6-41
Index

Symbolic addressing.......................... 6-52
System attributes [parameters] .............. 5-15
System Attributes for parameters .......... 6-64
System parameters............................ 6-117
SFC inputs/outputs ............................ 6-117

T
Target ................................................. 9-25
Target step .......................................... 10-13, 10-14
Target steps ......................................... 6-101
programmed ........................................ 6-101
TARGETSEQ ......................................... 6-101, 9-25
TARGETSTEP ......................................... 6-101, 9-23
Test mode ........................................... 10-7, 10-10
Display ............................................... 10-7
Text ..................................................... 2-18, 6-16
selecting with keyboard ...................... 6-16
Text box .............................................. 6-18
creating ............................................. 6-18
editing .............................................. 6-18
Timers .................................................. 5-9
Tips & Tricks ......................................... 13-1
Tracing .................................................. 10-5
Tracking ............................................... 9-40
Control strategy and setpoints .............. 9-40
Transition .......................................... 2-17, 5-41
accessing structures ......................... 5-41
editing addresses .............................. 5-47
editing OS comment ............................ 6-49
formulating conditions ...................... 6-46

Transitions ......................................... 6-43
editing .............................................. 6-43
Type properties ................................... 5-3
adapting ........................................... 5-3
Type/instance concept ......................... 4-10
of an SFC ........................................... 4-10

U
User interface ..................................... 3-3, 3-8, 3-9, 3-10, 3-12, 3-14, 3-15, 3-16, 3-17
elements ............................................ 3-3
Using .................................................. 5-12
note texts .......................................... 5-12, 5-13
Position text ........................................ 5-12

V
Valid data types .................................. 6-53
Valid entries for addresses ................... 6-38

W
Window selection .................................. 3-17
changing ............................................ 3-17
Working .............................................. 3-1
with the SFC editor ......................... 3-1
Working with SFC .................................. 1-6
in principle .......................................... 1-6
Working with the mouse ....................... 3-9